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INTRODUCTION 

To continue our commitment to satisfy customer demands, we are introducing this Implementation 

Manual. Software implementation is often associated with a high degree of uncertainty and a significant 

impact on the daily operations of a company. It is our hope that this manual will assist in alleviating the 

uncertainties and revealing the expectations of the implementers and customers by providing detailed 

descriptions on installation and other configuration topics. This manual is not intended to replace the 

need for proper Exact Synergy Enterprise training; but rather, it should be used as a reference after the 

user or implementer has been trained on Exact Synergy Enterprise. 

In addition to the manual, we will continue to provide updated documents on the software that will be 

made available online via the customer and reseller portals. To stay current, we still recommend that 

implementers and users check for the latest developments and documentation changes regularly via 

the appropriate portals.  

While each implementation is unique, it is our hope that the manual will provide ongoing support in a 

single-document reference. We have endeavored to ensure that the information and content provided is 

as current as possible.  

We are dedicated to helping you improve your return on investment by taking full advantage of Exact 

Synergy Enterprise and/or other Exact products. We hope that you will find the Implementation 

Manual useful and we welcome any feedback you may have.



CHAPTER 1 | IMPLEMENTATION PROJECT APPROACH 

2 

 

1. IMPLEMENTATION PROJECT 

APPROACH 

Can you expect success in business without a well-defined organizational structure? Can you expect 

success without integrating the knowledge and people that are scattered around your organization and 

then making full use of them? 

Maximizing the potential of the people available in the organization is crucial to business success. It is 

therefore essential that the organization involved is well-structured before implementing any system. An 

organization that is not well-structured in the beginning will likely remain that way later. Fortunately, 

preliminary studies before implementation can be performed to identify the inefficiencies in the 

organization structure and internal communication. 

While no two implementations are exactly the same, the project structure is however consistent across 

all implementations for different companies.  
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1.1 COMMITMENT TO IMPROVE 

Believing that a project, like implementing Exact Synergy Enterprise, will bring improvements is the first 

step to any successful project implementation. The stronger the belief means the stronger the 

commitment to implement the project, and hence, the greater the likelihood of success. 

In the past, process-improvement initiatives were viewed as projects that brought intangible benefits, 

and organizations tend to be less interested in such long-term projects that produced intangible 

benefits.  

However, the current view point is that business processes play a key role in added value delivered by 

the company. Therefore, a process-improvement initiative, like implementing Exact Synergy Enterprise, 

is viewed as essential. 

Organization-wide changes must be initiated top-down. While many organizations, with the forward-

looking business vision, have accepted such changes as their way of life, there are still organizations 

struggling with having a mission statement on process improvement. 

In progressive organizations, every functional department is responsible and committed to improving its 

individual departmental process. The functional departments have the best knowledge of their 

respective departmental processes and therefore they must take on the responsibility to continuously 

look for ways to improve their processes for the betterment of the entire company. 

 

The first sign of a successful implementation is the commitment to create a dedicated project team 

comprising a high-level steering committee and implementation team. The implementation team must 

include management team leaders who are experts in the processes and functional departments (sales, 

finance, HR, manufacturing, marketing, engineering, purchasing, et cetera). Together with the working 

team members, they represent the functional departments in the project. 
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1.2 PROJECT-BOOK APPROACH 

A project book is maintained throughout the implementation of Exact Synergy Enterprise to: 

• ensure the success of the project, 

• reduce the risks involved, 

• ensure accountability and procedural consistency, and 

• define the scope of the project. 

 

1.3 KEY SUCCESS FACTORS 

The key success factors in implementing Exact Synergy Enterprise include: 

• proper process management, 

• well-defined roles and responsibilities, 

• efficient communication, 

• strong commitment from the top management, 

• setting of realistic achievable goals, 

• providing thorough training, 

• avoiding filtered information, and 

• willingness to accept change. 

 



CHAPTER 1 | IMPLEMENTATION PROJECT APPROACH 

5 

 

1.4 PROJECT TEAM 

A successful project team should comprise of a steering committee, project manager, managerial team 

leaders, and end users, of which all are internal people of the company. 

 

1.4.1 Steering committee 

The steering committee is represented by the top management executives of the company. The 

committee is not involved in the low-level operating issues of the implementation but makes high-level 

decisions relating to business issues of the implementation. 

The steering committee oversees and is responsible for the progress of individual project components 

and hence the process of the overall project. It must be ever ready to act to ensure that the project 

advances until completion. It must be decisive and specific when the implementation team needs 

certain directions. The committee also assures the project team of the commitment from top 

management by resolving issues relating to people constraints and conflicts with company policies, and 

hence, assuring that the project is a priority of the company. 

 

Responsibilities 

The responsibilities of the steering committee include, but are not limited to, the following: 

• defining the overall project goal, 

• providing a strategic vision, 

• introducing the project to the organization, 

• ensuring sufficient people are available, 

• empowering the implementation team and holding them accountable, 

• delegating to the project manager the authority to make decisions, 

• approving and supporting the implementation plan, 

• ensuring no conflicts with other company priorities, 

• making the go-or-no-go decisions on whether to continue with the project, and 

• reviewing and monitoring the progress in terms of deadlines and budgets. 

 

Suitable candidate 

The steering committee must assume the roles of: 

• Visionary planners, 

• Chief executive officers, and 

• Hands-off advisors. 

The steering committee members must be willing to devote an average of five to 10 percent of their 

time each week to implementing the project. 
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1.4.2 Project manager 

A project manager plays the most important role in a project. This person must have a good grasp of 

the complexity and intricacy of the overall project requirements. He or she must also be able to 

coordinate among the team members and lead them to achieve the overall team’s objective. 

 

Responsibilities 

The responsibilities of the project manager include, but are not limited to, the following: 

• project planning, organizing, and control, 

• maintaining and scheduling project activities, 

• conducting team meetings and resolving issues, 

• allocating people, 

• securing people required for the project, 

• coordinating the activities of the implementation team, 

• serving as a liaison person to top management and external consultants, 

• chairing coordination and status meetings, and 

• keeping the steering committee informed. 

 

Suitable candidate 

A suitable candidate for the project manager position must at least have: 

• high vested interest in (for example, will benefit  a lot from) the project, 

• project management skills, 

• excellent organizing capability, 

• sufficient time to coordinate the project, and 

• good overall understanding of the business. 

The person selected must be willing to devote an average of 40 to 50 percent of his or her time each 

week to implementing the project. 
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1.4.3 Management team leaders 

The management team leaders are the managers or representatives from the functional departments. 

They get involved in reviewing the current procedures, proposing possible changes to them, and 

documenting the actual changes. The team leaders also get involved in assigning responsibilities and in 

the post-project training of their team members. 

 

Responsibilities 

The responsibilities of a team leader are confined to the functional department concerned and they 

include, but are not limited to, the following: 

• ensuring the progress of the implementation within the functional department, 

• defining the project goals for the functional department, 

• determining requirements and availability of people, 

• addressing interdepartmental issues and conflicts, 

• learning the implemented software system, 

• reviewing/revising related information and process flows, 

• appointing a backup team leader, and 

• cooperating with and following the guidance of the project manager. 

 

Suitable candidate 

A suitable candidate for the team leader position must at least be: 

• a managerial-level user of Exact Synergy Enterprise, 

• having high vested interest in (for example, will benefit a lot from) the project, 

• determined to complete the implementation, 

• aware of the benefits of implementing Exact Synergy Enterprise, 

• able to communicate the project benefits to fellow co-workers, 

• able to devote time and effort to the implementation process, 

• an expert in the functional area, and 

• a catalyst of change. 

The persons selected must be willing to devote about 20 to 25 percent of their time each week to 

implementing the various stages of the project. 
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1.4.4 End users 

End users are employees who will be working with Exact Synergy Enterprise on a daily basis after the 

implementation. The end users need to be thoroughly trained, as they are at the front-line working on 

the departmental processes and hence, use Exact Synergy Enterprise the most. 

 

Responsibilities 

The responsibilities of end users include, but are not limited to, the following: 

• reporting to team leaders on any problems, issues, or concerns encountered relating to the 

processes and workflows, 

• adapting to and using new processes and workflows through Exact Synergy Enterprise, and 

• becoming proficient in using, and be familiarized with, all the functionalities of Exact Synergy 

Enterprise so that daily processes are handled accurately, promptly, and efficiently. 

 

Suitable candidate 

A suitable candidate for the role of the end user must be someone who is capable of: 

• being a primary user of the system, and 

• handling routine tasks on a daily basis. 

End users involved must be willing to devote an average of 10 to 15 percent of their time each week to 

implementing the various stages of the project. 

 

Additional employees 

During the implementation, it is often necessary to hire additional temporary employees. These 

additional employees are usually needed for entering data into the system, such as those for customers 

and items. They must be guided and supervised during the data entry process. The team leaders are 

the ones accountable for the accuracy and completeness of the work. 

At the stage of assigning responsibilities and tasks, the project consultant from Exact is involved to 

ensure that the employees are allocated their duties and that they have the necessary skills for them. 
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1.5 PROJECT IMPLEMENTATION STAGES 

1.5.1 Kickoff meeting 

 

A meeting is necessary to start or kick off the project. The kickoff meeting formally starts the 

implementation process. It is vital in establishing a strong foundation for the entire project. During this 

meeting, the project manager and management team affirm the objectives and expectations of the 

project, and also the implementation schedule. 

Once everyone involved has a clear understanding of the project, the Exact project consultant, together 

with the project team of the company, will devise a comprehensive implementation plan. The plan must 

include a precise project schedule, allocation of people, and assignment of responsibilities to individual 

project members. 

Topic Item 

Objectives Demonstrate system overview 

Explain the Exact Synergy Enterprise methodology 

Review the key success factors 

Define the roles and responsibilities 

Develop the project plan 

Develop the communication plan 

Who should be involved? The steering committee 

Project manager 

Management team 

All the Exact Synergy Enterprise users 

Deliverables Project kickoff PowerPoint presentation 

Meeting agenda 

Project team organization chart 

Project book 

Duration Approximately two to four hours 
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1.5.2 Planning and business analysis 

 

After the kickoff, the next stage is planning and business analysis. 

Topic Item 

Objectives Identifying critical business issues 

Reviewing front-office business operations 

Documenting current business processes 

Defining goals 

Defining implementation strategy 

Revisiting project plan 

Who should be involved? The steering committee 

Project manager 

Management team 

Deliverables Critical business issues 

Documents on current business processes 

Task list 

Project book 

Duration Approximately three to four days 
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1.5.3 Setup and piloting 

 

At this stage, the project manager, management team, and key decision makers should be present. The 

Exact project consultant will advise the key decision makers on the Exact Synergy Enterprise setup and 

work flow that affect the company. The management team will gain a better understanding of the 

functionalities of the software. They can then decide together with the project consultant on how the 

company will be using Exact Synergy Enterprise. 

Topic Item 

Objectives Complete file setup and training 

Complete defining and settings of pilot modules and training 

Complete process flow training and piloting setup 

Assign management team with data input 

Who should be involved? Project manager 

Management team 

Key decision makers 

Deliverables Exact Synergy Enterprise process flows 

Critical business issues 

Formal sign-off 

Project book 

Duration Approximately 10 days 
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1.5.4 End user training 

 

At this stage, the main focus is to train the end users in the functional departments through interactive 

hands-on training sessions of Exact Synergy Enterprise. The emphasis is on the Exact Synergy 

Enterprise process flows designed during the setup and piloting stage. The project manager and team 

leaders are required to be present to provide the necessary interaction between the project team and 

the end users. 

Topic Item 

Objectives Training end users on business processes 

Resolving any arising issues 

Testing data input accuracy 

Who should be involved? Project manager 

Management team 

End users 

Deliverables Exact Synergy Enterprise process flows 

Project book 

Duration Approximately five to six days 
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1.5.5 30-day follow-up 

 

A meeting is held to review the project progress to-date and to ensure compliance and effectiveness of 

procedures introduced. At this time, all outstanding issues will be discussed and resolved. 

During the implementation, the primary contact person for the company has been the Exact project 

consultant. From this point onward, the company will be served by the support and sales personnel 

from Exact. This transition of support service will be discussed with the project manager and 

management team. 

Topic Item 

Objectives Addressing outstanding issues 

Ensuring compliance and effectiveness of procedures 

Introducing the Support and Sales team from Exact 

Who should be involved? Project manager 

Management team 

Deliverables Handover letter 

Project book 

Duration Approximately one day 
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2. TECHNICAL IMPLEMENTATION 

Exact Synergy Enterprise is installed to run as an application server on a web server while the data is 

stored in a Microsoft SQL database. The application server and the database server can reside on the 

same server hardware or separately depending on scalability requirements. 

 

2.1 SOFTWARE REQUIREMENTS 

2.1.1 Application and database servers 

The following are the supported requirements for the application and database servers: 

• Microsoft Windows Server 2012/2012R2, 2016, 2019, and 2022.  

• Microsoft .NET Framework version 4.7 should be installed. 

• WCF Data Services 5.0 should be installed. 

• Microsoft SQL Server 2014, 2016, 2017, 2019, or 2022. 

• Microsoft Office 2016, 2019, 2021, or 32-bit 365 ProPlus. 

• Microsoft Exchange Server 2010, 2013, 2016, and 2019, and Microsoft Exchange Online. 

• Microsoft Edge, Mozilla Firefox, Google Chrome, or Safari (only for the MAC operating system, and 

is not fully supported for tablets). 

• Microsoft SQL TDE is supported. 

Microsoft Office is required on the application server that runs some of the background jobs. Microsoft 

Edge is required in order to access Exact Synergy Enterprise for initial setup and maintenance. You can 

download and install Microsoft .NET Framework version 4.7 from the Microsoft web site.  

The recommended system requirements are Microsoft Windows Server 2016, WCF Data Services 5.0, 

Microsoft SQL Server 2019, Microsoft Office 2019, and Microsoft Exchange Server 2019. 

The customer must provide all the required licenses for the application server and database software. 

Tip:  

Exact Synergy Enterprise can be integrated with Microsoft Exchange Server 2010, 2013, 2016, or 

2019. Microsoft Exchange 2016 with the latest service pack is recommended. However, it is not 

required to be installed on the web server. 
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2.1.2 Client workstations 

The following are the supported requirements for the client workstations to access Exact Synergy 

Enterprise: 

• Microsoft Windows 10, or 11. 

• Microsoft Edge 

• Mozilla Firefox, Google Chrome, or  Safari (only for the MAC operating system and is not fully 

supported for tablets) 

• Display resolution of 1024 x 768 pixels 

• Microsoft Office 2016, 2019, 2021, and 32-bit 365 ProPlus 

Microsoft Office is required in order to use the Microsoft Office integration feature of Exact Synergy 

Enterprise.  

The recommended system requirements are Microsoft Windows 10, Microsoft Edge, Microsoft Office 

2019, and a screen resolution of 1280 x 1024. 

Tip:  

For mobile users, any mobile phone that has Internet browsing capabilities can be used to access 

specific functionalities in Exact Synergy Enterprise that have been developed for mobile use. 
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2.2 NETWORK REQUIREMENTS 

The connection between client workstations and the application server can be established using 

standard TCP/IP internet protocol through a local area network (LAN) or a global infrastructure like the 

Internet. 

Note:  

Internet connection is mandatory for Exact Synergy Enterprise. 

 

2.2.1 Connection speed 

Although lower connection speeds do not affect application integrity, the client workstation requires at 

least a 56.6 Kbps connection to Exact Synergy Enterprise for acceptable performance. 

If the application server is separate from the database server, the application server should be 

connected to the database server with a 100 Mbps LAN connection. 

 

2.2.2 Network security 

One of the greatest strength of the Internet is that it is based on open technology. However, the Internet 

and its related applications are generally considered as insecure due to this open nature. Therefore, a 

number of strict security policies must be maintained when implementing Exact Synergy Enterprise in 

order to protect both the application software and the data from malicious acts. 

Total system security involves numerous security measures, each of which performs its own tasks to 

meet certain security requirements. These security measures are not confined to protecting the Exact 

Synergy Enterprise application but also the integrity of every element in the system. 

 

Since the Exact Synergy Enterprise data traffic from the client workstation to the application server and 

database server is vulnerable, the entire data traffic path, from data sources to data destinations and 

data storage has to be protected. To provide the security needed, HTTPS (Hypertext Transmission 

Protocol, Secure) should be used for data encryption. Firewalls should also be installed to separate the 

Local Area Networks (LAN), the Demilitarized Zone (DMZ), and the Internet. 
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2.3 SERVER HARDWARE REQUIREMENTS 

Exact Synergy Enterprise requires an application server (IIS with Exact Synergy Enterprise) and a 

database server (Microsoft SQL Server and database). Both servers can reside on a single machine or 

separate machines, depending on the required scalability. As Exact Synergy Enterprise is scalable up 

to thousands of users, the actual hardware requirements are determined by the specific needs of 

individual customers. 

In order to ensure acceptable performance, the servers must have minimum configurations capable of 

serving all concurrent client workstations. Using server hardware that exceeds the minimum 

requirements improves the application performance. 

 

2.3.1 Up to 50 concurrent connections 

For a small Exact Synergy Enterprise implementation to serve up to 50 concurrent connections, both 

the application server and database server can reside in the same machine. 

 

 

Single application and database server machine 

Hardware Recommended Minimum 

Processor 2 x Dual Core Intel Xeon (2.4 GHz) 1 x Pentium 4 (3.4 GHz) 

Memory 4 GB 1 GB 

Hard disk 3 x SCSI 72 GB (RAID 5) 1 x IDE 30 GB 
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2.3.2 Up to 150 concurrent connections 

When more connections are required or a large database size is expected, the IIS web server should 

be installed on a separate machine capable of handling up to 150 concurrent connections. The resulting 

setup is one machine for the application server (IIS with Exact Synergy Enterprise) and another 

machine for the database server. 

Note:  

The client workstation communicates only with the application server. 

 

 

Application server machine 

Hardware Recommended Minimum 

Processor 2 x Dual Core Intel Xeon (2.4 GHz) 1 x Pentium 4 (3.4 GHz) 

Memory 2 GB 1 GB 

Hard disk 2 x SCSI 18 GB (RAID 1) 1 x IDE 6 GB 

 

Database server machine 

Hardware Recommended Minimum 

Processor 2 x Dual Core Intel Xeon (2.4 GHz) 1 x Pentium 4 (3.4 GHz) 

Memory 2 GB 1 GB 

Hard disk 5 x SCSI 72 GB (RAID 5) 1 x SCSI 50 GB 
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2.3.3 More than 150 concurrent connections 

If more than 150 concurrent connections are required, the workload of the application server can be 

shared among several machines for improved reliability and performance. A load balancer can be used 

to proportionate data traffic among the application server machines, each of which is capable of serving 

up to 50 or more concurrent connections. All these clients are connected to a single centralized 

database server for data storage and retrieval. 

 

 

Each application server machine 

Hardware Recommended Minimum 

Processor X64 server based processor X86 & X64 processor 

Memory 4 GB for IIS or more 2 GB for IIS 

Hard disk RAID 1 for redundancy Single disk 

 

 

Load balancer 

Dedicated load balancers, such as the Foundry Server Iron Load Balancer (8 ports) can be used to 

balance the application server load. Microsoft Windows Server 2008 R2 also provides the Microsoft 

Windows Network Load Balancing service that is built into the operating system. 
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2.4 WINDOWS SERVER 2012 COMPATIBILITY 

Since Windows Server 2012 is available, some organizations may choose to upgrade their servers to 

run on this new operating system. Windows Server 2012 offers new and improved features that 

organizations can take advantage of. These features include: 

• Web — Improved features, such as Internet Information Services (IIS) 8.0, which allows more 

efficient and effective delivery of web-based experiences. 

• Virtualization — With the availability of server virtualization technology, servers are easily scalable. 

This helps to reduce costs, increase hardware utilization, and optimize available infrastructure. 

• Security — Enhanced security services, including Network Access Protection feature, which helps to 

keep the network and data safe. 

• Reliability — Enhanced features, such as fail over clustering and next generation networking 

capabilities that helps to increase server reliability. 

 

2.4.1 Windows Server 2012 and Exact Synergy Enterprise 

To ensure that Exact continues to support organizations that choose to upgrade to Windows Server 

2012, efforts have been carried out to ensure that Exact Synergy Enterprise is able to run on Windows 

Server 2012. 

Exact Synergy Enterprise has taken advantage of certain features available in Windows Server 2012 to 

enhance its offerings. These include: 

• the support of 64-bit architecture, 

• the support of IPAM, and 

• the availability of Internet Information Services (IIS) 8.0. 

 

2.4.2 Installing Exact Synergy Enterprise on Windows Server 2012 platform 

In order to install Exact Synergy Enterprise on a 64-bit Windows Server 2012 machine, a fresh 

installation is required. The recommended steps when installing Exact Synergy Enterprise on a 

Windows Server 2012 machine are as follows: 

1. Back up the database of an existing Exact Synergy Enterprise installation, if previously installed on 

a 32-bit machine. 

2. Install the appropriate components on the Windows Server 2012 platform and other related 

applications, namely the application server, web server, Microsoft .NET Framework version 4.7, and 

Microsoft Exchange Server 2013. 

3. Download and install Exact Synergy Enterprise on the Windows Server 2012 machine. 

4. Restore the Exact Synergy Enterprise database on the 32-bit Windows Server 2012 machine. 
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To back up databases: 

5. Start the SQL Server Management Studio. 

6. Right-click on the database that you want to backup, select Tasks, and then click Back Up… 

 

7. Specify the appropriate backup destination under the Destination section, if required. 
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8. Click OK to begin the backup process. 

To install the appropriate components on the Windows Server 2012 platform and other related 

applications: 

Prepare the machine for the Windows Server 2012 installation. 

Apart from Windows Server 2012, the required systems to run Exact Synergy Enterprise include: 

• the application server role, 

• the Internet Information Services or Web server (IIS) role, 

• Microsoft .NET Framework version 4.7, and 

• Microsoft Exchange Server 2013. 

To install and set up Windows Server 2012, see Installing Windows Server 2012 from the Microsoft web 

site at https://technet.microsoft.com/en-us/library/jj134246.aspx. 

To install and set up the application server and web server (IIS) 8.0 server roles, see 2.6.1 Installing 

and setting up application server and web server (IIS) server roles. 

Microsoft .NET Framework version 4.7 must be installed before installing Exact Synergy Enterprise. If 

the operating system that you are running on does not have the Microsoft .NET Framework version 4.7 

preinstalled, you can download it from the Microsoft web site. To install, see 2.6.2 Installing Microsoft 

.NET Framework version 4.7. 

To install Microsoft SQL Server 2016, see 2.7 Setting Up Database Servers. 

For Exact Synergy Enterprise to run on Windows Server 2012, Windows Exchange Server 2013 is 

recommended. To install Windows Exchange Server 2013, see the related Microsoft Windows 

documentation at https://technet.microsoft.com/en-us/library/bb124558(v=exchg.150).aspx. 

Caution:  

It is possible that Windows Exchange Server 2013 has to be installed and executed from a separate 

machine. Consult Exact executives for further clarification, if required. 
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2.5 WINDOWS SERVER 2016 COMPATIBILITY 

Since Windows Server 2016 is available, some organizations may choose to upgrade their servers to 

run on this new operating system. Windows Server 2016 offers new and improved features that 

organizations can take advantage of.  

 

2.5.1 Installing Exact Synergy Enterprise on Windows Server 2016 platform 

In order to install Exact Synergy Enterprise on a Windows Server 2016 machine, a fresh installation is 

required. The recommended steps when installing Exact Synergy Enterprise on a Windows Server 

2016 machine are as follows: 

1. Back up the database of an existing Exact Synergy Enterprise installation. 

2. Install the appropriate components on the Windows Server 2016 platform and other related 

applications, namely the application server, web server, Microsoft .NET Framework version 4.7, and 

Microsoft Exchange Server 2013. 

3. Download and install Exact Synergy Enterprise on the Windows Server 2016 machine. 

4. Restore the Exact Synergy Enterprise database on the Windows Server 2012 machine. 

 

To back up databases: 

1. Start the SQL Server Management Studio. 

2. Right-click on the database that you want to backup, select Tasks, and then click Back Up… 
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3. Specify the appropriate backup destination under the Destination section, if required. 

 

4. Click OK to begin the backup process. 

 

To install the appropriate components on the Windows Server 2016 platform and other related 

applications: 

Prepare the machine for the Windows Server 2016 installation. 

To install and set up Windows Server 2016, see Installing Windows Server 2016 from the Microsoft web 

site at https://gallery.technet.microsoft.com/Step-By-Step-Install-e78aea4e. 

To install and set up the application server and web server (IIS) 8.0 server roles, see 2.6.1 Installing 

and setting up application server and web server (IIS) server roles. 

Microsoft .NET Framework version 4.7 must be installed before installing Exact Synergy Enterprise. If 

the operating system that you are running on does not have the Microsoft .NET Framework version 4.7 

preinstalled, you can download it from the Microsoft web site. To install, see 2.6.2 Installing Microsoft 

.NET Framework version 4.7. 

To install Microsoft SQL Server 2016, see 2.7 Setting Up Database Servers. 

For Exact Synergy Enterprise to run on Windows Server 2016, Windows Exchange Server 2013 is 

recommended. To install Windows Exchange Server 2013, see the related Microsoft Windows 

documentation at https://technet.microsoft.com/en-us/library/bb124558(v=exchg.150).aspx.
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2.6 APPLICATION SERVERS AND WEB SERVERS (IIS) 

Application server and web server (IIS) server roles are included in all editions of Microsoft Windows 

Server 2012 and 2016. However, for security reasons, they are not preinstalled by default. You will 

need to manually install both the application server and IIS roles. Furthermore, Exact Synergy 

Enterprise relies heavily on the web server (IIS). Since a web server is usually accessible from the 

Internet, it is one of the most vulnerable servers in the network. It is advisable to install only the required 

components to run Exact Synergy Enterprise. Apart from saving server resources, this will also 

minimize the risk of unwanted activities on the server. 

After installing the application server and IIS roles, you will also need to activate certain role services as 

these are also deactivated by default. 

 

2.6.1 Installing and setting up application server and web server (IIS) server 

roles 

To install and set up application server and web server (IIS) server roles: 

1. Go to Server Manager.  

2. Under the Manage menu at the top right corner, select Add Roles and Features. 

3. In the Add Roles and Features Wizard screen, click Next. 

 

4. Select Role-based or feature-based installation.  
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5. Next, select the appropriate server, as shown in the following: 

 

6. Click Next. 

7. Select the Application Server and Web Server (IIS) check boxes. 

 

8. Click Next.  

9. Select the .NET Framework 7 check box. If they are already installed, click Next. 
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10. The Application Server screen will be displayed. 

 

11. Click Next. 
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12. Select .NET Framework 7, Web Server (IIS) Support, and any other required role services to be 

installed on the application server. When selecting the Web Server (IIS) Support check box, you 

will be requested for confirmation on adding the required features to the Web Server (IIS) Support. 

You cannot install Web Server (IIS) Support unless the required features are installed. Click Add 

Required Features. 

 

13. Click Next. 

14. Select the appropriate server authentication certificate for the SSL encryption, and then click Next. 
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15. The Web Server Role (IIS) screen will be displayed. 

 

16. Click Next. 

17. Select the check boxes corresponding to the role services in the following to install on the web 

server (IIS): 
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Common HTTP Features 

• Default Document 

• Directory Browsing 

• HTTP Errors 

• Static Content 

• HTTP Redirection 

Health and Diagnostics 

• HTTP Logging 

• Logging Tools 

• Request Monitor 

• Tracing 

Performance 

• Static Content Compression 

• Dynamic Content Compression 

Security 

• Request Filtering 

• Basic Authentication 

• Client Certificate Mapping Authentication 

• Digest Authentication 

• IIS Client Certificate Mapping Authentication 

• IP and Domain Restrictions  

• URL Authorization 

• Windows Authentication 

Application Development 

• .NET Extensibility 3.5 

• .NET Extensibility 4.5 

• ASP 

• ASP.NET 3.5 

• ASP.NET 4.5 

• ISAPI Extension 

• ISAPI Filters 

Management Tools 

• IIS Management Console 

• IIS 6 Management Compatibility 

– IIS 6 Metabase Compatibility 

– IIS 6 Scripting Tools 

– IIS 6 Management Console 

– IIS 6 WMI Compatibility 

• IIS Management Scripts and Tools 

• Management Service 

18. Click Next, and then click Install.  

19. Once installation is successful, click Close.  
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20. To verify the installation, enter the URL http://localhost at the address bar in Microsoft Edge. 

 

Tip:  

Visit the Microsoft web site on a regular basis to check for the latest service packs, updates, 

patches, and hot fixes to protect your application server. 

2.6.2 Installing Microsoft .NET Framework 

The Microsoft .NET Framework includes everything you need to run applications using the Microsoft 

.NET Framework and is therefore required before installing Exact Synergy Enterprise.  

 

To install Microsoft .NET Framework version 7: 

1. Go to the Microsoft website, and download Microsoft .NET Framework version 7.  

2. Double-click on the downloaded file to run the installer. 

3. Follow the steps in the wizard.  

 

 

 

http://localhost/
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2.6.3 Registering Microsoft .NET Framework with web servers (IIS) 

After each installation, the installer will automatically register the tool with IIS.  

A simple check can be done to see if Microsoft .NET Framework version 7 is running properly by 

following steps: 

1. Go to Server Manager. 

2. In the Tools menu at the top right corner, select Internet Information Services (IIS) Manager. 

3. In the left pane, expand the server node and select Application Pools. 

 

4. In the Actions pane, select Add Application Pool…. 

5. At the .NET Framework version: field, click the arrow to view the list of all the available options of 

the .NET Framework version. 

Tip:  

You can also use the ASP.NET IIS Registration tool (aspnet_regiis.exe) to display all versions of 

ASP.NET installed on the computer and perform other operations, such as registering the .NET 

Framework with IIS. For more information on using ASP.NET IIS Registration tool, see ASP.NET 

IIS Registration Tool (Aspnet_regiis.exe) at http://msdn.microsoft.com/en-

us/library/k6h9cz8h(v=VS.90).aspx. 

 



CHAPTER 2 | TECHNICAL IMPLEMENTATION 

33 

 

2.6.4 Preparing web servers (IIS) 

Before you can install and run Exact Synergy Enterprise, the following several settings must be 

configured in the IIS web server: 

• enable dynamic content in IIS, 

• set appropriate download and upload file size limits, 

• ensure that the Web garden is not used in IIS, and  

• configure the required authentication persistence. 

 

Enabling ASP.NET in IIS 

By default, dynamic content, such as ASP and ASP.NET are not activated in IIS for security reasons. It 

is important to enable ASP.NET to ensure that the Microsoft .NET framework used in IIS is the correct 

version. 

To add ASP.NET (3.5 and 4.5) in the web server (IIS 8.0) role services, see 2.6.1 Installing and setting 

up application server and web server (IIS) server roles. 

A simple check can be done to see if ASP.NET dynamic content in the web server (IIS) has been 

enabled. 

 

To enable ASP.NET dynamic content in IIS 8.0 web servers: 

1. Go to Server Manager. 

2. In the left pane, select IIS.. A list of roles services will be displayed under the ROLES AND 

FEATURES section. Search from the list to confirm whether the ASP.NET 4.5 and ASP.NET 3.5 

role services are listed. If not, you can install them by clicking Add Roles and Features under the 

TASKS menu at the top right of the section. 
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Setting the appropriate file size limits for downloads and uploads 

By default, the file size limit is 4 MB for downloading and 200 KB for uploading when using ASP.NET. If 

a user attempts to download an attached file larger than 4 MB, the download will fail. Likewise, the user 

cannot upload an attachment larger than 200 KB. 

 

To set appropriate file size limits for downloads and uploads: 

1. Go to Start → Control Panel → Administrative Tools → Internet Information Services (IIS) Manager.  

2. In the left pane, expand the server node and double-click ASP under the IIS section. 
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3. To set the file size for upload, expand Limits Properties under the Behavior section, type the 

appropriate value (in bytes) at Maximum Requesting Entity Body Limit.  

4. To set the file size for download, expand Limits Properties, type the appropriate value (in bytes) at 

Response Buffering Limit. 

 

5. In the Actions pane, click Apply to save changes. 

Tip:  

To convert the MB value for the upload and download size to bytes, multiply the number with 1024 

twice. For example, the bytes equivalent of 30 MB is 30 x 1024 x 1024 = 31457280. 
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Ensuring Web garden is disabled in IIS 

Exact Synergy Enterprise will not be able to function properly if Web garden is used. Due to this, you 

must ensure that Web garden is not enabled in IIS. You can get more information on Web garden from 

the IIS documentation.  

By default, the Web garden is disabled from IIS 7.0 onwards. 

 

To disable IIS Web garden: 

1. Go to Start → Control Panel → Administrative Tools → Internet Information Services (IIS) Manager. 

2. Expand the server node. 

3. Click the Application Pools folder and the Application Pools summary will be displayed. 
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4. In the Actions pane, select Set Application Pool Defaults…, and then set Maximum Worker 

Processes to 1. 

 

5. Click OK, and then close Internet Information Services (IIS) Manager. 

 

Configuring IIS authentication 

In order to avoid users with appropriate roles and security settings in Exact Synergy Enterprise from 

being denied access due to insufficient rights, it is important to configure the authentication modes in 

the IIS. 

To add Windows Authentication, Basic Authentication, and URL Authorization (for Forms 

Authentication) in the web server (IIS) role services, see 2.6.1 Installing and setting up application 

server and web server (IIS) server roles. 
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To check if the Windows Authentication, Basic Authentication, and URL Authorization role 

services in Web server (IIS) are enabled: 

1. Go to Start → Control Panel → Server Manager. 

2. Expand the server node. Click Roles to expand it, and select Web Server (IIS). A list of roles 

services will be displayed under Role Services. Search from the list to confirm whether the 

Windows Authentication, Basic Authentication, and URL Authorization role services are 

Installed. 
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To configure authentication modes: 

1. Go to Start → Control Panel → Administrative Tools → Internet Information Services (IIS) Manager. 

2. In the left pane, expand the server node. Click Sites to expand it, and then click Default Web Site. 

3. In Features View, double-click the Authentication feature under the IIS section. 

4. In the Authentication pane, configure the authentication modes as follows: 

• Right-click Anonymous Authentication, and then select Disable. 

• Right-click ASP.NET Impersonation, and then select Disable.  

• Right-click Basic Authentication, and then select Disable. 

• Right-click Digestion Authentication, and then select Disable. 

• Right-click Forms Authentication, and then select Disable. 

• Right-click Windows Authentication, and then select Enable. 

 

Note: 

When anonymous accesses to the web sites are intended, right-click Anonymous Authentication 

and select Enable. Disable the rest of the authentication methods. Anonymous Authentication 

must be disabled when authenticated accesses are required. 

 

Windows Authentication and Basic Authentication require users to respond correctly to a 

server-initiated challenge while Forms Authentication relies on redirections to a login page to 

determine the identity of the user. Forms Authentication cannot be enabled while Windows 

Authentication and/or Basic Authentication are enabled. 
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Tip:  

If you are not able to view document attachments on your iPhones and iPads when using the Exact 

CRM mobile application, you may need to enable the Basic Authentication setting only. This is 

because iOS7 (Apple) has no longer supports Windows Authentication. Exact CRM mobile 

application is introduced in product update 252. For more information, see Exact CRM mobile 

application introduced (Doc ID: 25.311.714), Activation use of Exact CRM mobile application (Doc 

ID: 25.306.244), and System requirements for Apps (Doc ID: 25.309.288) on your Exact Synergy 

Enterprise.
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2.7 SETTING UP THE DATABASE SERVER 

The database server must be prepared and configured before operating Exact Synergy Enterprise. The 

Database Management System (DBMS) supported by Exact Synergy Enterprise is Microsoft SQL 

Server 2016. 

For more information on Microsoft SQL Server 2008 R2, see 2.6.3 Installing Microsoft SQL Server 2008 

R2. 

 

2.7.1 Preparation before installing Microsoft SQL Server 2014 

Before beginning the installation process, check the following prerequisites: 

• Ensure the computer meets the system requirements. 

• Make sure you have administrator’s rights on the computer where Microsoft SQL Server 2014 (SQL 

Server 2014) will be installed. 

Note:  

For local installations, you must run the Microsoft SQL Server installer as an administrator. If you 

are installing from a remote share location, you need a domain account that has Read and Execute 

permissions on the remote share location. To create a failover cluster, you need to be a local 

administrator with permissions to log on as a service and act as part of the operating system on all 

nodes of the virtual server. 

• Back up the Exact Synergy Enterprise database on the current SQL server. 

• Verify that the disk where SQL Server 2014 is to be installed is uncompressed. 

Caution:  

If you attempt to install SQL Server 2014 on a compressed drive, the setup will fail. 

• Exit your antivirus software while upgrading to SQL Server 2014. 

• Stop all services that depend on the current SQL server, including any service using Open Database 

Connectivity (ODBC), such as Internet Information Services (IIS). 

• Exit Event Viewer, and registry editors (Regedit.exe or Regedt32.exe). 

Once these prerequisites are met, proceed to install SQL Server 2014. 
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2.7.2 Installing Microsoft SQL Server 2014 

In a standalone environment, you have to perform these steps on the workstation where you work with 

Exact Globe Next. In all other cases, you have to perform these steps on the server. 

When working in a standalone environment, you will have one computer on which you are working with 

Exact Globe Next. On this computer, both Exact Globe Next and the SQL Server are installed. This is 

seen as a standalone even when your computer is part of a network, as all software needed to work 

with Exact Globe Next are installed on this one computer. 

Before installing the SQL Server, check the system requirements for the specific SQL Server edition at 

https://msdn.microsoft.com/en-us/library/ms143506.aspx.  

When these requirements are met, you can start installing SQL Server 2014. 

 

To install Microsoft SQL Server 2014 

1. Log in as an administrator on the server (of a workstation in case of a standalone installation). 

2. Insert the SQL Server installation DVD into your DVD drive. When the autorun is not performed, 

open the DVD drive in Windows Explorer and start the installation by clicking Setup.exe. 

3. The SQL Server Installation Center screen will be displayed. In this screen, you can view and 

execute several installation tasks. 

 

https://msdn.microsoft.com/en-us/library/ms143506.aspx
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4. Click Installation on the left panel. Next, click New SQL Server stand-alone installation or add 

features to an existing installation. 
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5. In the Product Key screen, type the product key at Enter the product key if the product key is not 

filled automatically. Click Next to continue. The screen with the license terms will be displayed. 
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6. To continue, select I accept the license terms and click Next. 
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7. Checks will be performed to identify possible problems when installing the SQL Server Setup 

support files. The SQL Server Setup support files are needed for the installation of MS SQL Server 

2014 and are automatically installed via this installation wizard. Click Show details >> to view the 

details of these checks. When all checks are passed, the results are displayed in this screen. When 

a check has failed, a red icon will be displayed. You can click the link in the Status column for more 

information about the check and the error. After solving the issue, click Re-run to perform the 

checks again. 

Note:  

It is possible that some warnings are displayed regarding the firewall. In spite of the warnings, it is 

still possible to continue with the installation. Depending on the situation, it may or may not be 

necessary to close the installation wizard and restart. When all checks are passed, this screen will 

close automatically and the next screen will be displayed. 
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8. The installation wizard will check for updates and installs the available update files. As soon as this 

is done, the screen will close automatically and the next screen will be displayed: 

 

9. Checks will be performed to identify potential problems that might occur during the installation. Click 

Show details >> to view the details of these checks. When a check has failed, a red icon will be 

displayed. You can click the link in the Status column for more information about the check and the 

error. After solving the issue, click Re-run to perform the checks again. 

Note:  

Depending on the situation, it may or may not be necessary to close the installation wizard and 

restart. 
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10. Click Next to continue. However, the Next button is available only when no checks have failed. 
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11. In the Setup Role screen, define if you want to install all components of the SQL Server with 

default values. Select SQL Server Feature Installation and click Next to continue. 
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12. Select the features to install. When you select a feature, the corresponding information about this 

feature will be displayed on the right. Select the following features: 

• Database Engine Services 

• Reporting Services - Native (applicable only when you are using SQL Server Reporting services 

and/or Exact Globe Next with extended functionality) 

• Client Tools Connectivity 

• Integration Services 

• Documentation Components 

• Management Tools - Basic 

• Management Tools – Complete 

Besides selecting the features, you do not have to change anything else. Click Next to continue. 

 

13. Checks will be performed to identify issues that might block the installation. Click Show details >> 

to view the details of these checks. When a check has failed, a red icon will be displayed. You can 

click the link in the Status column for more information about the check and the error. After solving 

the issue, click Re-run to perform the checks again. 

Note:  

Depending on the situation, it may or may not be necessary to close the installation wizard and 

restart. 
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14. Click Next to continue. However, the Next button is available only when no checks have failed. 
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15. When the actions in the previous screen are completed, the screen will close automatically and the 

next screen will be displayed. In the Instance Configuration screen, define a name for the 

instance. This is the name for your SQL Server. Click Next to continue. 

Note: 

• New installation — When it is a new installation, there is no SQL Server present in your 

system yet. In this case, select Default instance. There is no need to change anything else in 

the screen. At the bottom of the screen, you can see if there are already other SQL Server 

instances present. When this is a new installation in a system where no SQL Server is present 

yet, this part of the screen is empty. 

• Installing new instance — When there are existing SQL Server installations present, you have 

to select Named instance and define a name in the box next to it, for example “SQL2014”. The 

name defined here has to be unique and cannot be the same as any of the names of the other 

instances that are already present on your system. The field Instance ID will be filled 

automatically and you do not have to change this manually. At the bottom of the screen, you 

can see if any other instances are present. 
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16. In this screen, under the Service Accounts tab, you can define which account you want to use for 

starting the MS SQL Server 2014 services. For a standard installation, accept the data as 

suggested in the screen. Keep in mind that when you select a user for which the password regularly 

changes, you will also have to change the password in the services every time. If you forget to 

change the password in the services, the services cannot be started and you will not be able to use 

the SQL Server until you have updated the password in the services, and have started the services. 

Depending on the account selected at Account Name, you have to enter the corresponding 

password at Password. 

17. In the Startup Type column, you can define that the service has to start automatically when the 

system starts. The SQL Server Database Engine is the SQL Server itself. This service should 

always be started in order to use the SQL Server. The SQL Server Browser service is a service 

that is used for identifying the ports that the installation of SQL Server listens to. This service needs 

to be started to enable network access. The Startup Type option of this service should be 

Automatic. The account name of this service cannot be changed. 
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18. Under the Collation tab, you can define the collation (character set) settings. For Western 

European countries, you can accept the collation as displayed in the screen. Click Next to continue. 

The following screen will be displayed: 

 

19. Under the Server Configuration tab, define how you would like to log on to the SQL Server. When 

you are working with Exact Synergy Enterprise and/or Exact Globe Next with extended functionality, 

select Mixed Mode (SQL Server authentication and Windows authentication). Type your 

password at Enter password and Confirm password. This password is a password that will be 

used for the SA user; this default user is the System Administrator within the SQL Server. If you 

select Windows authentication mode, you do not have to type a password. 

Note:  

Regardless of which Exact product you use, you will always have to define one user or more at the 

bottom of the screen. These users will be administrators on the SQL Server. You have to select at 

least one user. This user will be the administrator on the SQL Server and can also add other users 

later on. 
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20. Click Add Current User to add the users that are currently performing the installation as an 

administrator. Click Add to add other users or Remove to remove selected users. 

21. Click Next to continue. 

Note:  

The following screen will be displayed only if you have selected the Reporting Services – Native 

feature. 
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22. In this screen, define if you want to configure the reporting services feature now or if you want to 

configure it later. Select Install only to install the feature and configure it later. Click Next to 

continue. 
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23. In the Feature Configuration Rules screen, checks will be performed for problems that might 

occur during the installation. Click Show details >> to view the details of these checks. When a 

check has failed, a red icon will be displayed. You can click the link in the Status column for more 

information about the check and the error. After solving the issue, click Re-run to perform the 

checks again. 

Note:  

Depending on the situation, it may or may not be necessary to close the installation wizard and 

restart. 

24. Click Next to continue. However, this button is available only when no checks have failed. 

 



CHAPTER 2 | TECHNICAL IMPLEMENTATION 

59 

 

25. In the Ready to Install screen, a summary of the defined installation criteria will be displayed. Click 

Install to start the installation. 
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26. The screen displaying the progress of the installation will displayed. The installation might take 

some time. 

 

27. As soon as the installation has completed successfully, the installed components are displayed with 

a green icon. Click Close to close the wizard. 
28. To be able to access the SQL Server via a network, you have to activate some protocols. When 

working with a network environment, you have to check if the protocols are activated. If required, 

activate the protocols. 

• Start (on the server where MS SQL Server 2014 is installed) SQL Server Configuration 

Manager. In Windows, go to Start, select All Programs, followed by Microsoft SQL Server 

2014. Click Configuration Tools, and then SQL Server Configuration Manager. 

• Click SQL Server Network Configuration. 

• Select Protocols for xxxx. (“xxxx” has to be replaced by the name you have defined for the 

SQL Server during installation). 

• Right-click the protocols Named Pipes and TCP/IP and click Enable to enable these protocols. 
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29. You might also need to start the SQL Server Browser service. This service is used for identifying 

the ports that the installation of SQL Server listens to. When this service is not started, you can use 

the SQL Server only locally. To check if this service is started, follow these steps: 

• Start (on the server where MS SQL Server 2014 is installed) SQL Server Configuration 

Manager. In Windows, got to Start, select All Programs, followed by SQL Server 2014. Click 

Configuration Tools, and then SQL Server Configuration Manager. 

• Click SQL Server Services. 

• On the right side, the SQL Server Browser service is displayed. 

Note:  

When it is not started, the icon is red. When it is started, the icon is green. Ensure that the service 

starts automatically so that every time the system is restarted, the service will also start. 

• Right-click SQL Server Browser and select Properties. 

• In the SQL Server Browser Properties screen, click the Service tab. 

• At Start Mode, select Automatic, as displayed in the following screen: 
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• Click Apply to apply the changes. The SQL Server Browser service will now start automatically 

every time the system is started. 

• Next, start SQL Server Browser. 

• In the SQL Server Browser Properties screen, click the Log On tab. 

• Click Start to start the service. When the Start button is inactive, the SQL Server Browser 

service is already started and you do not have to start it. 

Note:  

When you have a firewall, you have to configure the firewall to allow connections with SQL Server 

2014. The default port for SQL Server 2014 is 1433. The SQL browser used UDP port 1434. 
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2.7.3 Installing Microsoft SQL Server 2008 R2 

The following describes the installation steps of Microsoft SQL Server 2008 R2 on the Windows Server 

2008 R2 platform for the optimum running of Exact Synergy Enterprise. 

 

To install Microsoft SQL Server 2008 R2: 

1. Insert the SQL Server 2008 R2 installation media. From the root folder, double-click setup.exe. 

This will check the necessary prerequisites in your system. You may be required to install the 

prerequisites, such as Microsoft .Net Framework version 4.7, or Windows Installer version 4.5. If 

the Microsoft SQL Server 2008 R2 Setup screen is displayed, click OK to install the prerequisites. 

Otherwise, click Cancel to exit the SQL Server 2008 R2 installation. 

 

2. Once the installation for the prerequisites is completed, you will need to restart the computer. Click 

Restart Now. 
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3. Restart SQL Server 2008 R2 setup.exe. The SQL Server Installation Center page will be 

displayed. Select Installation under the Planning section. 

 

4. Click New installation or add features to an existing installation. to proceed. 
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5. The Setup Support Rules screen will be displayed. Click OK to proceed after the scanning is 

done. 

6. On the Product Key screen at Enter the product key, type the product key, and then click Next. 

 

7. On the License Terms screen, select the I accept the license terms. check box and click Next. 
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8. Click Install to proceed. 

 

9. Click Next to proceed. 

 

Caution:  

You might receive a warning on the Windows Firewall. This is normal as, by default, Windows has 

blocked the TCP port. See http://msdn.microsoft.com/en-us library/ms175043.aspx to learn how to 

enable the TCP port. 

http://msdn.microsoft.com/en-us
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10. On the Setup Role screen, select SQL Server Feature Installation, and then click Next. 

 

11. On the Feature Selection screen, you can select the minimum required features, such as 

Database Engine Services, SQL Server Books Online, Management Tools – Basic, and 

Management Tools – Complete by selecting the corresponding check boxes. Click Next to 

proceed. 
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12. Click Next to proceed. 

 

13. Select Default instance if you do not have any SQL server instance installed or select Named 

instance if you have an existing SQL server installed. By default, the instance name is used as the 

instance ID as well. Click Next to proceed. 
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14. The Disk Space Requirements screen displays the summary of the disk space required for the 

installation. Click Next. 

 

15. Click the Account Name column for the SQL Server Agent and SQL Server Database Engine 

services and select NT AUTHORITY\SYSTEM. Click Next to proceed. 

 

Note:  

If you do not want to use the default regional setting of the system for language, you can select the 

collation that you want to install by clicking the Collation tab and setting the language yourself. 
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16. Select Mixed Mode (SQL Server authentication and Windows authentication) and type the 

system administrator password at Enter password. Then, click Add Current User to set yourself 

as the SQL server administrator. Finally, click Next to proceed. 
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17. Select the options for Error Reporting to specify the information that you want to send to Microsoft 

that will help to improve the SQL Server features and services. Click Next. 

 

18. Click Next to proceed. 
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19. Click Install to proceed. 

 

20. Click Close to exit the setup after the installation. 

 

21. Click X at the top right corner to close the SQL Server Installation Center. 
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2.7.4 Installing Microsoft SQL Server 2016 

In a standalone environment, you have to perform these steps on the workstation where you work with 

Exact Globe Next. In all other cases, you have to perform these steps on the server. 

When working in a standalone environment, you will have one computer on which you are working with 

Exact Globe Next. On this computer, both Exact Globe Next and the SQL Server are installed. This is 

seen as a standalone even when your computer is part of a network, as all software needed to work 

with Exact Globe Next are installed on this one computer. 

Before installing the SQL Server, check the system requirements for the specific SQL Server edition at 

https://msdn.microsoft.com/en-us/library/ms143506(v=sql.130).aspx. 

When these requirements are met, you can start installing SQL Server 2016. 

 

To install Microsoft SQL Server 2016: 

1. Log in as an administrator on the server (of a workstation in case of a standalone installation). 

2. Insert the SQL Server installation DVD into your DVD drive. When the autorun is not performed, 

open the DVD drive in Windows Explorer and start the installation by clicking Setup.exe. 

3. The SQL Server Installation Center screen will be displayed. In this screen, you can view and 

execute several installation tasks. 
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4. Click Installation on the left panel. Next, click New SQL Server stand-alone installation or add 

features to an existing installation. 
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5. In the Product Key screen, type the product key at Enter the product key if the product key is not 

filled automatically. Click Next to continue. The screen with the license terms will be displayed. 
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6. To continue, select I accept the license terms and click Next. 
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7. Checks will be performed to identify possible problems when installing the SQL Server Setup 

support files. The SQL Server Setup support files are needed for the installation of MS SQL Server 

2016 and are automatically installed via this installation wizard. Click Show details >> to view the 

details of these checks. When all checks are passed, the results are displayed in this screen. When 

a check has failed, a red icon will be displayed. You can click the link in the Status column for more 

information about the check and the error. After solving the issue, click Re-run to perform the 

checks again. 

Note:  

It is possible that some warnings are displayed regarding the firewall. In spite of the warnings, it is 

still possible to continue with the installation. Depending on the situation, it may or may not be 

necessary to close the installation wizard and restart. When all checks are passed, this screen will 

close automatically and the next screen will be displayed. 
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8. The Product Updates screen allows you to check for new update files online. However, you can 

click Skip Scan to skip this step. Click Next to continue. 
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9. The installation wizard will check for updates and install the available update files. As soon as this is 

done, the screen will close automatically and the next screen will be displayed: 
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10. Checks will be performed to identify potential problems that might occur during the installation. Click 

Show details >> to view the details of these checks. When a check has failed, a red icon will be 

displayed. You can click the link in the Status column for more information about the check and the 

error. After solving the issue, click Re-run to perform the checks again. 

Note:  

Depending on the situation, it may or may not be necessary to close the installation wizard and 

restart. 

11. Click Next to continue. However, the Next button is available only when no checks have failed. 
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12. Select the features to install. When you select a feature, the corresponding information about this 

feature will be displayed on the right. Select the following features: 

• Database Engine Services 

• Reporting Services — Native (applicable only when you are using SQL Server Reporting 

services and/or Exact Globe Next with extended functionality) 

• Client Tools Connectivity 

• Integration Services 

• Documentation Components 

Besides selecting the features, you do not have to change anything else. Click Next to continue. 

 

13. Checks will be performed to identify issues that might block the installation. Click Show details >> 

to view the details of these checks. When a check has failed, a red icon will be displayed. You can 

click the link in the Status column for more information about the check and the error. After solving 

the issue, click Re-run to perform the checks again. 

Note:  

Depending on the situation, it may or may not be necessary to close the installation wizard and 

restart. 
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14. Click Next to continue. However, the Next button is available only when no checks have failed. 
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15. When the actions in the previous screen are completed, the screen will close automatically and the 

next screen will be displayed. In the Instance Configuration screen, define a name for the 

instance. This is the name for your SQL Server. Click Next to continue. 

Note: 

• New installation — When it is a new installation, there is no SQL Server present in your system 

yet. In this case, select Default instance. There is no need to change anything else in the 

screen. At the bottom of the screen, you can see if there are already other SQL Server 

instances present. When this is a new installation in a system where no SQL Server is present 

yet, this part of the screen is empty. 

• Installing new instance — When there are existing SQL Server installations present, you have 

to select Named instance and define a name in the box next to it, for example “SQL2016”. The 

name defined here has to be unique and cannot be the same as any of the names of the other 

instances that are already present on your system. The field Instance ID will be filled 

automatically and you do not have to change this manually. At the bottom of the screen, you 

can see if any other instances are present. 
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16. In this screen, under the Service Accounts tab, you can define which account you want to use for 

starting the MS SQL Server 2016 services. For a standard installation, accept the data as 

suggested in the screen. Keep in mind that when you select a user for which the password regularly 

changes, you will also have to change the password in the services every time. If you forget to 

change the password in the services, the services cannot be started and you will not be able to use 

the SQL Server until you have updated the password in the services, and have started the services. 

Depending on the account selected at Account Name, you have to enter the corresponding 

password at Password. 

17. In the Startup Type column, you can define that the service has to start automatically when the 

system starts. The SQL Server Database Engine is the SQL Server itself. This service should 

always be started in order to use the SQL Server.  

The SQL Server Browser service is a service that is used for identifying the ports that the 

installation of SQL Server listens to. This service needs to be started to enable network access. The 

Startup Type option of this service should be Automatic. The account name of this service cannot 

be changed. 
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18. Under the Collation tab, you can define the collation (character set) settings. For Western 

European countries, you can accept the collation as displayed in the screen. Click Next to continue. 

The following screen will be displayed: 

 

19. Under the Server Configuration tab, define how you would like to log on to the SQL Server. When 

you are working with Exact Synergy Enterprise and/or Exact Globe Next with extended functionality, 

select Mixed Mode (SQL Server authentication and Windows authentication). Type your 

password at Enter password and Confirm password. This password is a password that will be 

used for the SA user; this default user is the System Administrator within the SQL Server. If you 

select Windows authentication mode, you do not have to type a password. 

Note:  

Regardless of which Exact product you use, you will always have to define one user or more at the 

bottom of the screen. These users will be administrators on the SQL Server. You have to select at 

least one user. This user will be the administrator on the SQL Server and can also add other users 

later on. 

20. Click Add Current User to add the users that are currently performing the installation as an 

administrator. Click Add to add other users or Remove to remove selected users. 
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21. Click Next to continue. 

Note:  

The following screen will be displayed only if you have selected the Reporting Services – Native 

feature. 
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22. In this screen, define if you want to configure the reporting services feature now or if you want to 

configure it later. Select Install only to install the feature and configure it later. Click Next to 

continue. 

 

23. In the Feature Configuration Rules screen, checks will be performed for problems that might 

occur during the installation. Click Show details >> to view the details of these checks. When a 

check has failed, a red icon will be displayed. You can click the link in the Status column for more 

information about the check and the error. After solving the issue, click Re-run to perform the 

checks again. 

Note:  

Depending on the situation, it may or may not be necessary to close the installation wizard and 

restart. 
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24. Click Next to continue. However, this button is available only when no checks have failed. 
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25. In the Ready to Install screen, a summary of the defined installation criteria will be displayed. Click 

Install to start the installation. 
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26. The screen displaying the progress of the installation will displayed. The installation might take 

some time. 

 

27. As soon as the installation has completed successfully, the installed components are displayed with 

a green icon. Click Close to close the wizard. 
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28. To be able to access the SQL Server via a network, you have to activate some protocols. When 

working with a network environment, you have to check if the protocols are activated. If required, 

activate the protocols. 

• Start (on the server where MS SQL Server 2016 is installed) SQL Server Configuration 

Manager. In Windows, go to Start, select All Programs, followed by Microsoft SQL Server 

2016. Click Configuration Tools, and then SQL Server 2016 Configuration Manager. 

• Click SQL Server Network Configuration. 

• Select Protocols for xxxx. (“xxxx” has to be replaced by the name you have defined for the 

SQL Server during installation). 

• Right-click the protocols Named Pipes and TCP/IP and click Enable to enable these protocols. 
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29. You might also need to start the SQL Server Browser service. This service is used for identifying 

the ports that the installation of SQL Server listens to. When this service is not started, you can use 

the SQL Server only locally. To check if this service is started, follow these steps: 

• Start (on the server where MS SQL Server 2016 is installed) SQL Server Configuration 

Manager. In Windows, go to Start, select All Programs, followed by SQL Server 2016. Click 

Configuration Tools, and then SQL 2016 Server Configuration Manager. 

• Click SQL Server Services. 

• On the right side, the SQL Server Browser service is displayed. 

Note:  

When it is not started, the icon is red. When it is started, the icon is green. Ensure that the service 

starts automatically so that every time the system is restarted, the service will also start. 

• Right-click SQL Server Browser and select Properties. 

• In the SQL Server Browser Properties screen, click the Service tab. 

• At Start Mode, select Automatic, as displayed in the following screen: 

 

• Click Apply to apply the changes. The SQL Server Browser service will now start automatically 

every time the system is started. 

• Next, start SQL Server Browser. 

• In the SQL Server Browser Properties screen, click the Log On tab. 

• Click Start to start the service. When the Start button is inactive, the SQL Server Browser 

service is already started and you do not have to start it. 

Note:  

When you have a firewall, you have to configure the firewall to allow connections with SQL Server 

2016. The default port for SQL Server 2014 is 1433. The SQL browser used UDP port 1434. 
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Installing SQL Management Studio for SQL Server 2016 

The next step is to install SQL Server Management Studio. SQL Server Management Studio is an 

application for managing the SQL Server. With SQL Server Management Studio, you can create and 

restore backups, change database settings, and give users SQL Server rights. 

• Log in as an administrator on the system where you have installed SQL Server 2016. 

• The setup file for SQL Server Management Studio can be downloaded from the Microsoft website 

(https://msdn.microsoft.com/library/mt238290.aspx). Place this file on the system where MS SQL 

Server 2016 is installed.  

• Start the installation by double-clicking the downloaded file. 

The following screen will be displayed: 

 

Click Install to start the installation. 

https://msdn.microsoft.com/library/mt238290.aspx
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During the installation, you can follow the progress of the installation. The following screens will be 

displayed. The installation can take some time. 
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When the installation is completed, the following screen will be displayed. You have to restart the 

system to complete the setup. 
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2.7.5 Installing and updating Microsoft SQL Server 2017 

Installing Microsoft SQL Server 2017 

This section describes the installation of SQL Server 2017 Standard Edition. The installation procedure 

for the Enterprise Edition is similar, but some screens may differ. 

Before installing, you should have, at the very least Exact Synergy Enterprise product update 261 to 

work with SQL Server 2017. 

In the following steps, it is assumed that you are installing the SQL server as a new installation or as a 

new instance: 

• For a new installation, there is no MS SQL Server software present in your system. After the 

installation, you will have one MS SQL Server. 

• When installing a new instance, install MS SQL Server next to your current MS SQL Server version. 

After the installation, you will have multiple MS SQL Servers; the one you have just installed, and the 

existing one(s) present in your system. 

The steps for installing a new instance are almost the same as the steps for installing the SQL server in 

a system where no other versions of SQL server are present. Where applicable, the difference(s) will be 

highlighted in this section. 

The next step is installing SQL Server 2017. In a standalone environment, you have to perform the 

following steps on the workstation where you work with Exact Synergy Enterprise. In all other cases, 

you have to perform the following steps on the server. 

When working in a standalone environment, you will have one computer on which you are working with 

Exact Synergy Enterprise. On this computer, both Exact Synergy Enterprise and the SQL server are 

installed. This is seen as a standalone even when your computer is part of a network, as all software 

needed to work with Exact Synergy Enterprise are installed on this computer. 

Before installing the SQL server, check the system requirements for the specific SQL server edition at 

https://msdn.microsoft.com/en-us/library/ms143506(v=sql.140).aspx. 

When these requirements are met, you can start installing SQL Server 2017. 

 

To install Microsoft SQL Server 2017: 

1. Log in as an administrator on the server (of a workstation for the standalone installation). 

2. Insert the SQL server installation DVD into your DVD drive. When the autorun is not performed, 

open the DVD drive in Windows Explorer and start the installation by clicking Setup.exe. 

 

 

https://msdn.microsoft.com/en-us/library/ms143506(v=sql.140).aspx
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3. The SQL Server Installation Center screen will be displayed. In this screen, you can view and 

execute several installation tasks. 
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4. Click Installation on the left panel. Next, click New SQL Server Stand-alone installation or add 

features to an existing installation. 
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5. In the Product Key screen, type the product key at Enter the product key if the product key is not 

filled automatically. Click Next to continue. The screen with the license terms will be displayed. 
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6. To continue, select I accept the license terms and click Next. 
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7. Checks will be performed to identify possible problems when installing the SQL Server Setup 

support files. The SQL Server Setup support files are needed for the installation of MS SQL Server 

2017, and are automatically installed via this installation wizard. Click Show details >> to view the 

details of these checks. If all the checks have passed, the results will be displayed in this screen. 

However, if a check has failed, a red icon will be displayed. You can click the link in the Status 

column for more information about the check and error(s). After solving the issue, click Re-run to 

perform the checks again. 

Note: 

It is possible that some warnings are displayed regarding the firewall. In spite of the warnings, it is 

still possible to continue with the installation. Depending on the situation, it is not necessary to close 

the installation wizard and restart. If all checks have passed, this screen will close automatically, 

and the next screen will be displayed. 
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8. The Microsoft Update screen allows you to check for new update files online. If you select this 

option and click Next, the Product Updates screen will be displayed whereby you can download 

the files. However, if you did not select this option, the Install Setup Files screen will be displayed. 
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9. The installation wizard will check for the updates, and install the available update files. Once 

completed, the screen will close automatically, and the next screen will be displayed: 

 

10. Checks will be performed to identify the potential problems that might occur during the installation. 

Click Show details >> to view the details of the checks. If a check has failed, a red icon will be 

displayed. You can click the link in the Status column for more information about the check and 

error(s). Once the issue is solved, click Re-run to perform the checks again. 

Note: 

Depending on the situation, it is not necessary to close the installation wizard and restart. 
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11. Click Next to continue. The Next button is enabled only if no checks have failed. 
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12. Select the features that you want to install. When you select a feature, the corresponding 

information about the feature will be displayed on the right. Select the following features: 

• Database Engine Services 

• Client Tools Connectivity 

• Integration Services 

• Full-Text and semantic extractions for Search: If you want to use the SQL full text search to 

search for feeds in the timeline of Exact Synergy Enterprise, this component should be selected. 

If you have not selected this component during the installation of the SQL server, you can install 

it at a later time. 

Besides selecting the features, you do not have to change anything else. Click Next to continue. 

 

13. Checks will be performed to identify the issues that might block the installation. Click Show details 

>> to view the details of the checks. If a check has failed, a red icon will be displayed. You can click 

the link in the Status column for more information about the check and error(s). After solving the 

issue, click Re-run to perform the check again. 

Note: 

Depending on the situation, it is not necessary to close the installation wizard and restart. 
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14. Click Next to continue. However, the Next button is enabled only if no checks have failed. 
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15. When the actions in the previous screen are completed, the screen will close automatically, and the 

next screen will be displayed. In the Instance Configuration screen, define a name for the 

instance. This is the name for your SQL server. Click Next to continue. 

Note: 

• New installation — When it is a new installation, there is no SQL Server present in your system. 

In this case, select Default instance. You do not have to change anything else in the screen. At 

the bottom of the screen, you can see if there are other SQL server instances present. If this is 

a new installation in the system whereby there is no SQL Server, this section will be blank. 

• Installing a new instance — When there are existing SQL server installations present, you have 

to select Named instance, and define a name for the instance, for example “SQL2017”. The 

name must be unique, and cannot be the same as the name of the other instances that are 

already present in your system. The Instance ID field will be filled automatically, and you do not 

have to change this manually. At the bottom of the screen, you can see if any other instances 

are present. 

 

16. In the Server Configuration screen, under the Service Accounts tab, you can define which 

account you want to use to start the MS SQL Server 2017 services. For standard installation, 

accept the data as displayed in the screen. However, when you select a user for which the 

password regularly changes, you will also have to change the password in the services each time 

the password changes. If you forget to change the password in the services, the services cannot be 

started, and you will not be able to use the SQL Server until you have updated the password in the 

services, and have started the services. Depending on the account selected at Account Name, you 

have to define the password at Password. 

 



CHAPTER 2 | TECHNICAL IMPLEMENTATION 

109 

 

17. In the Startup Type column, you can define to start the service automatically when the system 

starts. The SQL Server Database Engine is the SQL Server. This service should always be started 

to be able to use the SQL Server. 

The SQL Server Browser service is a service that is used to identify the ports that the installation 

of the SQL Server listens to. This service must be started to enable the network access. The 

Startup Type option for this service should be Automatic. The account name of this service cannot 

be changed. 
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18. Under the Collation tab, you can define the collation (character set) settings. For Western 

European countries, you can accept the collation as displayed in the screen. Click Next to continue. 

The following screen will be displayed: 

 

19. Under the Server Configuration tab, define how you want to log in to the SQL server. If you are 

working with Exact Synergy Enterprise and/or Exact Globe Next with extended functionality, select 

Mixed Mode (SQL Server authentication and Windows authentication). Type your password at 

Enter password and Confirm password. This password will be the password that will be used for 

the SA user; this default user is the System Administrator within the SQL server. If you select 

Windows authentication mode, you do not have to type the password. 

Note: 

Regardless of which Exact product you are using, you will always have to define one or more users 

at the bottom of the screen. These users will be the administrators for the SQL server. You have to 

select at least one user. This user will be the administrator for the SQL server, and can also add 

other users later on. 

20. Click Add Current User to add the users that are currently performing the installation as an 

administrator. Click Add to add other users, or Remove to remove the selected users. 
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21. Click Next to continue. 

 

22. In the Feature Configuration Rules screen, checks will be performed for the problems that might 

occur during the installation. Click Show details >> to view the details of these checks. If a check 

has failed, a red icon will be displayed. You can click the link in the Status column for more 

information about the check and the error(s). After solving the issue, click Re-run to perform the 

checks again. 

Note: 

Depending on the situation, it is not necessary to close the installation wizard and restart. 
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23. Click Next to continue. However, this button is enabled only if no checks have failed. 
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24. In the Ready to Install screen, a summary of the defined installation criteria will be displayed. Click 

Install to start the installation. 

 

25. The screen displaying the progress of the installation will be displayed. The installation might take 

some time. 

26. As soon as the installation has completed successfully, the installed components will be displayed 

with a green icon. Click Close to close the wizard. 
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27. To be able to access the SQL server via a network, you have to activate some protocols. When 

working with a network environment, you have to check if the protocols are activated. If required, 

activate the protocols. 

• Start (on the server where MS SQL Server 2017 is installed) SQL Server Configuration 

Manager. In Windows, go to Start, select All Programs, followed by Microsoft SQL Server 

2017. Click Configuration Tools, and then SQL Server 2017 Configuration Manager. 

• Click SQL Server Network Configuration. 

• Select Protocols for xxxx. (“xxxx” has to be replaced by the name you have defined for the 

SQL Server during the installation). 

• Right-click the Named Pipes and TCP/IP protocols, and click Enable to enable these protocols. 
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28. You might also need to start the SQL Server Browser service. This service is used to identify the 

ports that the installation of SQL server listens to. If this service is not started, you can use the SQL 

server only locally. To check if this service is started, do the following: 

• Start (on the server where MS SQL Server 2017 is installed) SQL Server Configuration 

Manager. In Windows, go to Start, select All Programs, followed by SQL Server 2017. Click 

Configuration Tools, and then SQL 2017 Server Configuration Manager. 

• Click SQL Server Services. 

• On the right side, the SQL Server Browser service is displayed. 

Note: 

If it is not started, the icon is red. However, if it is started, the icon is green. Ensure that the service 

starts automatically so that every time the system is restarted, the service will also start. 

• Right-click SQL Server Browser, and select Properties. 

• In the SQL Server Browser Properties screen, click the Service tab. 

• At Start Mode, select Automatic, as displayed in the following screen: 

 

• Click Apply to apply the changes. The SQL Server Browser service will now start automatically 

every time the system is started. 

• Next, start SQL Server Browser. 

• In the SQL Server Browser Properties screen, click the Log On tab. 

• Click Start to start the service. When the Start button is inactive, the SQL Server Browser 

service is already started, and you do not have to start it. 

Note: 

If you have a firewall, you have to configure the firewall to allow the firewall to connect with SQL 

Server 2017. The default port for SQL Server 2017 is 1433. The SQL browser uses UDP port 1434. 
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Updating Microsoft SQL Server 2017 

Before updating SQL Server 2017, ensure the existing SQL server supports updates. For a list of 

supported upgrade scenarios, see https://msdn.microsoft.com/en-us/sql/database-engine/install-

windows/supported-version-and-edition-upgrades-2017. 

Note: 

Back up all your databases. 

 

To upgrade Microsoft SQL Server 2017: 

1. Log in as an administrator on the server (of the workstation for a standalone installation). 

2. Insert the SQL server installation DVD into the DVD drive. If the autorun does not execute, open the 

DVD drive in Windows Explorer and start the installation by clicking Setup.ext. The following 

screen will be displayed: 

 

 

https://msdn.microsoft.com/en-us/sql/database-engine/install-windows/supported-version-and-edition-upgrades-2017
https://msdn.microsoft.com/en-us/sql/database-engine/install-windows/supported-version-and-edition-upgrades-2017
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3. Click Installation on the left panel, and then click Upgrade from a previous version of SQL 

Server on the right panel. The following screen will be displayed: 
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4. Select the Enter the product key option and type the product key if the product key is not filled 

automatically. Click Next to continue. The following screen will be displayed: 
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5. Select the I accept the license terms check box, and then click Next. The following screen will be 

displayed: 
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6. Checks will be performed to identify the possible problems when installing the SQL Server Setup 

support files. The SQL Server Setup support files are needed for the installation of SQL Server 

2017 and are automatically installed via this installation wizard. Click Show details >> to view the 

details of the checks. If all the checks are passed, the results will be displayed in the Global Rules 

screen. However, if a check has failed, a red icon will be displayed. You can click the hyperlink in 

the Status column to view the details of the check and error(s). Once the error is fixed, click Re-run 

to perform the checks again. 

Note: 

Some warnings about the firewall might be displayed. Despite the warnings, you can still continue 

with the installation. Depending on the situation, it is not necessary to close the installation wizard 

and restart. If all the checks are passed, the Global Rules screen will close automatically and the 

following screen will be displayed: 
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7. The Microsoft Update screen allows you to check for new update files online. If you select the Use 

Microsoft Update to check for updates (recommended) check box, the Product Updates 

screen will be displayed whereby you can download the files. Otherwise, the Install Setup Files 

screen will be displayed. 
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8. The installation wizard will check for updates and install the available update files. Once the files 

are updated, the screen will close automatically and the next screen will be displayed: 

 

9. In the Upgrade Rules screen, checks will be performed to identify the problems that might occur 

during the installation. Click Show details >> to view the details of the checks. If a check has failed, 

a red icon will be displayed. You can click the hyperlink in the Status column for more information 

on the check and error(s). Once the issue is solved, click Re-run to perform the checks again. 

Note: 

Depending on the situation, it is not necessary to close the installation wizard and restart. 
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10. Click Next and the following screen will be displayed: 
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11. At Select Instance, select the instance of the SQL server that you want to upgrade. The 

instance(s) will be displayed under the Installed instances section. The Instance Name column 

displays the name of the instance. The Version column displays the version of the instance. 

Version numbers that start with 10 apply to SQL Server 2008 (R2), version numbers that start with 

11 apply to SQL Server 2012, and version numbers that start with 12 apply to SQL Server 2014, 

and version numbers that start with 13 apply to SQL Server 2016. The <Shared Components> line 

applies to the extra components of the SQL server that are installed, such as SQL Server 

Management Studio. Click Next and the following screen will be displayed: 
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12. The Reporting Services Migration screen is displayed only if the reporting services component is 

installed for the previous SQL server version. 

Note: 

If Reporting Services is installed, this will be removed during the upgrade. Before you continue, 

back up your report server database, and your encryption key. Furthermore, Reporting Services for 

SQL Server 2017 is done via a separate installation, and you have to migrate the reports. 

Once you have made a backup of the report server database, and the encryption key, you can select 

the Uninstall Reporting Service check box, and click Next to continue. 
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13. The Select Features screen displays the components that will be upgraded. By default, the 

components that will be upgraded will be selected. You cannot change anything in the screen. This 

screen will close automatically. 

 

 



CHAPTER 2 | TECHNICAL IMPLEMENTATION 

127 

 

14. In the Instance Configuration screen, you can define the name and instance ID of the SQL server 

instance. Since you are upgrading the SQL server, you will not be able to change the name of the 

SQL instance. The SQL instance will use the same name. You do not have to change the instance 

ID and you can accept the value displayed in the screen. Click Next and the following screen will be 

displayed: 
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15. Under the Service Accounts tab in the Server Configuration screen, you can define the account 

that you want to use to start the SQL Server 2017 services. You do not have to change anything. 

Click Next and the following screen will be displayed: 
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16. The Full-text Upgrade screen is displayed only if the Full-Text and semantic extractions for 

Search component of SQL server is installed. This screen allows you to select an upgrade option 

for this component. This component is applicable if you use the SQL full text search to search for 

feeds in the timeline in Exact Synergy Enterprise. For this Exact Synergy Enterprise functionality, it 

is not important which option is selected. If you are using the SQL full text search component for 

other purposes, check with your system administrator to determine which option to select. Click 

Next to continue. 
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17. In the Feature Rules screen, checks will be performed to identify the problems that might occur 

during the installation. Click Show details >> to view the details of the checks. When a check has 

failed, a red icon will be displayed. You can click the hyperlink in the Status column for more 

information on the check and error(s). After you have fixed the issue, click Re-run to perform the 

checks again. The screen will automatically close after all the checks are successful. 

Note: 

Depending on the situation, it is not necessary to close the installation wizard and restart. 
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18. In the Ready to Upgrade screen, the list of upgrade and installation criteria will be displayed. Click 

Upgrade to start the upgrade and installation. 

 

19. The Upgrade Progress screen displays the progress of the installation. 

20. Once the installation has completed successfully, the installed components will be displayed with a 

green icon. Click Close to exit. 
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21. To be able to access the SQL server via a network, you have to activate some protocols. When 

working with a network environment, you have to check if the protocols are activated. If required, 

activate the protocols. 

• Start (on the server where MS SQL Server 2017 is installed) SQL Server Configuration 

Manager. In Windows, go to Start, select All Programs, followed by Microsoft SQL Server 

2017. Click Configuration Tools, and then SQL Server 2017 Configuration Manager. 

• Click SQL Server Network Configuration. 

• Select Protocols for xxxx. (“xxxx” has to be replaced by the name you have defined for the 

SQL server during installation). 

• Right-click the protocols Named Pipes and TCP/IP and click Enable to enable these protocols. 

 

 



CHAPTER 2 | TECHNICAL IMPLEMENTATION 

133 

 

22. You might also need to start the SQL Server Browser service. This service is used for identifying 

the ports that the installation of SQL server listens to. When this service is not started, you can use 

the SQL server only locally. To check if this service is started, follow these steps: 

• Start (on the server where MS SQL Server 2017 is installed) SQL Server Configuration 

Manager. In Windows, go to Start, select All Programs, followed by SQL Server 2017. Click 

Configuration Tools, and then SQL 2017 Server Configuration Manager. 

• Click SQL Server Services. 

• On the right side, the SQL Server Browser service is displayed. 

Note: 

When it is not started, the icon is red. When it is started, the icon is green. Ensure that the service 

starts automatically so that every time the system is restarted, the service will also start. 

• Right-click SQL Server Browser and select Properties. 

• In the SQL Server Browser Properties screen, click the Service tab. 

• At Start Mode, select Automatic, as displayed in the following screen: 

 

• Click Apply to apply the changes. The SQL Server Browser service will now start automatically 

every time the system is started. 

• Next, start SQL Server Browser. 

• In the SQL Server Browser Properties screen, click the Log On tab. 

• Click Start to start the service. When the Start button is inactive, the SQL Server Browser 

service is already started and you do not have to start it. 

Note: 

When you have a firewall, you have to configure the firewall to allow connections with SQL Server 

2017. The default port for SQL Server 2014 is 1433. The SQL browser used UDP port 1434. 
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Preparing your database to use Microsoft SQL Server 2017 

To change the compatibility level of  your upgraded databases: 

1. Go to Start ➔ All Programs ➔ Microsoft SQL Server 2017 ➔ Microsoft SQL Server Management 

Studio. 

2. Connect to the SQL server. 

3. Expand the tree view until you see the databases. 

4. Right-click a company database and select Properties. 

5. In the Database Properties screen, select Options on the left panel and select SQL Server 2017 

(140) at Compatibility level on the right panel, and then click OK. 

 

Note: 

You have to change the Compatibility level for every company database. 

 

Installing SQL Server Management Studio for Microsoft SQL Server 2017 

To install SQL Server Management Studio: 

The next step is to install SQL Server Management Studio. SQL Server Management Studio is an 

application for managing the SQL server. With SQL Server Management Studio, you can create and 

restore backups, change the database settings, and give the users SQL server rights. However, if you 

already have an older version of SQL Server Management Studio installed, it is advisable to install the 

most recent version of SQL Server Management Studio. The new version will be installed with the 

previous version so both versions can be used. 

• Log in as an administrator on the system where you have installed SQL Server 2017. 

• The setup file for SQL Server Management Studio can be downloaded from the Microsoft website 

(https://msdn.microsoft.com/library/mt238290.aspx). Save this file on the system where MS SQL 

Server 2017 is installed. 

• Start the installation by double-clicking the downloaded file. 

 

https://msdn.microsoft.com/library/mt238290.aspx
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The following screen will be displayed: 

 

Click Install to start the installation. 
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During the installation, you can follow the progress of the installation. The following screens will be 

displayed. The installation might take some time. 
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Once the installation is completed, the following screen will be displayed. You have to restart the 

system to complete the setup. 
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2.7.6 Installing SQL Server Reporting Services (SSRS) 

SQL Server Reporting Services (SSRS) is a server-based report generating software system from 

Microsoft. SSRS is part of Microsoft SQL Server, and can be used by the Reporting Services 

Integration functionality in Exact Synergy Enterprise. SSRS is also used by the dashboards in Exact 

Globe Next with extended functionality. 

From SQL Server 2017 onwards, SSRS must be installed via a separate installer. The following 

describes the SSRS installation. 

Note: 

Before installing SSRS, it is advisable to check whether SSRS is already installed in your system. 

 

To check SSRS: 

To check if SSRS is already installed in your system, do the following: 

1. Log in to the server that has Microsoft SQL Server installed. 

2. Search in the Start menu for “Report Server Configuration Manager”. 

3. If the “Report Server Configuration Manager” is available, this means the reporting services feature 

is already installed. However, if “Report Server Configuration Manager” is not available, install the 

reporting services feature. 

 

To install SSRS: 

1. Download the setup file from https://www.microsoft.com/en-us/download/details.aspx?id=55252. 

2. Log in as an administrator on the server where the SQL server is installed. 

 

https://www.microsoft.com/en-us/download/details.aspx?id=55252
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3. Open SQLServerReportingServices.exe. The following screen will be displayed: 
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4. Click Install Reporting Services. The following screen will be displayed: 

 

5. Select the Enter the product key option, and type the product key for SQL Server 2017. 
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6. Click Next. The following screen will be displayed: 

 

7. In the Review the license terms screen, read the license terms. If you agree with the license 

terms, select the I accept the license terms check box. 
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8. Click Next. The following screen will be displayed: 
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9. Click Next. The following screen will be displayed: 

 

10. Select the location to install SSRS. 
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11. Click Install. The following screen will be displayed: 
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12. Once the installation is completed, the following screen will be displayed: 

 

13. Restart the system. 

If you upgraded from the previous version of the SQL server to SQL Server 2017, and have a backup of 

your report server database and encryption, you have to select or restore the files in Report Server 

Configuration Manager. 

• Firstly, restore the backup of the report server database via SQL Server Management Studio. 

• Start Report Server Configuration Manager, and connect to the SQL server. 

• In Report Server Configuration Manager, select the report server database in the Database 

menu, and restore the backup of the encryption key in the Encryption keys menu. 
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3. INSTALLATION AND DATABASE 

CREATION 

Basically, installing Exact Synergy Enterprise involves three major steps. These are: 

• installing the software, 

• creating the database, and 

• configuring the background jobs. 

This chapter discusses the installation of the software and the creation of the database. Configurations 

of the background jobs and applications that support functions in Exact Synergy Enterprise are more 

elaborate and are discussed in Chapter 5 Background Jobs Configuration. 

Note:  

Before installing Exact Synergy Enterprise, the system must first be prepared as discussed in 

Chapter 2 Technical Implementation. 

 

3.1 INSTALLING EXACT SYNERGY ENTERPRISE 

Exact Synergy Enterprise can be installed from the compact disc installation media (CD-ROM) or from 

the Internet. The Exact Synergy Enterprise installer is available in different languages. The language of 

the installer is not the language of Exact Synergy Enterprise. When Exact Synergy Enterprise is 

operational, you can change the user interface language of Exact Synergy Enterprise. 

You can also choose to install Exact Synergy Enterprise using the alternative MSI installation file. For 

more information, see 7.2 Installing Exact Synergy Enterprise Using MSI. 

Caution:  

During installation, the installer will stop the IIS web server. If you are upgrading or installing Exact 

Synergy Enterprise in a critical web server in service, plan the installation time carefully to minimize 

web service disruption. 
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3.1.1 Installing Exact Synergy Enterprise from the CD-ROM 

You can select which language to use while installing Exact Synergy Enterprise by starting the 

appropriate executable file in the installation CD-ROM: 

Installer Language Executable File Name 

American English Setup_AE.exe 

German Setup_DE.exe 

Dutch Setup_NL.exe 

 

To install Exact Synergy Enterprise from CD-ROM: 

1. Insert the installation CD-ROM in the CD-ROM drive. 

2. Go to the Start menu, click Windows Explorer and browse to the installation CD-ROM. 

3. Double-click Setup_AE.exe to start the installer in American English. You can start the installer in 

German or Dutch by double-clicking Setup_DE.exe or Setup_NL.exe instead. 

 

 

4. At Local installation directory, type the full path where you want to install the Exact Synergy 

Enterprise application components, for example, “C:\Program Files\SynergyNET”. You can also 

select the folder by clicking the   icon. 
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5. Click OK and wait while the installer calculates the disk space requirement. 

 

6. When prompted, click Yes to continue installation. 

7. Wait a few minutes while Exact Synergy Enterprise is being installed. You can click Cancel to abort 

the installation but this is not recommended as the partial installation cannot be rolled back. 

8. Once completed, the installer will ask whether you want to start Exact Synergy Enterprise. 

9. Click Yes to start Exact Synergy Enterprise and begin creating the database. Take note that 

clicking Yes will open Exact Synergy Enterprise in Microsoft Edge using normal HTTP protocol. If 

your server allows only HTTPS connection or you want to start Exact Synergy Enterprise using 

HTTPS, click No instead and open it manually. 

Caution:  

If the current Windows user account is not the designated Exact Synergy Enterprise administrator, 

click No. Although you can start Exact Synergy Enterprise to specify the license and create the 

database, the database initialization will fail and the newly created database will be unusable. 

 

Note:  

Loading Exact Synergy Enterprise for the first time takes longer than usual. This is normal. 

You can proceed to the next step by creating the database as described in 3.2 Initializing Exact 

Synergy Enterprise. 
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3.1.2 Installing Exact Synergy Enterprise from the Internet 

In order to install Exact Synergy Enterprise from the Internet, you require the Exact Internet Installer. 

You can download this installer from one of the following web sites: 

• Customers — https://customers.exact.com 

• Resellers — https://partners.exact.com 

• Employees — https://employees.exact.com 

The Exact Internet Installer is available in several languages. Download the appropriate file for the 

language that you want to use to install Exact Synergy Enterprise: 

Installer Language Executable File Name 

American English ProductUpdater_T15_AE.exe 

German ProductUpdater_T15_DE.exe 

Dutch ProductUpdater_T15_NL.exe 

 

Caution:  

The Exact Synergy Internet installer (ProductUpdater_T8) cannot be used for installing Exact 

Synergy Enterprise. 

 

To install Exact Synergy Enterprise from the Internet: 

1. Go to the Start menu, click Windows Explorer and browse to the folder where you saved the 

downloaded Exact Internet Installer.  

2. Double-click the Exact Internet Installer. 
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3. At Install mode, select Internet installation.  

Note:  

The URL where Exact Synergy Enterprise will be downloaded is displayed at Web site. By default, 

this is https://update.exactsoftware.com. You do not need to change this unless informed otherwise 

by an Exact representative. 

4. At User name and Password, type your user name and password. Then, type the domain of the 

user account at Domain. For Exact customers and resellers, the domain is EWEB. 

5. Once you have defined the fields in the Please enter your credentials section, click Authenticate. 

6. At Release under the Installation section, select the release that you want to install. 

7. At Installation directory, type the full path where you want to install the Exact Synergy Enterprise 

application components, for example, “C:\Program Files\SynergyNET”. You can also select the 

folder by clicking the   icon. 
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8. At Update software, select one of the following options: 

• During download — The installer will stop the IIS web server while downloading and installing 

the files. Once the files have been downloaded and installed, the installer will restart the IIS web 

server. 

• After download — The installer does not stop the IIS web server during downloading of the 

files. After the files are completely downloaded, the installer stops the web server, installs the 

files, and then restarts the IIS web server. 

Caution:  

These settings are important especially when updating Exact Synergy Enterprise or installing on a 

server that is already serving other IIS web sites. On a slow internet connection, select After 

download to minimize web service disruption. 

9. Click OK and wait while the installer downloads the list of files and calculates the disk space 

requirement. 

 

10. When prompted, click Yes to continue installation. 

11. Wait while Exact Synergy Enterprise is being downloaded and installed. The time it takes to 

download and install depends on the speed of your Internet connection. You can click Cancel to 

abort the installation but this is not recommended as the partial installation cannot be rolled back. 

Once completed, the installer will ask whether you want to start Exact Synergy Enterprise. 
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12. Click Yes to start Exact Synergy Enterprise and begin creating the database. Take note that 

clicking Yes will open Exact Synergy Enterprise in Microsoft Edge using normal HTTP protocol. If 

your server allows only HTTPS connection or you want to start Exact Synergy Enterprise using 

HTTPS, click No instead and open it manually. 

 

Caution:  

If the current Windows user account is not the designated Exact Synergy Enterprise administrator, 

click No. Although you can start Exact Synergy Enterprise to specify the license and create the 

database, the database initialization will fail and the newly created database will be unusable. 

 

Note:  

Loading Exact Synergy Enterprise for the first time takes longer than usual. This is normal. 

13. You can proceed to the next step by creating the database as described at 3.2 Initializing Exact 

Synergy Enterprise. 
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3.2 INITIALIZING EXACT SYNERGY ENTERPRISE 

The Exact Synergy Enterprise installer creates a virtual directory called Synergy in the Microsoft 

Internet Information Services (IIS) web server. You can open Exact Synergy Enterprise by browsing to 

this virtual directory. For example, if your server address is https://deltabike.com, you can open Exact 

Synergy Enterprise by browsing to https://deltabike.com/synergy. 

Caution:  

Before accessing Exact Synergy Enterprise for the first time to create a database or open an 

existing one, make sure that the user account currently logged on to Microsoft Windows is the 

designated Exact Synergy Enterprise administrator. Otherwise, the database initialization will fail. 

 

3.2.1 Specifying valid Exact Synergy Enterprise licenses 

The first time Exact Synergy Enterprise is started, you are required to provide a valid license. For 

customers upgrading from Exact Synergy, the license is no longer valid. You can download your Exact 

Synergy Enterprise license from https://customers.exact.com. 

 

To provide valid Exact Synergy Enterprise licenses: 

1. If you have clicked Yes when prompted by the Exact Synergy Enterprise installer after completing 

the installation, Microsoft Edge will start with Exact Synergy Enterprise. Otherwise, you can start 

Microsoft Edge and browse to the Exact Synergy Enterprise portal. 

Caution:  

If you are starting Exact Synergy Enterprise from the web server it is installed on and the web 

server is configured for HTTPS connection, avoid using https://localhost/synergy. Instead, use the 

complete domain name as issued in the server certificate to avoid certificate error. 

 

2. Click Browse and select the license file. The license file has an ELC file name extension. 

3. Click Continue. 

After providing a valid license, you can proceed to create a database or open an existing database. 

 

https://deltabike.com/
https://deltabike.com/synergy
https://customers.exact.com/
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3.2.2 Creating Exact Synergy Enterprise databases 

After providing the license file, the Database: Create page will be displayed. You can either create a 

database or open an existing database. 

 

 

To create Exact Synergy Enterprise databases: 

1. On the Database: Create page, click Create a new Exact Synergy Enterprise database. 

 

2. Under the Database section, type the name of the database server at Server. 

3. Type the name of the database at Database. This cannot be edited once the database is created. 

Caution:  

If the database name is not “Synergy”, a virtual directory will be created in the IIS web server with 

the entered name. Exact Synergy Enterprise can then be accessed at this virtual directory. For 

example, if the name is “deltabike”, Exact Synergy Enterprise can be accessed at 

https://deltabike.com/deltabike. Therefore, it is advisable for first time users to use “Synergy” as the 

database name. 

4. Select the collation for your database at Collation. You have the option to use the local collation by 

selecting Server default or the international collation by selecting International 

(Latin1_General_CI_AS). 
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5. At Directory, type the full path to the folder where you want the SQL database to be stored. If you 

leave this blank, Exact Synergy Enterprise will create the SQL database in the default Microsoft 

SQL Server data folder, which is usually “C:\Program Files\Microsoft SQL 

Server\MSSQL10_50.SQL2008R2\MSSQL\Data”. 

Caution:  

The folder specified at Directory must exist or Exact Synergy Enterprise will display an error 

message. If the folder does not exist in the system, you will need to create it before clicking Create. 

6. Select the Default check box to make this the default database. When you log into Exact Synergy 

Enterprise, this is the database that will be used by default. 

7. Under the Administrator section, type the Windows login name, full name, and ID of the Exact 

Synergy Enterprise administrator at User name, Full name, and ID respectively. 

Caution:  

The User name must be the same as the login name of the user who is currently logged on to 

Microsoft Windows or the database initialization will fail. Due to this, ensure that the Exact Synergy 

Enterprise administrator is the current user logged on to Microsoft Windows before creating the 

database. 

 

Note:  

The ID of users created subsequently will progress from this number. For example, if the ID of the 

administrator is “1”, the ID of the next user created will be “2”. 

8. Under the Login section, define the authentication method to log into the Microsoft SQL Server in 

order to create the database. If the current Microsoft Windows login has administrative rights to the 

database server and you want to use the Windows Authentication method, select the Integrated 

security check box. Otherwise, clear the check box and type the Microsoft SQL administrator login 

name and password at Login name and Password respectively. 

9. Under the Division section, type the company code (up to three digits) and name for the first 

company to be created in the database at Code and Name respectively. 

Note:  

This section is disabled if the Demo company check box under the Database section is selected. 

10. Under the Settings section, select the country this new database at Country. 

Note:  

The Country box will be disabled if the Demo company check box under the Database section 

has been selected. 
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11. Select the settings for the account code, debtor code, and creditor code at Account code, 

Customer code (or Debtor code), and Vendor code (or Creditor code) respectively: 

• Numerical — Select this option to use only numbers as account, debtor, or creditor codes. 

• Alphanumerical — Select this option to allow both numbers and letters for the codes. 

Caution:  

The default option for each code setting is Numerical. Do not select the Alphanumerical option for 

any of the code setting if there will be data replication with the back-office system. These settings 

cannot be changed after the database is created. 

12. Click Create and wait while Exact Synergy Enterprise creates the database. After the database is 

created, the Exact Synergy Enterprise environment is loaded. 

Note:  

All fields with the “!” icon are mandatory. 
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3.2.3 Opening an existing Exact Synergy Enterprise database 

If you have an existing Exact Synergy database, you can open the database in the newly installed 

system after providing the license file. Exact Synergy Enterprise will automatically update the database 

as required. 

Caution:  

If the database that you are opening was created in Exact Synergy Enterprise, it is highly 

recommended that you read the document titled Exact Synergy Enterprise: Database 

Conversion Manual in order to convert the database correctly to Exact Synergy Enterprise. 

 

Note:  

A file named db.config is used by Exact Synergy Enterprise to store information about the different 

Exact Synergy Enterprise database portals. This file is automatically created in the folder where 

Exact Synergy Enterprise is installed after creating or opening a database. 

 

To open an existing Exact Synergy Enterprise database: 

1. On the Database: Create page, click Open an existing Exact Synergy Enterprise database. 

 

2. Under the Database section, type the name of the database server at Server. 

3. Type the SQL name of the existing database at Database. 

Tip:  

The database will be attached automatically to the virtual directory where the initialization page is 

accessed. For example, you can create a dbike virtual directory in IIS and allow scripts to be 

executed in the virtual directory. Then, open Microsoft Edge and browse to the virtual directory, for 

example, https://deltabike.com/dbike. After providing the license and opening the database, Exact 

Synergy Enterprise automatically assigns the database to this directory. If you are creating several 

virtual directories and using the same database for these directories, remember to restart the IIS 

web server. An alternative method is to edit the db.config file manually where you do not need to 

restart the IIS web server. For more information on the db.config file, see 3.2.4 Manually editing 

the database configuration file. 

4. Under the Login section, define the authentication method to log into the Microsoft SQL Server in 

order to open the database. If you are the database administrator and you want to use the 

Windows Authentication method, select the Integrated security check box. Otherwise, clear the 

check box and type the Microsoft SQL administrator login name and password at Login name and 

Password respectively. 
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5. Click Open and wait while Exact Synergy Enterprise opens the database and updates the database 

if required. After the database is opened, the Exact Synergy Enterprise environment will be loaded. 

 

Caution:  

In order to avoid any errors, ensure that you are an existing employee in the Exact Synergy 

Enterprise database. 

 

Note:  

All fields with the “!” icon are mandatory. 
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3.2.4 Manually editing the database configuration file 

The database configuration is stored in the db.config file in the root of the folder where Exact Synergy 

Enterprise is installed. This file is created when a database is created or an existing database is 

opened. 

Tip:  

In Exact Synergy, the database configuration was named baco.cfg. 

You can manually edit this file to assign a database in Exact Synergy Enterprise to a virtual directory. 

Although this is done automatically when you open a database, you might want to edit this file manually 

in certain situations: 

• You want to attach the database to several virtual directories but you want to avoid restarting the IIS 

web server. 

•  You want to configure a different IIS web server machine in a multi-server setup to access the same 

database but using a different virtual directory name. 

• The file is missing or corrupted. 

The db.config file is a plain text file. Therefore, you can edit or create the file using a plain text editor, 

such as Microsoft Notepad. 

The following is a sample of the db.config file: 

 

Caution:  

It is recommended that you back up the db.config file before making any changes. Either rename 

the backup file, such as db (original).config or store the backup file in another different folder. 

In this file, you can attach the database to other IIS virtual directories or web sites. 
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To attach virtual directories to the db.config file: 

1. Open the db.config file. 

2. Add the following codes before the </databases> tag: 

 

3. Replace virtual_directory_name, sql_database_name, and sql_server_address with the 

appropriate values. For more information on creating virtual directories, see 3.3.4 Creating web 

sites and virtual directories in IIS. 

4. Save the db.config file. If the virtual directory is able to run properly, you may then proceed with 

deleting the backup file. 

Caution:  

Make sure that the IIS virtual directory is created with scripts that are allowed to be executed. You 

can then browse to the virtual directory and access Exact Synergy Enterprise as long as you are a 

valid employee that is not blocked in the database. 

In case you are configuring a new web server in a multi-server setup, copy the db.config file from the 

existing server to the new server and make changes as necessary. You can also recreate the 

db.config file if it is missing or corrupted, such as when installing Exact Synergy Enterprise in a new IIS 

web server after the existing server failed. 

 

To attach web sites to the db.config file: 

You can also use the same principles described in the procedures above to attach web sites to the 

db.config file by adding the following codes before the <databases> tag: 

 

Replace host_name, sql_database_name, and sql_server_address with the appropriate values. For 

more information on creating web sites, see 3.3.4 Creating web sites and virtual directories in IIS. 
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3.3 SETTING UP EXACT SYNERGY ENTERPRISE PORTALS 

A business organization generally allows a particular category of people to access specific business 

information and processes. Exact Synergy Enterprise provides such control by having different portals 

for different categories of people. 

 

3.3.1 Portal types in Exact Synergy Enterprise 

There are five types of portals in Exact Synergy Enterprise: 

• Web Portal 

• Customer Portal 

• Reseller Portal 

• Supplier Portal 

• Employee Portal 

The Web Portal is an anonymous portal meant for the general public and is accessible by anyone on 

the World Wide Web. The other portals are authenticated portals where only customers, resellers, 

suppliers, and employees of the company who are allowed to access can log in with their user names 

and passwords. You can also create custom portals for all portal types. 
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3.3.2 Portal accesses and authentications 

In order to enable proper authentication for the portals, Exact Synergy Enterprise uses Windows 

Authentication. Exact Synergy Enterprise determines the type of portals to load and access to grant to 

the user based on this authentication. 

 

Accessing the anonymous Web Portal 

Exact Synergy Enterprise allows you to create several web sites for the Web Portal and assign each 

web site to a domain name. Whenever an anonymous user accesses one of these domain names, the 

Web Portal will display the associated web site. 

Since the Web Portal does not require any user authentication, a specific Windows user account is not 

necessary. The IIS web server assigns the Internet Guest Account (IUSR_<domain>) to the user. 

When a user accesses Exact Synergy Enterprise, Default.aspx redirects the user to Portal.aspx. 

When Portal.aspx detects that the user account is an Internet Guest Account, Portal.aspx displays a 

public news page. 

Tip:  

You can create custom web sites for the Web Portal in Exact Synergy Enterprise at Modules → 

Documents → Setup → Maintenance → Web sites. 

If you want the anonymous portal to load custom web sites, you will need to create a special redirector 

page pointing the user to SysWebSite.aspx. This is described at 3.3.5 Configuring anonymous portal. 

Based on the domain name used to access the Web Portal, SysWebSite.aspx displays the proper 

web site to the user. 

 

Accessing the authenticated portals 

The authenticated portals require each user to have a Windows user account in the designated domain. 

The users must authenticate themselves with their user names and passwords before they are granted 

access by Exact Synergy Enterprise to these portals. 

When a user visits an authenticated Exact Synergy Enterprise portal, the IIS web server verifies the 

user name and password against a Windows user accounts before allowing access to Default.aspx. 

Then, Default.aspx redirects the user to Portal.aspx. 

Based on the authenticated user name, Portal.aspx determines automatically the type of portal to 

present to the user. For example, when a customer logs in to Exact Synergy Enterprise, the Customer 

Portal is loaded for the customer. 
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3.3.3 Segregating user accounts by types 

In an Exact Synergy Enterprise implementation with a large number of users, it is recommended that 

you segregate the user accounts in separate domains based on user types. These user accounts can 

be segregated either by using different domains or Microsoft Windows Active Directory containers. 

 

 

Prerequisites to segregating user accounts based on types 

The following configuration must be in place to allow Exact Synergy Enterprise to manage the Windows 

user accounts: 

• The domains or Active Directory containers for each authenticated portal type must be configured 

under the Server section of Modules → HRM → General → Settings in Exact Synergy Enterprise. 

• The Exact.Jobs.SysMaint background job must be set up and running properly in the application 

server. For more details, see Chapter 5 Background Jobs Configuration. 

Caution:  

Incorrect set up of the Exact.Jobs.SysMaint background job can cause improper additions or 

deletions of Windows user accounts in the domain. 
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3.3.4 Creating web sites and virtual directories in IIS 

The Exact Synergy Enterprise installer creates a virtual directory called Synergy in the Default Web 

Site in the IIS web server. You can further create other web sites or virtual directories for setting up 

anonymous and authenticated portals for Exact Synergy Enterprise. 

In order to set up Exact Synergy Enterprise portals, web sites or virtual directories must be created in 

the IIS web server. The following summarizes some aspects of web sites and virtual directories: 

• A web site can be linked to many IP addresses where each IP address is assigned to a different 

Local Area Network (LAN) interface in the web server. 

• A single IP address can be linked to several web sites where each web site is assigned a different 

Domain Name System (DNS) name. 

• A DNS name can be assigned as a host header to receive the network traffic to the web site when 

an IP address is used for multiple web sites in a web server. 

• Virtual directories are just components of a web site and thus, do not have addresses or DNS 

names. 

• Multiple virtual directories can be created in one web site and this is useful in setting up different 

portals. 

• The name of each virtual directory has to be unique within one web site. 

 

To create Exact Synergy Enterprise web sites: 

1. Go to Start → Control Panel → Administrative Tools → Internet Information Services (IIS) Manager. 

2. In the left pane, expand the server node.  
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3. Right-click Sites and select Add Website…. The Add Website page will be displayed. Define the 

required fields as follows, and then click OK: 

 

• Site name  — Type a name for your web site. 

• Application pool — Click Select… to select the application pool associated to the web sites. 

Content Directory section: 

- Physical path — Type the relevant path or browse to select the path of the web sites. 

- Pass-through authentication — To enable proper authentication for the web sites, click 

Connect as and select the option Specific user: to allow users with specific credentials to 

access the path. Otherwise select the option Application user (pass-thru 

authentication). 

- Test Settings — Click this to verify the settings specified for the content directory. 
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• Binding section: 

- Type — Select the type of protocol applicable to the web site.  

- IP address — Define the IP address assigned to the web sites. Leave it as it is when only 

one web site is created. 

- Port — Type the TCP ports assigned to the web sites. 

- Host name — Type the host header name for the web sites sharing specific IP address 

with several DNS names. 

 

 

To create Exact Synergy Enterprise virtual directories: 

1. Go to Start → Control Panel → Administrative Tools → Internet Information Services (IIS) Manager. 

2. In the left pane, expand the server node and click Sites to expand it. 

3. Right-click Default Web Site and select Add Virtual Directory…. 
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4. In the Add Virtual Directory screen, type the virtual directory name at Alias. This alias will be the 

address of the Exact Synergy Enterprise virtual directory. 

 

5. At Physical path, type a full path or browse for the full path to the folder. 

6. Click Connect as and select the option Specific user: which requires specific credentials to access 

the path. Otherwise select the option Application user (pass-thru authentication) in the Connect 

As screen. To verify the settings specified for the virtual directory, click Test Settings. 

7. Click OK. 
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To enable 32-bit applications on a 64-bit system with Exact Synergy Enterprise: 

1. Go to Start → Control Panel → Administrative Tools → Internet Information Services (IIS) Manager. 

2. In the left pane, expand the server node and click Application Pools. 

3. On the Application Pools pane, right-click required application pool and select Advanced 

Settings…. 

4. At Enable 32-bit Applications, select True, and then click OK. 

 

After the web site or virtual directory is created, you need to configure the web site for anonymous or 

authenticated access, depending on the type of portal you are assigning to the web site or virtual 

directory. 
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3.3.5 Configuring anonymous portals 

For the anonymous Web Portal, you will need to observe several requirements: 

• Before anonymous users can access the Web Portal, you need to create the ExactWebGuest 

special account in Exact Synergy Enterprise. 

• If you plan to redirect the anonymous users to a custom web site, you will need to create a custom 

redirector file. 

• The web site or virtual directory must be properly configured and must allow anonymous access. 

 

To create Exact Web Guest special accounts: 

1. Go to the Start menu and click Run. At Open, type SqlWb.exe and click OK. 

2. In the Connect to Server screen, define the relevant information and click Connect. 

3. Double-click the Microsoft SQL Server node containing the Exact Synergy Enterprise database, and 

then double-click Databases. Then, right-click the Exact Synergy Enterprise database branch and 

click New Query. 

 

4. In the query area in the right-pane, type the following query, replacing <country_code> and 

<division_code> with the proper values according to your requirements: 

 



CHAPTER 3 | INSTALLATION AND DATABASE CREATION 

171 

 

5. Then, click the Query menu and select Execute. If the ExactWebGuest account is not available 

yet, it will be created. Otherwise, an error message telling you that you cannot insert a duplicate key 

row will be displayed. In this case, the ExactWebGuest account already exists. 

6. Close Microsoft SQL Server Management Studio. 
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To create custom redirector files: 

1. Using Windows Explorer, browse to the folder where Exact Synergy Enterprise is installed. 

2. Right-click the Default.aspx file and select Copy. 

3. Right-click a blank space in the folder and select Paste. You will see the Copy of Default.aspx file. 

4. Right-click the Copy of Default.aspx file and select Rename. Then, type a valid file name, such as 

webdefault.aspx and press the ENTER key. For clarity, the file will be referred to as 

webdefault.aspx onwards. 

Tip:  

If you do not see the .aspx file extension, you must first clear the Hide extensions for known file 

types check box under the Advanced settings section in the View tab of Folder Options. You can 

access Folder Options by selecting Folder Options from the Tools menu of Windows Explorer. 

5. Then, right-click the webdefault.aspx file and select Edit. Microsoft Notepad will open the file for 

editing. 

 

6. In the line that says Response.Redirect(“docs/Portal.aspx”), change the code Portal.aspx to 

SysWebSite.aspx. 

7. Click the File menu, select Save, and then close Microsoft Notepad. 
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To configure web sites as anonymous web portals: 

Tip:  

You can use the same principles described in this procedure to also configure an Exact Synergy 

Enterprise virtual directory for anonymous access. 

1. Go to Start → Control Panel → Administrative Tools → Internet Information Services (IIS) Manager. 

2. To configure the Authentication feature, expand the server node and Sites in the left pane. 

3. Click the site for which you want to enable Windows Authentication. 

4. In Features View, double-click Authentication under the IIS section. 

5. In the Authentication pane, right-click Anonymous Authentication and select Enable. Disable 

the rest of the authentication methods as follows: 

 

6. To configure the Logging feature: 

7. In the left pane, expand the server node, expand Sites, and then select the required site in the left 

pane.  

8. In Features View, double-click Logging under the IIS section.  

9. In the Logging pane, select W3C at Format: under the Log File section. Type or browse the path 

where you want to store the log file at Directory.  
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10. Under the Log File Rollover section, select Daily at Schedule for the IIS to create a log file, and 

then select Apply in the Actions pane. 

 

11. To configure Default Document feature, click the required site in the left pane. 

12. In Features View, double-click Default Document under the IIS section.  
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13. In the Default Document pane, in the Actions pane, click Add… and type webdefault.aspx (or 

the name you gave to the file created in the previous procedure). Click OK. 
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14. Remove all other entries in the box by clicking Remove after selecting each entry. Select Yes when 

prompted to remove the selected default document. 

 

Once you have configured the proper custom web sites in Exact Synergy Enterprise, whenever a public 

user browses to this web site, SysWebSite.aspx will load and present the user with the proper web 

site. 
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3.3.6 Configuring authenticated portals 

For authenticated portals, apart from configuring the web sites or virtual directories, you will also need 

to set the appropriate portal settings under the Server section via Modules → Customers → Setup → 

Other → Settings in Exact Synergy Enterprise. 

 

To configure web sites as authenticated portals using Windows Authentication method: 

Tip:  

You can use the same principles described in this procedure to also configure an Exact Synergy 

Enterprise virtual directory for authenticated access. 

1. Go to Start → Control Panel → Administrative Tools → Internet Information Services (IIS) Manager. 

2. Expand the server node and Sites in the left pane and click the required site. 

3. In Features View, double-click Authentication under the IIS section. 

4. In the Authentication pane, right-click Windows Authentication and select Enable. Disable the 

rest of the authentication methods as follows: 

 

To configure the Logging and Default Document features on authenticated portals, see 3.3.5 

Configuring anonymous portals.  
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When a user browses to this web site, the user will be authenticated either through Windows 

Authentication or Basic Authentication. The user will then be directed to the SysWebSite.aspx file. 

SysWebSite.aspx will then present the appropriate portal to the user based on the user authentication. 

Caution:  

Remember to set the appropriate portal settings under the Server section via Modules → 

Customers → Setup → Other → Settings in Exact Synergy Enterprise so that authenticated users 

are directed to the correct portals. 

 

Note:  

You can also redirect users to a login page for authentication using Forms Authentication. To do 

so, disable Windows Authentication and/or Basic Authentication before enabling Forms 

Authentication. 
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4. INITIAL COMPANY CONFIGURATION 

This chapter describes the setting up of a company in Exact Synergy Enterprise after a database has 

been created. The procedures involve tasks to be performed in various menu paths where the 

necessary settings in different modules can be defined and customized. 

Note:  

The specific settings for each installation depend on the company’s needs. Exact Synergy 

Enterprise has to be implemented with a complete planned approach with clear goals and means of 

achieving these goals during the implementation phase. For more information, see Chapter 1 

Approach to Project Implementation. 
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4.1 GENERAL SETTINGS 

General settings affect the general functioning of Exact Synergy Enterprise. They form the bases of all 

settings in the software, and hence must be set up first. The following page shows the information of the 

general settings already defined when you set up a company in Exact Synergy Enterprise. You can 

view the information by going to the General section via Modules → System → Setup → Database → 

Set up company. 

 

 

General section 

Financial 

Click the Check hyperlink in the Value column and you will see the Financial: Settings page where 

you can define important financial settings. For more information, see 4.1.1 Defining general financial 

settings. 

 

Countries 

The number displayed in the Value column indicates the number of active countries in the system. Click 

the number hyperlink and you will see the System: Countries page where you can display an overview 

of the countries and activate or deactivate the countries. 
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Currencies 

The number displayed in the Value column indicates the number of active currencies in the system. 

You need to activate the currencies before you can use the currencies. Click the number hyperlink and 

you will see the Currencies page where you can display an overview of the currencies and activate the 

currencies that you want to use in the system. For more information, see 4.1.5 Activating currencies. 

 

Divisions: Groups 

The number displayed in the Value column indicates the number of available division group layouts in 

the system. Click the number hyperlink and you will see the HRM: Groups page where you can define 

the different division group layouts. The layouts are important as you can use different layouts to display 

your division groups and divisions in your organization chart. For more information, see 4.1.11 Setting 

up organization structure. 

 

Create: Division 

The number displayed in the Value column indicates the number of divisions which have been created 

in the system. Click the number hyperlink and you will see the HRM: Divisions page where you can 

see the overview of divisions and create divisions. For more information, see 4.1.12 Creating divisions. 

 

Categories: Cost centres 

The number displayed in the Value column indicates the number of available cost center group layouts 

in the system. Click the number hyperlink and you will see the HRM: Cost centre groups page where 

you can define the different cost center group layouts. For more information, see 4.1.13 Defining cost 

center group layouts and subgroups. 

 

Create: Cost centre 

The number displayed in the Value column indicates the number of cost centers which have been 

created in the system. Click the number hyperlink and you will see the HRM: Cost centres page where 

you can display an overview of the cost centers and create cost centers. For more information, see 

4.1.14 Creating cost centers. 
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4.1.1 Defining general financial settings 

Before you use the financial applications in Exact Synergy Enterprise, you should define the financial 

settings. With the financial settings, you can configure the functions available in the Financial module. 

Among the most important general financial settings you should define are the default Currency, 

Country, and the Check closed periods options. To define the general financial settings, go to 

Modules → Financial  → Setup → General → Settings, and then click Edit. 

To set up the general financial settings, function right 39 - Maintain financial settings is required. 

Users with the General manager and Controller roles have this function right. 

 

 

General section 

Main holding division 

Type or select the reporting entity to determine the organization that needs to prepare the general 

purpose financial reports for financial consolidation. If financial consolidation is not required, type or 

select a division. 

 

Country 

Type or select the default country to be used in the system at Country. Only active countries can be 

selected. 
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Currency 

At Currency, type or select the default currency to be used in the system. This is important as you need 

to define the default currency before the system can be operational. Once you have created 

transactions in the default currency, it is not possible to change the default currency of the system. Only 

active currencies can be selected. For more information, see 4.1.5 Activating currencies. 

 

Check closed periods 

Select Date or Reporting date at Check closed periods to determine which is to be used when 

checking the close or open status of the financial period for the division. 

 

General ledger links section 

Calculation differences 

Type or select the default general ledger account to be used for recording currency calculation 

differences. 

 

Euro calculation difference 

Type or select the default general ledger account to be used for recording Euro calculation differences. 

Note:  

Before you can select the general ledger accounts, you need to create the general ledger accounts. 

For more information, see 4.1.8 Creating corporate and division general ledger accounts. 

 

Export: G/L Account section 

Classification 

Select the classification of the general ledger account category used when exporting the general ledger 

schema (chart of accounts) from Exact Synergy Enterprise. 

 

Sub-classification 

Select the sub-classification of the general ledger account category used for exporting the general 

ledger schema from Exact Synergy Enterprise. 

Note:  

Only active general ledger account categories can be selected at Classification and Sub-

classification. For more information, see 4.1.9 Defining general ledger account categories. 
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Import section 

Reopen: Periods (Automatically) 

Select this check box to automatically reopen the closed financial periods when financial entries are 

imported into these periods. If the check box is not selected, reopening of closed periods has to be 

done manually. 

 

Show alert after 

Select a number to indicate the maximum number of days that will be displayed at Days in the Import: 

Status column in the division status report. This report can be accessed at Modules → Financial → 

Reports → Analysis → Division: Status. The report allows you to identify the last date and the number 

of days the financial transactions were uploaded. If the last import date in the report exceeded the 

number of days defined at Show alert after, you will see a cross in the report. This is also displayed at 

Days in the Import: Status column. You can enter a maximum of 30 days for this field. 

 

Document: Type 

Select a document type to display the default job report when the background check on the financial 

transactions is made. This report is displayed when you click Date in the Check column in the 

Division: Status report. 

 

Import: Check section 

Document: Deletion date 

Select a number to indicate the number of days required to delete reports that record the comparisons 

of the financial data by division between Exact Synergy Enterprise and its back-office. You can enter a 

maximum of 30 days for this field. 

 

Import financial data section 

Document type 

Select the document type to display the Save attachment check box at Modules → Financial → Entry 

→ Transactions → Import financial data. If you do not make a selection here, the check box will be 

unavailable. 

Note:  

This section is available only if you have the module license YA1040 – Financial 

consolidation and option 470. 
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Financial consolidation section 

Opening balance: Year / Period 

Select a year and type a period to enter the opening balance for financial consolidation and start the 

consolidation at the fixed period of the financial year. You can leave this blank if you do not need to 

enter any consolidation opening balances as in the case when you run financial consolidation from the 

very first period in the system. This case is probably only true for new Exact Synergy 

Enterprise installations. 

Note:  

This section is available only if you have the module license YA1040 – Financial 

consolidation and option 470. 
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4.1.2 Creating financial years and periods 

Financial figures are statutorily required to be reported based on financial years. Meanwhile, business 

performance figures can be reported on a periodic basis, for example, on a monthly frequency within a 

financial year. Therefore, such financial year and periods need to be defined before the system can be 

used for creating financial entries and reporting of financial data. In addition, it is also necessary to 

create the financial years and periods for all the different divisions as different divisions may have 

different financial years and periods. Apart from these, the system also supports the definition of 

broken-book years (financial years that start other than 1 January) as not all financial years are 

according to calendar years and start on 1 January. 

To create financial years, function right 195 - Maintain years/periods is required. Users with the 

Controller role have this function right. 

 

To create financial years and periods: 

1. Go to Modules → Financial → Setup → General → Financial years / Periods, and then click New. 

You will see the following page. 

 

2. Type or select the division at Division.  

3. By default, the year and date displayed at Year and Date will be set to the year after the last date 

available in the system. Alternatively, you can type a year, or type or select a date for which you 

want to generate the financial year for. 

4. Select the frequency for the new financial year at Frequency and select the Generate: Period 

mapping check box to generate the period mapping for the reporting entity and its subsidiary 

together with the new financial year. 

Note:  

This check box is enabled only when the division selected is a reporting entity. 

5. Click Generate to create the financial year and periods for the division, or Close to exit. 

Note:  

All fields with the "!" icon are mandatory. 
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Once the financial year or period table has been generated, click the year hyperlink in the overview of 

financial years of a division to view the table, as shown in the following page: 
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4.1.3 Creating broken-book years 

You can create broken-book years (financial years that start other than January 1) by following similar 

steps at 4.1.2 Creating financial years and periods. However, you should change the start and end 

dates of the financial year according to the needs of your company. 

 

To create broken-book years: 

1. Go to Modules → Financial → Setup → General → Financial years/Periods, and then click New. 

You will see the following page: 

 

2. Type or select the division at Division.  

3. At Year, type the year for which you want to generate the broken-book. At Date, type the start and 

end dates for the broken-book year that you want to generate. In the example shown, you can type 

the start date as “01-01-2016” and the end date as “31-12-2016”. 

4. Select the frequency for the new financial year at Frequency and select the Generate: Period 

mapping check box to generate the period mapping for the reporting entity and its subsidiary 

together with the new financial year. 

Note:  

This check box is enabled only when the division selected is a reporting entity. 

5. Click Generate to create the financial year and periods for the division, or Close to exit. 

Note:  

All fields with the "!" icon are mandatory. 
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4.1.4 Creating budget scenarios 

Budgets are estimated future costs and revenues used in financial and business performance planning. 

Budgeted figures are later compared with actual figures to monitor the progress of the business 

performance for further actions. In Exact Synergy Enterprise, a budget plan is known as a budget 

scenario. 

Generally, budgeting is done with figures assigned to the general ledger accounts, but it can be further 

refined to include individual cost centers, projects, employees, and even items. Different budget 

scenarios can be created for monitoring the progress of actual performance against the planned 

scenarios. To create budget scenarios, function right 32 - Maintain Budget Scenario is required. Users 

with the General Manager and Controller roles have this function right. 

The following is an example of an organization chart that compares the actual revenue with the 

budgeted revenue based on a budget scenario accessible at Modules → Financial → Reports → 

Analysis → Organization chart: 

 

 



CHAPTER 4 | INITIAL COMPANY CONFIGURATION 

190 

 

To create budget scenarios: 

1. Go to Modules → Financial → Setup → Master data → Budget scenarios, and then click New. You 

will see the following page: 

 

2. At Scenario, type a code for the new budget scenario. 

3. Type the description of the new budget scenario at Description.   

4. Select the Allow: Import check box to allow budget transactions to be imported for the budget 

scenario via XML. 

5. At Year / Period start and Year / Period end, select a start and end year and period for the new 

budget scenario. 

6. Select the status of the new budget scenario at Status. There are three options available, which are 

Active, Block, and Free. Select Active to create budget scenarios which you want to use, Block 

for budget scenarios that you do not want to use, and Free to create free budget scenarios which 

are non-active budget scenarios. 

7. Click Save to save the new budget scenario. 

Note:  

All fields with the "!" icon are mandatory. 
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4.1.5 Activating currencies 

Exact Synergy Enterprise provides a complete list of contemporary currencies. Before these currencies 

(each defined with an ISO currency code) can be used in the system, they must first be activated. 

Generally, currencies that need to be activated are: 

• The default currency used by the company in financial and management reports. 

• The different currencies used by all other divisions across the world. 

• Other currencies that are used in the transactions. 

To activate currencies, function right 33 - Maintain Currencies is required. Users with the General 

manager and Controller roles have this function right. 

 

To activate currencies: 

1. Go to Modules → Financial → Setup → General → Currencies, and click Show to display all the 

available currencies in the system. You will see the following page: 

 

2. Select a currency check box in the first left column and click Activate to activate the currency. You 

can select multiple currencies and activate them at the same time. Once this is done, a green check 

mark will replace the red cross to indicate that the selected currency is now active. 

Tip:  

You can also activate a currency by clicking on the hyperlink of the currency code in the Code 

column. This will open the respective currency details page. On that page, select the Active check 

box to activate the currency, and click Save to save the changes. 
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4.1.6 Creating and maintaining exchange rates 

The default currency is used in financial and management reporting purposes. Since exchange rates 

fluctuate, those of the activated currencies (against the default currency) should be maintained in the 

system periodically. The Financial module is capable of automating currency conversion for 

transactions involving different currencies. Before this conversion process can be done, you should 

create and maintain the period and daily exchange rates of the currencies.  

To create and maintain exchange rates, function right 36 - Maintain Currencies Period Rates and 

function right 51 - Maintain Exchange Rates are required. Users with the General manager and 

Controller roles have these function rights. 

 

To create and maintain exchange rates: 

1. Go to Modules → Financial → Setup → General → Currencies, and then click Show. You will see 

the overview of currencies based on the defined criteria. 

2. Select a currency (active or inactive) for which you want to create or modify the exchange rates by 

clicking the hyperlink in the Code column. You will see the following page: 

 

3. Under the Exchange rates section, select Period to create period exchange rates or Daily to 

create daily exchange rates. Then, click New. You will see the following page if Period has been 

selected: 

 

4. Type the year and period at Year and Period under the General section and the average, closing, 

and budget rates at Average, Closing, and Budget under the Rates section. 

5. Click Save to save the information, or Close to exit. 
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6. If Daily has been selected under the Exchange rates section, you will see the following page: 

 

7. Type or select the date at Date under the Date section, and type the exchange rate at Exchange 

rate under the Rates section. 

8. Click Save to save the information, or Close to exit. 

Tip:  

For active currencies, you can also view and create the exchange rates via Modules → Financial → 

Reports → TAX / Currencies  → Exchange rates. 

9. Under the Hyperinflationary section, click New. You will see the following page: 

 

10. Select the Hyperinflationary check box to set the currency as a hyperinflationary currency, and 

type the effective year at Year and period at Period for the currency to become hyperinflationary. 

By default, all currencies will be non-hyperinflationary. A currency will only become hyperinflationary 

after the user has selected the Hyperinflationary check box. 

11. Click Save. 
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4.1.7 Importing daily exchange rates 

Apart from creating and maintaining exchange rates in Exact Synergy Enterprise, you can also import 

daily exchange rates from an external source in the CSV format. 

To import daily exchange rates, function right 33 - Maintain Currencies is required. Users with the 

General manager and Controller roles have this function right. 

 

To import exchange rates: 

1. Go to Modules → Financial → Setup → General → Currencies, and then click Import: XRate. You 

will see the following page: 

 

2. Under the Data section at Date, type or select the date. By default, the current date is displayed. 

3. At File, click Browse to search and select the import file which is in the CSV format. 

4.  Click Import to import the information, or Close to exit. 

Tip:  

When you create the CSV file for the exchange rates in Microsoft Excel, you should type the 

targeted currency codes in the first column, followed by the currency description in the second 

column, and the exchange rates of the targeted currencies against the default currency in the third 

column. See the following example: 
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4.1.8 Creating corporate and division general ledger accounts 

When creating the chart of accounts, it must reflect the organization and management structure of a 

company. You can create general ledger accounts at a corporate level to reflect the corporate schema. 

In addition, you can also create general ledger accounts used by specific divisions. 

To create the corporate general ledger accounts, function right 10 - Maintain corporate G/L is 

required. Users with the General manager and Controller roles have this function right.  

Meanwhile, to create division general ledger accounts, function right 12 - Maintain division G/L is 

required. Users with the General manager and Controller roles have this function right. 

 

To create corporate general ledger accounts: 

1. Go to Modules → Financial → Setup → Master data → G/L Accounts or go to Modules → Financial 

→ Reports → G/L Accounts → Chart of G/L’s. You will see the following page: 

 

2. By default, Corporate is selected at Report under the Criteria section. Next, click New. You will 

see the following page: 
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3. Type the general ledger number at G/L. 

4. At Type, select the required general ledger account. 

Note:  

It is important to select the correct type of general ledgeraccount as this setting will determine 

whether the financial entries of the general ledger account are registered to the balance sheet or 

profit & loss statement. 

5. At Debit/Credit, select the type of entry for the general ledger account. This determines which side 

the balance of the general ledger account should be presented. 

6. Click Save to save the information, or Close to exit. 

Note:  

All fields with the "!" icon are mandatory. 

Tip:  

The categories available for selection under the Categories section are dependent on the defined 

categories at Modules → Financial → Setup → Master data → Categories. 
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To create division general ledger accounts: 

1. Go to Modules → Financial → Setup → Master data → G/L Accounts or Modules → Financial → 

Reports → G/L Accounts → Chart of Chart of G/L’s.  

2. Select Division at Report under the Criteria section. You will see an additional field next to Report 

if you select Division, as shown in the following page: 

 

3. Next, type or select a division code. Then, click New. You will see the following page: 

 

4. Type the general ledger number at G/L.  

5. Click Save to save the information, or Close to exit. 

Note:  

All fields with the "!" icon are mandatory. 
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4.1.9 Defining general ledger account categories 

General ledger account categories offer different classified views on your financial data for reporting 

purpose. Quick reference of financial data for particular categories is thus, made possible. 

You can have up to 10 general ledger account categories for both corporate and division general ledger 

accounts. You can activate, deactivate, or modify these categories. 

To create and modify general ledger account categories, function right 29 - Maintain account 

categories is required. Users with the General manager and Controller roles have this function right. 

 

To define general ledger account categories: 

1. Go to Modules → Financial → Setup → Master data → Categories. You will see the following page: 
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2. At Report under the Criteria section, select Corporate to define the categories for the corporate 

general ledger accounts or Division to define the categories for the division general ledger 

accounts. If Division is selected, type or select the division code. 

3. Next, select the category code that you want to activate or modify in the Code column. You will see 

the following page: 

 

Note:  

You will see the Division field only if you have selected Division at Report under the Criteria 

section on the G/L Accounts: Categories page. If Corporate has been selected at Report, you 

will only see the Description field and Active check box. 

4. Type a description for the general ledger account category at Description and select the Active 

check box to activate it. 

5. Click Add to add subcategories to the category. 

6. Click Save to save the information, or Close to exit. 
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4.1.10 Copying general ledger account schemas 

It is possible to copy the general ledger account schema of one division or corporate level to another 

division. This allows you to quickly set up the chart of accounts for a new division. 

To copy the chart of accounts, function right 12 - Maintain division G/L is required. Users with the 

General manager and Controller roles have this function right. 

 

To copy general ledger account schemas: 

1. Go to Modules → Financial → Setup → Master data → G/L Accounts or Modules → Financial → 

Reports → G/L Accounts → Chart of G/L’s, and then click Copy. You will see the following page: 

 

2. Under the Source section at Action, select the action for which you want to perform the copying. 

There are four options available, which include: 

• Corporate > Division — Select this option to copy the general ledger account schema from the 

corporate level to a division level. 

• Division > Corporate — Select this option to copy the general ledger account schema from a 

division level to the corporate level. 

• Division > Division — Select this option to copy the general ledger account schema from a 

division level to another division level. 

•  Division: Links > Division — Select this option to copy the general ledger corporate account 

links of a division level to another division level. 

3. At Division, type or select the source division from which the general ledger schema will be copied. 

This will depend on the action you have selected. If you have selected Corporate > Division at 

Action, the Division field will show Corporate and you cannot select a division here as the source 

of general ledger account schema will be taken from the corporate level general ledger account 

schema. 

4. Under the Target section, type or select the division at Division to copy the source general ledger 

account schema to the selected division. This will depend on the action you have selected. If you 

have selected Division > Corporate at Action, the Division field will show Corporate and you 

cannot select a division here as the target of the general ledger account schema to be copied to is 

the corporate level. 

5. Click Save to perform the copying, or Close to exit. 

Note:  

All fields with the "!" icon are mandatory. 
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4.1.11 Setting up organization structure 

It is important that the organization structure is properly set up in the system to allow smooth running of 

your business operations at any time. The number of divisions that you can create to form the 

organization structure, is based on your Exact Synergy Enterprise license. These divisions can be 

categorized into different group layouts, for example, according to geographical, functional, and product 

layouts. 

Based on your organization structure, appropriate function rights structure should also be created. For 

example, functional roles and rights can be assigned according to the corporate, division group, 

division, cost center group, cost center, and reseller levels so that a person with the adequate level of 

function rights can perform specific functions in the system. 

In general, Exact Synergy Enterprise supports a three-level organization structure. These levels are: 

• Corporate level — By default, this highest level is provided by the system. 

• Division group level — Division groups can be created and displayed according to the group layouts 

which have been defined in the system. 

• Division level — Divisions or subsidiaries across the organization structure. 
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4.1.12 Creating divisions 

A division represents a legal entity of the organization and operates using a different name from the 

organization. After groups have been defined, divisions can be created to further define the organization 

structure. 

To create divisions, function right 366 - Maintain division is required. To modify divisions, function right 

90 - Maintain division is required. Users with the General manager, HR, and HR assistant roles have 

these function rights. 

 

To create divisions: 

1. Go to Modules → HRM → Setup → Organization → Divisions, and then click New. 

 

2. Under the General section at Code, type a number of up to three digits to specify the code for the 

division. This cannot be changed after you have saved the division. 

3. At Name, type the name of the division.  

4. Type or select a country code at Country to define the country of the division.  

5. At Start date, type or select a date to define the start date of the division.  

6. At Security level, type a number of up to four digits to define the security level for the division. 

Note:  

Users with lower security levels will not be able to select divisions with higher security levels in 

fields associated with divisions. 
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7. Under the Financial reporting section at Reporting entity, select the check box to define the 

division as a reporting entity. 

Note:  

By default, this check box is not selected. However, the main holding division defined at Modules → 

Financial → Setup → General → Settings must be a reporting entity. Thus, this check box will be 

selected and disabled. 

8. At Presentation currency, type or select the currency code to be used in the financial reporting. 

Note:  

This field is available only if the Reporting entity check box is selected. 

 

9. Under the Address section at Account, type or select the account code of the division. 

Note:  

Other information under this section will be automatically filled in. These details are the information 

filled in when you create the account for the division. 

 

10. Under the Schedule section, select the Update: FTE check box to allow the system to 

automatically update the Full Time Equivalents (FTEs) of all employees when their work schedules 

are modified. 

Note:  

This function is applicable only if the Activate: Advanced Work Schedules check box at Modules 

→ HRM → Setup → General → Settings is not selected. 

11. Select the Generate: MRS check box to enable the Master Resource Schedule (MRS) to be 

automatically generated when an entry for an employee is created. 
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12. After filling in other relevant details, click Save to save the new division. 

Note:  

All fields with the "!" icon are mandatory. 

Tip:  

You can also create divisions at Modules → Financial → Setup → Organization → Divisions. 
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4.1.13 Defining cost center group layouts and subgroups 

To enhance the view of a cost center layout, it is possible to set up cost center groups. The cost center 

layout can be viewed by clicking Cost centers under the Monitor section when viewing the division 

card. 

 

You can define up to four groups. Cost center groups are used to classify cost centers based on 

criteria, such as the functional area. Cost center groups can then be subdivided into one or more cost 

center subgroups. For example, the cost center group “Functional area” may consist of the cost center 

subgroups “Sales”, “Support”, and “Training and Consultancy”. 

To maintain cost center groups and subgroups, function right 48 - Maintain Cost center Layouts is 

required. Users with the General manager and Controller roles have this function right. 

 

To define cost center group layouts: 

1. Go to Modules → HRM → Setup → Organization → Groups: Cost centers. You will see the 

following page: 
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2. Click the description of the cost center group in the Description column. You will see the following 

page: 

 

3. Under the Criteria section at Description, type the name of the cost center group. 

4. Click Save to save the changes made. 

Tip:  

You can also define the cost center groups at Modules → Financial → Setup → Organization → 

Cost center groups. 
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To define cost center subgroups: 

1. Go to Modules → HRM → Setup → Organization → Groups: Cost centers, and then click the 

required hyperlink in the Description column. 

 

Note:  

You can change the description of the subgroup by clicking the name of the subgroup in the 

Description column. 

2. Click New to add new subgroups to the cost center group. You will see the following page: 

 

3. Under the General section at Subgroup, type the code of the cost center subgroup. 

4. At Description, type the description of the cost center subgroup. This is mandatory. 

5. Click Save to save the new cost center subgroup. 

Note:  

All fields with the "!" icon are mandatory. 

Tip:  

You can also define the cost center subgroups by going to Modules → Financial → Setup → 

Organization → Cost center groups, and then clicking the description of the cost center group. 
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4.1.14 Creating cost centers 

Cost centers give an extra organizational dimension to the division structure, not only from an 

organizational point of view but also from a financial one. After a division has been created, cost centers 

can be linked to a division. Cost centers often represent the different departments in a division, for 

example, Sales, Support, and Consultancy. 

To create cost centers, function right 92 - Maintain cost centers is required. Users with the General 

manager and HR roles have this function right. 

 

To create cost centers: 

1. Go to Modules → HRM → Setup → Organization → Cost centers, and then click New. You will see 

the following page: 

 

2. Under the General section at Division, type or select the division code to specify the division that 

the cost center belongs to.  

3. At Code, type a code of up to eight characters for the cost center. This cannot be changed after you 

have saved the cost center. 

4. At Description, type the description of the cost center.  

5. Under the Groups section, select the cost center subgroup for each cost center group layout you 

have defined earlier to group the cost center under the group layouts and their respective 

subgroups. 

6. After filling in other relevant details, click Save to save the new cost center. 

Note:  

All fields with the "!" icon are mandatory. 

Tip:  

You can also create cost centers by going to Modules → Financial → Setup → Organization → Cost 

centers, and then clicking New. 
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4.2 FINANCIAL SETTINGS 

Financial settings are important as they are used in the financial-related functions in Exact Synergy 

Enterprise. The following page shows the information of the financial settings already defined when you 

set up a company in Exact Synergy Enterprise. You can view the information by going to the Financial 

section at Modules → System → Setup → Database → Set up company. 

 

 

Periods 

The number displayed in the Value column indicates the number of periods which have been created in 

the system. Financial periods must first be created before financial entries can be imported or created in 

the system. Click the number hyperlink and you will see the Financial years page where you can 

display an overview of the financial years and periods, and create financial years and periods. For more 

information, see 4.1.2 Creating financial years and periods. 

 

Currencies: Active 

The number displayed in the Value column indicates the number of active currencies in the system. 

You need to activate the currencies before you can use the currencies. Click the number hyperlink and 

you will see the Currencies page where you can display an overview of the currencies and activate the 

currencies which you want to use in the system. For more information, see 4.1.5 Activating currencies. 

 

Exchange rates: Period 

The number displayed in the Value column indicates the number of periodical exchange rate updates 

created in the system. Click the number hyperlink and you will see the Currencies page where you can 

maintain the currencies as well as create and maintain the exchange rates. For more information, see 

4.1.6 Creating and maintaining exchange rates. 
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Exchange rates: Daily 

The number displayed in the Value column indicates the number of daily exchange rate updates 

created in the system. Click the number hyperlink and you will see the Currencies page where you can 

maintain the currencies as well as create and maintain the exchange rates. For more information, see 

4.1.6 Creating and maintaining exchange rates. 

 

Categories: G/L Accounts 

Click the Check hyperlink in the Value column and you will see the G/L Accounts: Categories page 

where you can define the general ledger account categories. For more information, see 4.1.9 Defining 

general ledger account categories. 

 

Chart of Accounts: Corporate 

The number displayed in the Value column indicates the number of corporate general ledger accounts 

which have been created in the system. Click the number hyperlink and you will see the Financial: 

Chart of accounts page where you can create general ledger accounts. For more information, see 

4.1.8 Creating corporate and division general ledger accounts. 

 

Scenarios 

The number displayed in the Value column indicates the number of budget scenarios currently 

available in the system. Click the number hyperlink and you will see the Budget scenarios page where 

you can create budget scenarios. For more information, see 4.1.4 Creating budget scenarios. 

 

Scenario: Default 

Click the Check hyperlink in the Value column and you will see the Financial: Settings page where 

you can define important financial settings. For more information, see 4.1.1 Defining general financial 

settings. 
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4.2.1 Creating chart of accounts 

In Exact Synergy Enterprise, you can create more than one general ledger account schema or chart of 

accounts. You can create a corporate level chart of accounts and another chart of accounts to be used 

by a specific division. For more information, see 4.1.8 Creating corporate and division general ledger 

accounts, 4.1.9 Defining general ledger account categories, and 4.1.10 Copying general ledger account 

schemas. 
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4.3 HRM SETTINGS 

The HRM module is used to store and share information regarding the people throughout the company. 

To take full advantage of the features the module has to offer, it is important to define the HRM settings. 

The following page shows information of the HRM settings already defined when you set up a company 

in Exact Synergy Enterprise. You can view the information by going to the HRM section at Modules → 

System → Setup → Database → Set up company. 

 

 

Settings 

Click the Check hyperlink in the Value column and you will see the HRM: Settings page where you 

can define important HRM settings. For more information, see 4.3.1 Defining HRM settings. 

 

Schedule: Default 

The number displayed in the Value column indicates the default work schedule created in the system. 

Click the number hyperlink and you will see the HRM: Work schedule page where you can create and 

maintain the work schedule. For more information, see 4.3.2 Creating default work schedule. 

 

Schedule: Division 

The number displayed in the Value column indicates the number of divisions with work schedules 

created for them. Click the number hyperlink and you will see the HRM: Work schedule page where 

you can create and maintain the work schedules. For more information, see 4.3.3 Creating work 

schedules for divisions. 

 

Job titles 

The number displayed in the Value column indicates the number of job titles in the system. Click the 

number hyperlink and you will see the HRM: Job titles page where you can create job titles. For more 

information, see 4.3.4 Setting up job system. 

 

People 

The number displayed in the Value column indicates the number of employees in the system. Click the 

number hyperlink and you will see the HRM: Search - People page where you can search for people. 

For more information on creating entries for employees, see 4.3.5 Creating entries for employees. 
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4.3.1 Defining HRM settings 

Besides the important HRM settings, such as the work schedules, job titles, employees, and other 

settings that are used to manage and share information of the people, you also need to define 

additional settings related to the network domain controller, e-mail server, application process, and 

other technical settings related to the HRM module. To define the HRM settings, go to Modules → HRM 

→ Setup → General → Settings, and then click Edit. 

To maintain the HRM settings, function right 88 - Maintain HRM Settings is required. Users with the 

HR role have this function right. 

 

Server section 

 

The Exact.Jobs.SysMaint background job creates the Windows user account and Microsoft Exchange 

Mailbox for each new employee or partner. Due to this, some settings in this section is for the 

background job. 

 

Domain: New – People (Pre-Win2000) 

You can configure the automatic creation of Windows user accounts for new employees in three ways: 

• Leave the field blank to perform account management manually. This means that the background 

job is not triggered to perform functions, such as creating and deleting accounts, activating or 

deactivating employees, creating or deleting mailboxes, and closing HR periods. 

• Type the application server name to create the accounts in the application server. This is not 

recommended in a multi-server setup. 

• Type a Microsoft Windows domain name to have the accounts created under this domain. This can 

be the same as the domain for partners and customers. 

 

use Active Directory  

Select this check box to use Active Directory. The employee accounts will be created as Active 

Directory accounts in the organization unit and subdirectory defined at Organization: Unit and 

Subdirectory. This will allow you to segregate the types of accounts in the same domain using the 

Active Directory containers. 
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create Exchange Mailbox  

Select this check box to have Microsoft Exchange Mailbox created for new employees. In this case, the 

use Active Directory check box will be automatically selected. Microsoft Exchange should be 

operational before the Exact.Jobs. SysMaint background job runs. 

 

Oganization: Unit (People) 

Type the Active Directory organizational unit where you want the employee accounts to be created. If 

the field is left blank, the accounts will be created in the Users container by default. If the organizational 

unit container does not exist yet, it will be created by the Exact.Jobs.SysMaint background job. This 

field is available if the use Active Directory check box has been selected for people. 

Note:  

Active Directory can contain several containers. However, an organizational unit container can be 

created to store the Exact Synergy Enterprise accounts instead of the default Users container. This 

allows for differentiation between the locations of the Microsoft Windows user accounts created. 

You can have different containers for people, partners, and customers. The same also applies for 

the Active Directory subdirectory. 

 

Subdirectory 

Type the sub-container of the Active Directory organizational unit specified at Organization: Unit 

(People) where you want the employee accounts to be created. If the subdirectory container does not 

exist yet, it will be created by the Exact.Jobs.SysMaint background job. This field is available if the 

use Active Directory check box has been selected for employees. 

 

People: Outlook Web Access 

Type the Uniform Resource Locator (URL) of the Microsoft Exchange server if Microsoft Exchange is 

used with Exact Synergy Enterprise. This is available if the create Exchange Mailbox check box has 

been selected. 

 

Exchange server version 

Select the relevant Microsoft Exchange version to be supported by the system. This is only available 

when the create Exchange mailbox check box is selected. By default, a blank option will be displayed. 

If you do not select an option when saving the settings, a message “Mandatory: Exchange server 

version” will be displayed. 

 

Exchange: Domain 

Type the Microsoft Exchange domain. This field is available if the create Exchange Mailbox check box 

has been selected. 
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Domain: New – Partner (Pre-Win2000) 

You can configure the automatic creation of Windows user accounts for new partners in three ways: 

• Leave the field blank to perform account management manually. This means that the background 

job is not triggered to perform functions, such as creating, deleting, activating, and deactivating 

accounts. 

• Type the application server name to create the accounts in the application server. This is not 

recommended in a multi-server setup. 

• Type a Microsoft Windows domain name to have the accounts created under this domain. This can 

be the same as the domain for employees and customers. 

 

use Active Directory  

Select this check box to use Active Directory. The partner accounts will be created as Active 

Directory accounts in the organization unit and subdirectory defined at Organization: Unit and 

Subdirectory. This will allow you to segregate the types of accounts in the same domain using the 

Active Directory containers. 

 

Organization: Unit (Partners) 

Type the Active Directory organizational unit where you want the partner accounts to be created. If the 

field is left blank, the accounts will be created in the Users container by default. If the organizational 

unit container does not exist yet, it will be created by the Exact.Jobs.SysMaint background job. This 

field is available if the use Active Directory check box has been selected for partners. 

 

Subdirectory 

Type the sub-container of the Active Directory organizational unit specified at Organization: Unit 

(Partners) where you want the partners accounts to be created. If the subdirectory container does not 

exist yet, it will be created by the Exact.Jobs.SysMaint background job. This field is available if the 

use Active Directory check box has been selected for partners. 

 

Change password at next logon (People) 

Select this check box if you want to force the employees to change their password at next logon. 

 

Domain: New – Customer (Pre-Win2000) 

You can configure the automatic creation of Windows user accounts for new customers in three ways: 

• Leave the field blank if you want to perform account management manually. This means that the 

background job is not triggered to perform functions, such as creating, deleting, activating, and 

deactivating accounts. 

• Type the application server name to create the accounts in the application server. This is not 

recommended in a multi-server setup. 

• Type a Microsoft Windows domain name to have the accounts created under this domain. This can 

be the same as the domain for employees and partners. 
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use Active Directory 

Select this check box to use Active Directory. The customer accounts will be created as Active 

Directory accounts in the organization unit and subdirectory defined at Organization: Unit and 

Subdirectory. This will allow you to segregate the types of accounts in the same domain using Active 

Directory containers. 

 

Organization: Unit (Customers) 

Type the Active Directory organizational unit where you want the customer accounts to be created. If 

the field is left blank, the accounts will be created in the Users container by default. If the organizational 

unit container does not exist yet, it will be created by the Exact.Jobs.SysMaint background job. This 

field is available if the use Active Directory check box has been selected for customers. 

 

Subdirectory 

Type the sub-container of the Active Directory organizational unit specified at Organization: Unit 

(Customers) where you want the customer accounts to be created. If the subdirectory container does 

not exist yet, it will be created by the Exact.Jobs.SysMaint background job. This field is available if the 

use Active Directory check box has been selected for customers. 

Request: Portal access 

Select the request type that will be used to inform the account manager of the username and password 

sent to the customer. This allows the account manager to provide the username and password to the 

customer upon request. 

 

E-mail 

Select the e-mail transport method: 

• Microsoft Outlook — E-mails will be sent using Microsoft Outlook where e-mail attachments are 

sent separately. This is because Microsoft Outlook does not automatically combine e-mail text and 

attachments together in the e-mail body. 

• SMTP — E-mails will be sent by SMTP using the server and port specified at Server and Port 

where e-mail text and attachments can be combined in the e-mail body. E-mail clients that do not 

support e-mail in HTML format can still display the e-mail as the content is sent in both plain text and 

HTML format. 

 

Server 

Type the DNS name or IP address of the SMTP server. This field is available if SMTP has been 

selected at E-Mail. 

 

Port 

Type the SMTP port number to use. This field is available if SMTP has been selected at E-Mail. 
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Program: ID (Background - Process) 

Type the name of the custom DLL entry points. The background job will notify the DLLs listed here and 

execute the custom functions. 

Tip:  

You can write DLLs that conform to the Exact.Jobs.SysMaint specification to perform functions 

that are not handled by Exact.Jobs.SysMaint. For example, Exact Synergy Enterprise background 

jobs cannot create Lotus Notes accounts automatically. However, you can write a DLL that will 

perform this function and specify the DLL at Program: ID (Background - Process). 

 

OCS presence 

Select this check box to activate the integration with the Office Communications Server (OCS) 

functionalities. The OCS functionalities allow you to instantly track the availability of people for sharing 

of real-time information and communication purposes. 

 

Privacy section 

 

 

Levels of indirect managers permitted to view person specific documents and requests 

Select the levels of indirect managers allowed to view and/or search for documents, requests, and 

personal card information which have been set to security level 100. 

 

Expense claims section 

 

 

Request type 

Select the request type to use for expense claims. By default, Expense claim is selected. 
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Absence section 

 

 

Hours per day: Default 

Type the number of default work hours per day. This setting is used if the work hours for a division are 

not defined. 

 

Request type: Work time reduction 

Type or select a default request type for the work time reduction request. 

 

Split – Absence Balance 

Select this check box if you want to segregate the absence balance overview by the absence types. 

 

Calculation – Entitlements: Automatically 

Select the option to calculate the absence entitlements automatically. There are three options available, 

which are: 

• None — Select this option if you do not want to calculate the absence entitlements automatically. 

Instead, the calculation of the absence entitlements will be generated by closing the period. 

• Divisions (All) — Select this option to automatically calculate the absence entitlements for all 

divisions. 

• Divisions (Settings) — Select this option to automatically calculate the absence entitlements based 

on the settings per division. 

Next, select a specific day in the following month on which the automatic calculation of absence 

entitlements is to take place. 

 

Request type: Vacation 

Type or select a default request type for the vacation request. 

 

Request type: Sick 

Type or select a default request type for the sick request. 

 

Request type: Return to work 

Type or select a default request type for the return to work request. A return to work request can only be 

created via a parent request (by default, this is the sick report request). A return to work request is used 

to register partial absence when an employee returns to work partially during sickness. 
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Absence: Expiry date 

Type or select a default absence expiry date of the absence balance. With the expiry date, users are 

able to view their absence balance status, which are brought forward from the previous year, and their 

unused absence balance with reference to the effective expiry date. 

 

Person: Planning section 

 

 

Working day 

Type or select the item code for the working day. 

 

Public holiday 

Type or select the item code for the public holiday. 

 

Activate: Advanced Work Schedules 

Select the check box to activate the advanced work schedule features. By default, this check box is not 

selected to allow users to use the existing work schedule application. 

Note:  

When this check box is selected and the setting is saved, a warning message is displayed to inform 

users of the implications of using the advanced features. Once the advanced features are enabled, 

this check box will be disabled and you are not allowed to clear the check box to deactivate the 

advanced features. 

 

Job title: Security level section 

 

 

Required – Function rights (88): Security level: > 

Type the maximum security level that a person with the HR role at group and division levels can set for 

other people. If you leave the field blank or type “0”, anyone with the HR role at group and division 

levels can set the security level for all. The role(s) that are linked to function right 88 - Maintain HRM 

Settings are displayed next to the box. 
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Competency section 

 

 

Method 

Select Simple to enable the Competencies Comparison Chart function or Advanced to enable the 

enhanced function in Competency management. 

 

Final: Rating 

Select the final rating for the competency calculation. The final rating calculated will be updated at 

Competence profiles in the personal card. 

Note:  

This field is available only if you have selected Advanced at Method. 

 

Request type 

Type or select the request type of the notifications that will be sent to the managers and/or reviewers for 

reviewing purposes. 

Note:  

This field is available only if you have selected Advanced at Method. 

 

Calculation: Method 

Select Average, Summation, or Percentage to define the method of calculation for the final rating of 

the applicant’s or employee's competency profile. The calculation methods are defined as below: 

• Average — Sum of (each rated value x Factor) / Quantity of (competence involved x Factor) 

• Summation — Sum of (each rated value x Factor) 

• Percentage — Sum of [(each rated value x Factor) / Sum of (each highest field value x Factor)] x 

100% 

Note:  

This field is available only if you have selected Advanced at Method. 
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Request: End date 

Select the time span that is allowed for the manager and/or reviewers to realize or process the review 

request. You can select one of the following: 

• Number of weeks: 1 

• Number of weeks: 2 

• Number of weeks: 3 

• Number of months: 1 

• Number of months: 3 

Note:  

This field is available only if you have selected Advanced at Method. 

 

Reviewer 

Select Manager to allow the manager of the person being reviewed to review the competency of the 

person, or select Manager & Person to allow the manager of the person and the person being 

reviewed to review the competency of the person. 

Note:  

This field is available only if you have selected Advanced at Method. 

 

Customer: Vacancy 

Select this check box to enable the Vacancy button in the customer cards and the Customer field in 

the vacancy cards and reports. 

Note:  

This field is available only if you have selected Advanced at Method.  

 

Person: View profiles 

Select this check box to allow the person to view the active competency profile by clicking the hyperlink 

at Competence profiles under the General section in the personal card. If you do not select this check 

box, the person will not be able to view the active competency profile. However, if the person is an 

administrator, has the HR role, or is the reviewer for himself, the competency profiles can be viewed 

even if the Person: View profiles check box is not selected. 

Note:  

This field is available only if you have selected Advanced at Method. 
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Performance review section 

Note:  

A division that has its own performance review settings defined will not follow the settings defined in 

this section. 

 

 

Request type 

Type or select the request type ID of the notifications that will be sent to the managers and/or person for 

reviewing purposes. 

 

Final: Rating 

Select the final rating for the performance review calculation. The field types available for selection are 

field types with user-defined values. The final rating calculated will be updated at Performance review: 

Last update in the personal card. 

 

Request: End date 

Select the time span that is allowed for the manager and/or person to realize or process the 

performance review request. You can select one option from the following: 

• Number of weeks: 1  

• Number of weeks: 2  

• Number of weeks: 3  

• Number of months: 1  

• Number of months: 3 

 

Calculation: Method 

Select Average, Summation, or Percentage to define the method of calculation for the final rating of 

the person's performance review. 

Note:  

Refer to Calculation: Method under the Competency section for more information on the 

calculation methods. 

 

Reviewer 

Select Manager to specify that it is mandatory for the manager of the person to review the performance 

of the person, or select Manager & Person to specify that it is mandatory for both the manager and the 

person to perform the review. 
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Person: View profiles 

Select this check box to allow the person to view the performance review profiles belonging to the 

person. The performance review profiles are accessible via the hyperlink at Performance review 

profiles in the personal card. 

 

Performance indicators: method 

Select the Simple or Advanced option. By default, Simple is selected. For more information on the 

differences between the two methods, see Advanced performance review method introduced (Doc ID: 

26.210.647) in Exact Synergy Enterprise. 

 

Target agreement section 

 

Note:  

A division that has its own target agreement settings defined will not follow the settings defined in 

this section. 

 

Request type 

Type or select the request type ID of the notifications that will be sent to the managers and/or person for 

reviewing purpose. 

 

Request end date 

Select the time span that is allowed for the manager and/or person to realize or process the target 

agreement review request. You can select one option from the following: 

• Number of weeks: 1  

• Number of weeks: 2  

• Number of weeks: 3  

• Number of months: 1  

• Number of months: 3  

• Number of months: 6  

• Number of years: 1  

• Number of years: 2  

• Number of years: 3 

 

Number of targets: Minimum / Maximum 

Type the minimum and/or maximum number of targets allowed for each target agreement at the 

respective boxes. If the field is blank, users will be allowed to create any number of targets for each 

target agreement. 
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Training section 

 

 

Request type: Training 

Select the request type(s) used for training purposes. These are the request types that are available for 

people to select from when he or she wants to participate in the training courses. These training 

requests are grouped in a report, which can be viewed from the personal card of the particular person. 

Tip:  

To access this report, open a personal card, click Reports, and then click Training under the 

Reports section. 

 

Budget section 

 

 

Types: Person 

Select the types of people to be included in the budget scenario reports. There are four options 

available, namely Contractor, Employee, Student, and/or Temporary. 

 

Vacancy section 

 

 

Request type 

Type or select the default request type for the vacancy request. The request will be automatically 

created and sent to the person defined in the Workflow module when a vacancy entry has been saved. 

 

Attachment: Document type 

Type or select the document ID to specify the document type of the documents that will be attached to 

the vacancy card. This is mandatory. You must fill in this field before attaching any document in the 

vacancy card. 
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Applicant section 

 

 

Request type 

Type or select the default request type for the applicant request. The request will be automatically 

created and sent to the person defined in the Workflow module when a vacancy entry has been saved. 

 

Import: Document type 

Select a document type to save an imported file containing the data of the applicants using this 

document type directly to Exact Synergy Enterprise. 

Note:  

This setting will only be applied if the Save attachment check box at Modules → HRM → Entry → 

HRM → Import: Applicants has been selected. 
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Confirmation template 

Type or select a document to be used as the response message that will be displayed to the applicant 

when he or she has saved an applicant entry into the system via a public web site. By default, if the 

Confirmation template field is left blank, the system will display the response message defined at 

Confirmation once the entry has been saved. 

Note:  

Only response documents with security level “0” defined at the Confirmation template field can be 

viewed by the users. Otherwise, a blank page will be displayed. Users with the Administrator or 

Web administrator role are able to create the response document before it can be defined at 

Confirmation template. It is recommended that you create a document specifically for the 

response message only. To create a document, go to Modules →  Documents → Entry → Entry → 

Document: New. For more information on creating document types, see 4.6 Document Settings. 

Tip:  

To create applicant entries in Exact Synergy Enterprise via a public web site, you can either copy and 

paste or create a hyperlink to link to 

http://localhost/PublicWeb/docs/HRMApplicant.aspx?BCAction=0& at Document under the Frame – 

Content section on the Documents: Web site page where you set up the public web site. For more 

information, see Setting up public web sites (Doc ID: 17.667.379) and Creating and modifying web 

sites (Doc ID: 15.435.133) on your Exact Synergy Enterprise. 

 

Confirmation 

Type the message to be displayed to the applicant or employee when he or she has saved an applicant 

entry into the system. 

 

Application phase 

Type the application phases that can be specified when creating and maintaining applicants in the 

system. For example, you can define several phases, such as Phase 1: Already sat for EQ and IQ test, 

Phase 2: Attended interview with Hiring Manager, Phase 3: Attended interview with HR Manager, and 

Phase 4: Video conferring with management in the Netherlands. 

 

Export: Excel section 

 

 

Process type 

Click the hyperlink at Process type to view or modify the settings for the HRM Excel export process 

type. This process type allows the employee data to be exported in the Microsoft Excel format. 

 

https://employees.exact.com/docs/DocView.aspx?DocumentID=%7b10589983-305b-4024-b27b-db27f60e3293%7d
https://employees.exact.com/docs/DocView.aspx?DocumentID=%7b5250b5ce-8fd0-4575-9b4d-5c534ba45167%7d&NoSubject=1&NoHeader=1
https://employees.exact.com/docs/DocView.aspx?DocumentID=%7b5250b5ce-8fd0-4575-9b4d-5c534ba45167%7d&NoSubject=1&NoHeader=1
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Hyperlink: Services section 

 

 

Map - Link 

Select MapQuest: Address if you want to display the map of an address on the street level or select 

MapQuest: City if you want to display the map of the address on the city level. 

 

Request types allowed for Synergy user section 

 

 

Request type: 1 - 2 

The two request types available for usage for Synergy users are displayed in this section. 

These request types cannot be changed. 

 

Request types allowed for Employee self-service role user section 
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Request type: 1-15 

Type or select the request type at Request type: 1-15 to define the request types that a user with the 

Employee self-service role can create. Users with the Employee self-service role are not able to 

create or participate in request types that are not specified in this section. Employee self-service is a 

functionality that provides people with the defined role to have access to view and request certain HR 

related information quickly and completely. A user with the Employee self-service role has an active 

status but is blocked from accessing Exact Synergy Enterprise. When the user logs in to Exact 

Synergy Enterprise, the user will be redirected to a simplified interface. 

 

Request types allowed for CRM role user section 

 

 

Request type: 1-15 

Type or select the request type ID to define the request types that a person with the CRM role can 

create. You can define up to 15 request types. Users with the CRM role are not able to create or 

participate in request types that are not specified in this section. 

 

Visible projects for users with the CRM role section 

 

 

Show 

Select the types of projects to be visible for users with the CRM role. 
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4.3.2 Creating default work schedule 

In the HRM module, absences are calculated based on the work schedule of the employee. Schedules 

can either be created for individual employee or for the entire organization. The schedule for the entire 

organization or the default schedule applies to every person who does not have a personal schedule or 

whose division is without a work schedule. 

To maintain the default work schedule, function right 100 - Maintain default work schedule is 

required. Users with the HR role have this function right. 

 

To create default work schedule: 

1. Go to Modules → HRM → Setup → Schedules → Default work schedule, click the Default work 

schedule (Corporate) link, and then click Edit. You will see the following page: 

 

2. At Number of days, type the total number of days to be in the work schedule. Depending on the 

number, you will see the number of days displayed in the Day column in the work schedule. 

Note:  

This field is available only if the Activate: Advanced Work Schedules check box has been 

selected under the Person: Planning section on the HRM: Settings page. 

3. Under the Work schedule section in the Day type column, select Normal, Off day, or Rest day to 

define the day type for each day. Normal refers to a work day and Off day refers to a non-work 

day, which can be on any day of the week. Meanwhile, Rest day refers to a fixed and designated 

non-work day by the country or company where the employee does not work. 

4. Type the range of work hours before and after a break in the Hours columns. 

5. Click Calculate to calculate the total work hours after you have defined all the work hours for each 

day in the work schedule. The number of total hours will be displayed at the Total row. 

6. Click Save to save the default work schedule. 
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4.3.3 Creating work schedules for divisions 

Besides having a corporate level default work schedule, specific schedules can be set for different 

divisions. The division work schedule applies to all within that division who are without personal work 

schedules defined. 

To create and maintain work schedules of divisions, function right 101 - Maintain company work 

schedule is required. Users with the HR role have this function right. 

 

To create work schedules for divisions: 

1. Go to Modules → HRM → Setup → Schedules → Default work schedule, and then click New. You 

will see the following page: 

 

2. At Division, type or select the division to specify the division the work schedule belongs to. 

3. Type the total number of days for the work schedule at Number of days. The maximum number 

that is acceptable is 99. 

Note:  

This field is available only if you have selected the Activate: Advanced Work Schedules check 

box under the Person: Planning section on the HRM: Settings page. 

4. Under the Work schedule section in the Day type column, select Normal, Off day, or Rest day to 

define the day type for each day. 

5. Normal refers to work days, while Off day and Rest day refer to non-work days. Type the range of 

work hours before and after a break in the Hours columns. 

6. Click Calculate to calculate the total work hours after you have defined all the work hours for each 

day in the work schedule. The number of total hours will be displayed at the Total row. 

7. Under the Absence section, type the total number of work hours per day at Hours per day. 
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8. Select Calculation – Entitlements: Automatically check box if you want the calculation of the 

entitlements for the division to be generated automatically every period. Otherwise, clear this check 

box. 

Note: 

• This check box is available only if you have selected Divisions (Settings) at the Calculation - 

Entitlements: Automatically field under the Absence section on the HRM: Settings page. 

• All fields with the “!” icon are mandatory. 

9. Click Save to save the default work schedule for the division. 
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4.3.4 Setting up job system 

The setup of the job system focuses on the professions within an organization. The job system is used 

to define the functional area that the employees are working in, for example, management, sales, or 

consultancy staff. The job system is also used to indicate the level on which the employees are 

performing their tasks and responsibilities. 

One of the main purposes of defining a job system is to have the ability to measure the performances of 

the employees working in an organization. A well-defined job system will indirectly result in an 

organization-wide quality improvement. 

The job system within Exact Synergy Enterprise is concentrated on people and consists of the following 

elements: job groups, job activities, job titles, and job levels. 

This subchapter explains the procedures to create job groups, job activities, and job titles. 

 

Creating job groups 

The first level of the job system is a job group. It provides a general description of the job profession 

and defines the functional area of an organization that the person is working in. Examples include 

“Sales and Marketing” and “Research and Development”. 

By default, some job groups are created once you have installed Exact Synergy Enterprise. You can 

access them at Modules → HRM → Setup → General → Job groups. You can also create more job 

groups if required. 

To create and maintain job groups, function right 94 - Maintain job groups is required. Users with the 

HR role have this function right. 

 

To create job groups: 

1. Go to Modules → HRM → Setup → General → Job groups, and then click New. You will see the 

following page: 

 

2. Under the General section at Code, type a code of up to 10 characters for the job group. This 

cannot be changed after you have saved the job group. 

3. At Description, type the description of the job group. 



CHAPTER 4 | INITIAL COMPANY CONFIGURATION 

233 

 

4. After filling in other relevant details, click Save to save the new job group, or click Close to exit. 

Note:  

All fields with the “!” icon are mandatory. 

 

Creating job activities 

A job activity is at the second level of the job system. It contains further information of a job group. 

Thus, it is advisable to link a job activity to a job group. For example, the job group “Research and 

Development” can consist of job activities, such as “Software Development” and “Quality Assurance”. 

By default, some job activities are created once you have installed Exact Synergy Enterprise. You can 

access them at Modules → HRM → Setup → General → Job activities. You can also create more job 

activities if required. 

To create and maintain job activities, function right 94 - Maintain job groups is required. Users with the 

HR role have this function right. 

 

To create job activities: 

1. Go to Modules → HRM → Setup → General → Job activities, and then click New. You will see the 

following page: 

 

2. Under the General section at Code, type a code of up to 10 characters for the job activity. This 

cannot be changed after you have saved the job activity. 

3. At Description, type the description of the job activity.  
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4. Type or select the job group code to link the job activity to the selected job group at Job group. 

5. Under the Used in: Job titles section, select the check boxes next to the respective competency to 

specify the competencies that are important to perform the job activity. 

Note:  

Knowing the importance of the competencies for each job activity allows reviewers to assign the 

appropriate final ratings for people belonging to this job activity based on their performances. This 

section is available only if the competency method is defined as Simple at Modules → HRM → 

Setup → General → Settings, under the Competency section. 

6. After filling in other relevant details, click Save to save the new job activity, or click Close to exit. 

Note:  

All fields with the “!” icon are mandatory. 

 

Creating job titles 

A job title is at the third level of the job system. It contains further information about a job activity and 

describes the job description. Thus, it is advisable to link a job title to a job activity. For example, the job 

title “Software Engineer” can be linked to the job activity “Software Development”, which is linked to the 

“Research and Development” job group. 

By default, some job titles are created once you have installed Exact Synergy Enterprise. You can 

access them at Modules → HRM → Setup → General → Job titles. You can also create more job titles 

if required. 

To create or maintain job titles, function right 96 - Maintain job titles is required. Users with the HR role 

have this function right. 

 

To create job titles: 

1. Go to Modules → HRM → Setup → General → Job titles, and then click New. You will see the 

following page: 

 

2. Under the Criteria section at Code, type a code of up to 12 characters for the job title. This cannot 

be changed after you have saved the job title. 

3. At Description, type a description for the job activity.  

4. Next at Activity, type or select the job activity code to link the job title to the selected job activity. 
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5. Type a number or range of numbers at Job level to define the job level(s) for the job title. 

Note:  

A job level is used to represent the hierarchical level in an organization and as the basis to 

determine the salary range. 

6. At Security level, type a number to specify the security level of the job title. 

Note:  

This can be used to determine the documents that employees with this job title can view. When an 

employee is assigned to a particular job title, the security level of the employee will automatically be 

filled in with the value defined at this field. 

7. At Policy, select a policy that you want to link to the job title. 

8. After filling in other relevant details, click Save to save the new job activity, or click Close to exit. 

Note:  

All fields with the “!” icon are mandatory. 
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4.3.5 Creating entries for employees 

In order to gain access to Exact Synergy Enterprise, the details of all new employees must first be 

created in the system. There are two ways of creating an entry for an employee in Exact Synergy 

Enterprise. The first way is via the applicant process. This means a person starts out with the 

“applicant” status and is linked to a vacancy. When the applicant is hired by your organization, you can 

turn the status of the applicant to an employee, a student, contractor, or temporary. The other way is by 

directly creating the entries without going through the applicant process. 

To create and maintain entries for people, function right 147 - Maintain resource card is required. 

Users with the HR and HR assistant roles have this function right. 

 

To create entries for people: 

1. Go to Modules → HRM → Entry → HRM → Person. Alternatively, go to Modules → HRM → 

Reports → People → People, and then click New. You will see the following page: 

 

2. Under the Summary section at ID, type a number of up to nine digits to specify the ID for the 

person. This cannot be changed once you have saved the entry. 

3. At Last name, type the last name of the person. 
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4. Under the General section at User name, type a user name of up to 20 characters for the person. 

This cannot be changed once you have saved the entry. 

Note:  

This user name will be used to log in to Exact Synergy Enterprise.  

 

5. Under the Employment section at Type, select Contractor, Employee, Student, or Temporary to 

specify the employment type of the person. By default, Employee is selected. 

6. At Start date, type or select the date that the person will begin working for the organization. By 

default, the system-generated date will be filled in. 

7. Next at FTE, type a number to define the Full Time Equivalent (FTE) of the person. By default, 

1.000000 is filled in, which indicates that the person will work full-time. A person who works part-

time will have a pro-rated FTE. 

 

8. Under the Organization section at Job level, select a job level for the person. 

9.  At Security level, type the security level of the person. 

Note:  

By default, the value filled in is similar to the security level defined for the job title. For more 

information, see Creating job titles at 4.3.4 Setting up job system. 

10. Type or select an ID at Manager to define the manager of the person. 

Note:  

By default, the manager of the user who is creating the entry will automatically be filled in. 
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11. At Cost center, type or select the cost center code to define the cost center of the person. 

 

12. Under the Office section at Time zone, type or select the time zone ID to specify the time zone of 

the office that the person is working in. 

13. After filling in other relevant details, click Save to save the entry, or click Close to exit. 

Note: 

• Entries created can be retrieved by going to Modules → HRM → Reports → People → Search, 

defining the criteria, and then clicking Show to display the list of people. Next, click the name of 

the person. 

• All fields with the “!” icon are mandatory. 
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4.4 CRM SETTINGS 

The Customers module in Exact Synergy Enterprise is used to store and share with people the 

information pertaining to customer relationship management (CRM). The following page shows 

information of the CRM settings already defined when you set up a company in Exact Synergy 

Enterprise. You can view the information by going to Modules → System → Setup → Database → Set 

up company under the CRM section. 

To define CRM settings, function right 222 - Maintain CRM settings is required. Users with the 

Administrator and Customer manager roles have this function right. 

 

 

Sectors 

The number displayed in the Value column indicates the number of sectors created in the system. Click 

the number hyperlink and you will see the General: List - Sectors page where you can see the 

overview of sectors and create sectors. For more information, see 4.4.1 Creating sectors. 

 

Sizes: Division 

The number displayed in the Value column indicates the number of account sizes created in the 

system. Click the number hyperlink and you will see the General: List - Sizes page where you can see 

the overview of sizes and create sizes. For more information, see 4.4.2 Creating account sizes. 

 

Show: Warning 

Click the Check hyperlink in the Value column and you can view or edit the account settings on the 

Accounts: Settings page with regard to enabling or disabling warning messages for accounts and 

contacts. For more information, see 4.4.4 Enabling or disabling show warning functionality. 

 

Division: Default 

Click the Check hyperlink in the Value column and you can view or edit the account settings on the 

Accounts: Settings page with regard to setting the default division. For more information, see 4.4.5 

Defining default division. 
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Mail merge 

Click the Check hyperlink in the Value column and you can view or edit the account settings on the 

Accounts: Settings page with regard to defining the mail merge layout settings. For more information, 

see 4.4.6 Defining mail merge settings. 

 

Customer 

Click the Check hyperlink in the Value column and you can view or edit the account settings on the 

Accounts: Settings page with regards to: 

• assigning specific function rights to create accounts. For more information, see 4.4.3 Assigning 

specific function rights to create accounts. 

• enabling or disabling mandatory contracts for customers. If you enable the function, your accounts 

must have contracts in order to be listed as customers. For more information, see 4.4.7 Defining 

settings for status promotion of accounts. 

 

Classifications 

The number displayed indicates the number of classifications created in the system. Click the number 

hyperlink and you will see the General: List - Classifications page where you can see the overview of 

classifications and create classifications. For more information, see 4.4.8 Creating classifications. 
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4.4.1 Creating sectors 

In Customers, a prospect, lead customer, reseller, or supplier is defined as an account. These 

accounts can be segmented into sectors based on the industries the accounts are involved in. 

Segmentation into sectors allows specific marketing activities to be targeted to these sectors. For 

example, a special sales promotion on an industry-related product may apply to accounts in a particular 

sector but not to others. After a sector has been created, it can still be deleted if it does not contain any 

accounts.  Otherwise, you cannot delete it. Once the sectors are created, they can be used to 

categorize your accounts. 

To create and maintain sectors, function right 305 - Maintain sectors and subsectors is required. 

Users with the Customer manager role have this function right. 

 

To create sectors: 

1. Go to Modules → Marketing → Setup → General → Sectors, and then click New. You will see the 

following page: 

 

2. Under the Sector section, type a unique code and a suitable description for the new sector at Code 

and Description respectively. 

3. Select a policy for your sector at Policy. 

4. Finally, click Save to save the new sector, which will be displayed in the list of available sectors, or 

Close to exit. 

Note:  

All fields with the “!” icon are mandatory. 
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4.4.2 Creating account sizes 

Exact Synergy Enterprise allows you to categorize your accounts based on the size of the organization 

(numbers of employee). Hence, you should create the account sizes before you use them to group the 

accounts. 

To create and maintain account sizes, function right 119 - Maintain company size is required. Users 

with the Administrator role have this function right. 

 

To create account sizes: 

1. Go to Modules → Marketing → Setup → General → Sizes, and then click New. You will see the 

following page: 

 

2. Under the Size section, type a unique code and a suitable description for the new account size at 

Code and Description respectively.  

3. Finally, click Save to save the new account size, which will be displayed in the list of available 

sizes, or Close to exit. 

Note:  

All fields with the “!” icon are mandatory. 
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4.4.3 Assigning specific function rights to create accounts 

Exact Synergy Enterprise allows you to assign specific function rights to create accounts. You can 

manage who has the rights to create accounts. For example, you can define that a sales representative 

can create a prospect. However, the account is created by a sales manager.  

To assign specific function rights to create accounts, function right 222 - Maintain CRM settings is 

required. Users with the Administrator and Customer manager roles have this function right. 

 

To assign specific function rights to create accounts: 

1. Go to Modules → Customers → Setup → Other → Settings, and then click Edit. You will see the 

following page: 

 

2. Under the Security settings for creating new account section, define the fields or click  to 

select a specific function right to each account type.  

3. Click Save, and then Close to exit. 
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4.4.4 Enabling or disabling show warning functionality 

By default, a warning will be displayed when opening an account card or a contact card which is 

blocked, passive, or inactive. This warning reminds you that no service should be given to the account. 

 

To disable the show warning functionality: 

1. Go to Modules → Customers → Setup → Other → Settings, and then click Edit. 

 

2. Under the User section, select the Disable: Account - Warning pop-up and Disable: Contact - 

Warning pop-up check boxes. 

3.  Click Save to save the settings. 
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4.4.5 Defining default division 

Every account has to link to a division. Hence, you can define a default division which the accounts will 

be linked to by default when you create the accounts. 

 

To define the default division: 

1. Go to Modules → Customers → Setup → Other → Settings, and then click Edit. 

2. Under the Division section at Default, type or select the default division. 

 

3. Click Save to save the settings. 
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4.4.6 Defining mail merge settings 

You can perform mail merges to send mails to your accounts via Exact Synergy Enterprise. In line with 

this functionality, you should define the mail merge settings. 

Note:  

From product update 250 onwards, the mail merge settings will not be available. The Word Merge 

feature has replaced the mail merge functionality. 

Existing customers moving to product update 250 will still have the old mail merge functionality by 

default, and this can be switched easily to the new Word Merge functionality. When the New Word 

Merge check box under the Word Merge section is selected, the Mail merge: Layouts section will 

not be displayed. Word Merge will replace the mail merge functionality. You will be able to create 

letters and e-mails directly from the account cards, contact cards, personal cards, project cards, 

request pages, and new document pages. For more information, see the Word Merge section at 

4.6.2 Defining document settings and the Customers User Guide for Exact Synergy Enterprise. 

 

To define mail merge settings: 

1. Go to Modules → Customers → Setup → Other → Settings, and then click Edit. 

 

2. Under the Mail merge: Layouts section, select a default label which will be used for the mail merge 

at Label. 

3. At Requests, select a default mail merge layout which will be used in the account card. 

 

4. Under the E-mail section, type the default e-mail address of the sender for mail merge in the 

account card at Sender (Default) and the default sender’s name at Name (Default). 

5. Click Save to save the settings. 

Note:  

All fields with the “!” icon are mandatory. 

 

 

 



CHAPTER 4 | INITIAL COMPANY CONFIGURATION 

247 

 

4.4.7 Defining settings for status promotion of accounts 

Exact Synergy Enterprise allows you to define the prerequisites in promoting the status of an account. 

For example, you can specify that a sales order must be created from an account in order to be 

promoted to a customer status. Likewise, the prerequisites to promote an account to a prospect status 

can be a request for a quotation. Policies defining these prerequisites can be attached to the respective 

account types for reference. You can define these on the Accounts: Settings page. 

 

To define settings for status promotion of accounts: 

1. Go to Modules → Customers → Setup → Other → Settings, and then click Edit. 

 

2. Under the Customer section, select the Mandatory: Contract check box to disallow customer 

accounts to be created directly. Instead, prospect accounts can be promoted to customer accounts 

if there is a debtor number and a valid contract. 

 

3. Under the Policy section, you can select a policy document for each account type. For example, 

you can select a policy document at Prospect (Company), which will list the conditions and 

processes required to create prospects. 

4. Click Save to save the settings. 
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4.4.8 Creating classifications 

Meanwhile, the system also supports the classification of accounts based on the business structural 

sizes to facilitate account segmentation for marketing purposes. For example, corporate-, small- and 

medium-sized accounts can be grouped accordingly in Exact Synergy Enterprise. You need to create 

the classifications to categorize your accounts. 

To create and maintain classifications, function right 319 - Maintain classifications is required. Users 

with the Customer manager role have this function right. 

 

To create classifications: 

1. Go to Modules → Marketing → Setup → General → Classifications, and then click New. You will 

see the following page: 

 

2. Under the Classifications section, type a unique ID and a suitable description at ID and 

Description respectively to identify the classification. 

3. At Type, select the new classification type. The classification type can be used to indicate the type 

of account that is allowed to use the classification. For example, if you select Customer at Type, 

this classification can only be linked when the account type is Customer. 

4. Next, type a number for the order of the classification within the list of classifications at Order. This 

is useful if you want to list the classifications in the order of importance. 

5. Select a policy for the classification at Policy. 

6. Finally, click Save to save the new classification, which will be displayed in the list of available 

classifications, or Close to exit. 

Note:  

All fields with the “!” icon are mandatory. 
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4.5 SETTING UP CUSTOMER OR RESELLER PORTALS 

To improve the efficiency of the business process, customers and resellers should be given access to 

appropriate portals where they can access the product and marketing information as well as their 

account information readily. They can even create documents, requests, and orders through the 

customer and reseller portals which are also accessible by your company. Hence, your company can 

also process the documents, requests, and orders immediately, thereby shortening the communication 

time considerably. To view the information of the customer or reseller portal settings, go to the 

Customer portal / Reseller portal section via Modules → System → Setup → Database → Set up 

company. See the following page: 

 

 

Mail merge 

Click the Check hyperlink in the Value column and you can view or edit the account settings on the 

Accounts: Settings page with regard to defining the mail merge settings. For more information, see 

4.4.6 Defining mail merge settings. 

 

Portal: Path 

Click the Check hyperlink in the Value column and you can view or edit the account settings on the 

Accounts: Settings page with regard to defining the portal paths for the customer and reseller portals. 

For more information, see 4.5.1 Defining portal paths. 
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4.5.1 Defining portal paths 

You can define the portal paths for the customer portal and reseller portal when you define your 

account settings. These links will enable you to log on to the portals via the hyperlink in 

CRMQuestionnaire.aspx (entry form for new accounts and requests). You can also log on to the e-

mail facility after access to the portal has been granted. 

 

To define the portal paths: 

1. Go to Modules → System → Setup → Database → Set up company. 

2. Under the Customer portal / Reseller portal section, click Check in the Value column at Portal: 

Path. Next, click Edit on the Accounts: Settings page. Alternatively, go to Modules → Customers 

→ Setup → Other → Settings, and then click Edit. 

 

3. Under the Server section, at Customer portal, Reseller portal, and Public, type the respective 

portal address for the customers, resellers, and public to log on to the relevant portals. 

4. For each portal address you have defined for the customers, resellers, and the public, type the path 

where the ASPX files will be stored at Path. 

5.  Click Save to save the settings. 
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4.6 DOCUMENT SETTINGS 

Exact Synergy Enterprise stores all created documents in one centralized database. The following page 

shows the information of the document settings already defined when you set up a company in the 

system. You can view the information via Modules → System → Setup → Database → Set up company 

under the Documents section. 

 

Categories 

The number displayed in the Value column indicates the number of document categories created in the 

system. Click the number hyperlink and you will see the Documents: Categories page where you can 

view all the available document categories and create document categories. For more information, see 

Appendix 10 Document Categories. 

 

Settings 

Click the Check hyperlink in the Value column and you can view or edit the document settings on the 

Documents: Settings page. For more information, see 4.6.2 Defining document settings. 

 

Layouts: Frontpage 

The number displayed in the Value column indicates the number of Frontpage layouts created in the 

system. Click the number hyperlink and you will see the Layouts: Frontpage page where you can view 

all the available Frontpage layouts and create Frontpage layouts. For more information, see 4.6.3 

Creating Frontpage layouts. 
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4.6.1 Creating document types 

Documents are a source of information that needs to be managed for easy creation, retrieval, and 

accountability. Also, document features are well-integrated with other functions within the application. 

You can define the properties or attributes of the documents in the settings for document types. 

To create and modify document types, function right 361 — Maintain Document Type is required. 

Users with the Documents administrator role have this function right. However, a person defined at 

Manager under the General tab under the General section as described in the following section “To 

create document types” can also modify the document type definition. 

 

To create document types: 

1. Go to Modules → Documents → Setup → Maintenance → Document: Types, and then click New. 

You will see the following page: 

 

2. Under the General tab, click   at Document Group under the General section to select a 

document group that will group this document type. 

3. At Description, fill in the description of the document type.  

4. Next at Active, select or clear this check box to activate or deactivate this document type 

respectively. A deactivated document type cannot be used to create documents. 

Note:  

This check box will be selected and disabled if the System: Type check box is selected under the 

Document section under the More properties tab. 
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5. At Security level under the Creator section, select a security level or type a security level number 

to allow only document creators with the security level clearance above this security level to create 

a document of this type. This setting overrides the Security level setting in the subcategory of 

documents of this type. 

 

6. You can limit the rights to edit and view documents to people from specific groups at document type 

level. At Edit under the Share tab under the Rights section, select the required type of editing right 

based on the following: 

• Yes — Documents of this type can be modified by the document creator, owners, and 

approvers. Select this option to activate the Check in/Check out check box under the Check 

in/Check out section. 

• No — Documents of this type cannot be modified by anyone except the document administrator 

if the document is in the Approved status. The document can still be modified in the Draft, 

Open, or Rejected status.  

• No, only creator — Documents of this type can be modified only by the document creator once 

the document is in the Approved status.  

• No, only approver — Documents of this type can be modified only by the document approver 

once the document is in the Approved status. To use this option, the Use check box under the 

Approve section under the Publish tab must be selected. 

Note:  

If you are viewing this page in the Standard mode for document structure, the Edit rights section is 

separated from the View rights section, which works just the same, as in the Classic mode. To 

check the document structure mode of the current settings, go to Modules → Documents → Setup 

→ Maintenance → Settings. 

7. Under the Share tab under the Check in / Check out section, select the Check in / Check out 

check box to allow this type of documents to be modified by one person at a time for multi-owner 

documents. When one of the document owners saves a document, the document is considered as 

checked out. The same owner who has checked out the document must click Check In in the 

document editor or viewer before other owners of the document can modify the document. A 

document administrator can check in any document regardless of the checked out status or 

document ownership. 

8. At Numbers of days for check-out check box, type a value to specify the number of days that the 

document of this type can be checked out. 
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9. Finally, click Save to save the document type and its settings. 

Note:  

All fields with the “!” icon are mandatory. 
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4.6.2 Defining document settings 

Document settings affect document-related functionalities in the system. For example, the settings 

determine the size of pictures added to documents, whether the creator must select a document type 

when creating a document, and whether pictures for Frontpages can be resized. To define document 

settings, go to Modules → Documents → Setup → Maintenance → Settings. 

To maintain the standard document settings, function right 269 - Maintain standard settings for 

documents is required. Users with the Documents administrator and Web administrator roles have 

this function right. 

 

Frontpages section 

 

 

City 

Type a city to be displayed on the Frontpage. 

 

Picture 

Type the maximum size of a picture that is allowed to be attached to a Frontpage. 

 

Width 

Type a fixed width for the picture on the Frontpage. 

 

Height 

Type a fixed height for the picture on the Frontpage. 
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Resize 

Select the required option whether the picture can be resized on the Frontpage. There are four 

available options: 

• No — The picture cannot be resized. 

• Yes (Standard) — The picture can be resized to the size specified at Height and Width. 

• Yes (Smaller) — The picture can be resized if it is smaller than the size specified at Height and 

Width. 

• Yes (Bigger) — The picture can be resized if it is bigger than the size specified at Height and 

Width. 

 

Default: Frontpages section 

 

 

Documents/HRM/Financial/Logistics/Customers/Workflow/Projects/Assets/Others 

Type or select the default Frontpage layout for the respective news pages at Documents, HRM, 

Financial, Logistics, Customers, Workflow, Project, and Assets. 

 

Forum: Links section 

 

 

You can set up links using the forum feature. Click Add to specify a link. After specifying a link 

description and URL, you will be able to see the link in the Description column under the Links 

section. 
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Word Merge section 

 

 

This section defines the default label used in communications with your various accounts (customers, 

suppliers, and associates). It also allows you the option to activate and use the new Word Merge 

feature, which offers a wide range of improvements from the mail merge functionality. 

 

Label: Accounts 

Select a label to be used as the default mail merge layout for an account. The defined label will be used 

for communications with the accounts. For example, if you click Label on an account card, this layout is 

used. 

Note:  

This option is available only if the New Word Merge check box is not selected. 

 

New Word Merge 

• The Reference number field will be displayed on the Documents: Settings page. 

• On the Account: Settings page (go to Modules → Customers → Setup → Other → Settings), the 

following sections will be affected: 

• The Mail merge: Layouts section will not be displayed. 

• The Mail merge for customer portal: Document type section will not be displayed. 

• The Mail merge for reseller portal: Document type section will not be displayed. 

• The Word Merge settings for Customer Portal section will be displayed. 

• The Word Merge settings for Reseller Portal section will be displayed. 

• The Create letter and Create email buttons will be displayed on the following cards and pages, 

depending on the merge process (single or bulk) that you are performing: 

– Account cards 

– Contact cards 

– Person cards 

– Project cards 

– Request page 

– Document: New page 

– Accounts search results page 

– Contacts search results page 

– Requests search results page 

– Person or people search results page 

• The Generate Quotation button will be displayed on quotation cards, replacing Open in MS Word. 

• The Mail merge button has been removed from the account cards, contact cards, person cards, 

request cards, and the Document: New page. 
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You will be able to create letters and e-mails directly from the account cards, contact cards, person 

cards, project cards, request cards, and the Document: New page. Furthermore, you can also create 

letters and e-mails on bulk processes directly based the accounts, contacts, requests, and person 

search results. 

Note: 

• Depending on the product update you are using, you may or may not use all of the features 

mentioned above. 

• The new Word Merge functionality comes as a package in product update 250 which replaces 

the old mail merge functionality. For new customers, or when you are creating a database, the 

old mail merge functionality will no longer be available. No settings are required. 

• Existing customers moving to product update 250 will still have the old mail merge functionality 

by default, and this can be switched easily to the new Word Merge functionality. 

 

Reference number 

Type a number to be used as the reference number on letters and e-mails. This number must be an 

integer, positive, and less than 2,147,483,646. It increases when performing each merge and may 

increase multiple times when performing bulk merging processes. 

This field can be used to create your templates. 

 

Documents section 

 

 

Picture: Width 

Type a fixed width for the document’s picture. 

 

Layout 

Select a default layout for the document. This layout will be used for all documents created in the 

categories that do not have a specific layout defined. 

 

Type: Mandatory 

Select this check box to make it mandatory to select a document type when you create a document. 

You cannot save the document unless the document type is specified. If the check box is not selected, 

the documents can be saved without a document type defined. 
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Tagging Maximum 

Type the maximum number of tags that users are allowed to tag per document. The minimum number 

of tags per document is 1 and maximum is 999,999,999. By default, "100" is displayed. 

 

Website section 

 

 

Show: ID 

Select this check box to display the document ID for documents that are published to the public in Exact 

Synergy Enterprise. 

 

Security section 

 

 

FDA (Security) 

Select this check box to activate the FDA security function. When the FDA security function is activated, 

you will see a login page when you approve a document. You need to fill in a valid user name and 

password to continue with the secure approval. If the login is correct, you will see a page that displays 

the security statement and allows you to approve the document. After the document has been 

approved, you will see a page that confirms that the document has been approved. Click Close to exit. 

 

Security statement 

Select a security statement that describes the security policy. This document will be displayed in the 

page after the user logs in during the security approval (if the user name and password is valid). 

 

URL FDA 

Type the URL that will be used to redirect the approval to the virtual directory to enforce additional 

security feature. 
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XML section 

 

 

This section defines the URL for Synergy Office Add-in (Exact Synergy Enterprise integrated function 

with applications, such as Microsoft Word and Microsoft Outlook). 

 

URL 

Type the URL address to link Synergy Office Add-in with Exact Synergy Enterprise. If the URL is not 

defined in the settings of Synergy Office Add-in, this URL will be used to link Synergy Office Add-in 

with Exact Synergy Enterprise. For more information, see 7.4 Microsoft Office Add-in (Registering the 

MSXML components) and 7.4.2 Installing Microsoft Office Add-In. 

 

Document structure section 

 

 

Document structure 

Select the type of document structure to be displayed: 

• Classic — Select this option to view the document structure in the Classic mode.  

• Standard — Select this option to view the document structure in the Standard mode. 

Note:  

This is enabled only if you are currently using the Classic mode. Once you have upgraded to the 

Standard mode, you will not be able to revert back to the Classic mode. 

 

Online help feedback template section 

 

 

Document 

Select a feedback form template for online help. When this section is defined correctly, a feedback form 

will be displayed at the bottom of an online help document to allow users the convenience of submitting 

feedback on how to improve the document. For example, users can press F1 or click the Help icon on 

all pages in Exact Synergy Enterprise to display the System: Help page. 

http://www.exactsoftware.com/docs/DocView.aspx?Action=View&DocumentID=%7bB835DD52-2ED2-4A30-90B8-2422E34544A1%7d&NoHeader=1&NoSubject=1
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4.6.3 Creating Frontpage layouts 

Documents can be published as news messages on special news pages in Exact Synergy Enterprise. 

These news messages can be presented in a customized layout. For each news page, a separate 

layout can be created in addition to creating different layouts for divisions and for customers and 

resellers. 

To create and maintain Frontpage layouts, function right 255 - Maintain News Layout is required. 

Users with the Documents administrator and Web administrator roles have this function right. 

 

To create Frontpage layouts: 

1. Go to Modules → Documents → Setup → Layouts → Frontpage, and then click New. You will see 

the following page: 

 

2. Under the Layout section at Use, select Default or Document to create a Frontpage layout using 

the default options or by applying a pre-designed document. 

3. At Code, type a code for the new Frontpage layout. 

4. Under the News section, select the division at Division that will be using the Frontpage layout. 

Only employees linked to the selected division can use the Frontpage layout. 

5. At Description, type the description for the Frontpage. This description will be visible when 

viewing the list of Frontpage layouts. 

6. Select the Headlines check box to ensure that documents published as Headlines are visible on 

the Frontpage layout. 

7. Type a number at Page size to set the number of news items to be displayed in the headlines 

section. 

8. Select the Include: Picture check box to include any first picture found in the document to be 

displayed along with the headline. 

9. Select the Frontpages check box to ensure that links to other Frontpages are visible on the 

Frontpage layout. This allows quick access to other Frontpages, if required. 

10. Next, type a number at Rows to determine the maximum number of rows of news items that should 

be displayed on the Frontpage. 
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11. At Include: News, select the relevant check box to determine whether news from the Division, 

Country, or Group are included on the Frontpage. You can select more than one check box. 

Note:  

These check boxes are related to the Criteria section as explained in the following step 15. They 

are used as an “AND” relation. 

12. Select the Active check box to activate the Frontpage layout. During the creation or modification of 

the Frontpage , the check box can be cleared to deactivate the layout to prevent the Frontpage 

from being used. 

13. At Picture, select a default picture to be used for every news item if it does not have one. 

14. Select a background picture to be used for the headlines section at Background. To do this, you 

must first ensure that a picture has already been uploaded into the system. This can be done via 

Modules → Documents → Setup → Maintenance → Pictures. 

15. Under the Documents section, select a document for Header, Editorial, and/or Footer to be used 

in the corresponding parts of the Frontpage layout in order to customize the different parts of the 

document. Alternatively, you can also click Customize to customize the Header and Footer using 

HTML. 

Note:  

After the Frontpage layout has been saved, a Customize button will be displayed to allow you to 

edit the default Header and/or Footer parts in the HTML format when no document has been 

selected at Header and Footer. Under the Criteria section, type the criteria to filter the news items 

that will be displayed on the Frontpage. The criteria are stored as SQL statements in the 

documents table. 

16. Click Save to save the Frontpage layout. 

Note:  

All fields with the “!” icon are mandatory. 
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4.7 LOGISTICS SETTINGS 

Logistics allows the creation of a web shop where customers can view and buy items on the Internet. 

The best scenario in which to set up a web shop is an integrated scenario with Exact Globe Next. The 

following page shows the information of the logistics settings already defined when you set up a 

company in Exact Synergy Enterprise. You can view the information by going to Modules → System → 

Setup → Database → Set up company under the Logistics section. 

 

 

Settings 

Click the Check hyperlink in the Value column and you will see the Logistics: Settings page where 

you can view and edit the logistics settings. For more information, see 4.7.1 Defining logistics settings. 

 

Assortment – Properties 

Click the Check hyperlink in the Value column and you will see the Items: Assortment - Properties 

page where you can create assortment properties. For more information, see 4.7.2 Creating assortment 

properties. 

 

Assortments 

The number displayed in the Value column indicates the number of assortments created in the system. 

Click the number hyperlink and you will see the Assortments page where you can view the available 

assortments and create assortments. For more information, see 4.7.3 Creating assortments. 

 

Catalogs 

The number displayed in the Value column indicates the number of catalogs created in the system. 

Click the number hyperlink and you will see the Items: Catalogs page where you can view the 

available catalogs and create catalogs. For more information, see 4.7.4 Catalogs. 

 

Item: Relation types 

The number displayed in the Value column indicates the number of item relation types created in the 

system. Click the number hyperlink and you will see the Items: Relation types page where you can 

view the available item relation types and create item relation types. For more information, see 4.7.5 

Creating item relation types. 
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Items 

The number displayed in the Value column indicates the number of items created in the system. Click 

the number hyperlink and you will see the New: Item page where you can view all the assortments 

available in the system. From this page, you can create items under specific assortments. For more 

information, see 4.7.6 Creating items. 
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4.7.1 Defining logistics settings 

When you define the logistics settings, you can set up the numbers used for creating sales orders, 

sales invoices, purchase orders, and contracts in Exact Synergy Enterprise. To define the logistics 

settings, go to Modules → Logistics → Setup → Settings → Settings. 

To define the logistics settings, function right 15 - Maintain Item control settings is required. Users 

with the Item management role have this function right. 

 

 

Sales orders section 

Number: Starts with 

Type a starting number for the sales order number. You can specify up to eight digits. 
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Sales invoices section 

Number 

Select the format of the invoice number for the sales invoices. There are five available format options: 

• Sequence number — An automatically incremented invoice number. 

• Year: Sequence number — The invoice number format starts with the year, followed by a 

sequential number. For example, 2005:0001. 

• Invoice code: Sequence number — The invoice number format starts with the invoice code, 

followed by a sequential number. For example, 100:0001. 

• Year: Invoice code: Sequence number — The invoice number format starts with the year, followed 

by the invoice code, and then a sequential number. For example, 2005:100:0001. 

• Invoice code: Year: Sequence number — The invoice number format starts with the invoice code, 

followed by the year, and then a sequential number. For example, 100: 2005:0001. 

 

Number: Starts with 

Type a starting number for the sales invoice number. You can specify up to eight digits. 

 

Group by: Invoice customer contact 

Select this check box to group the related invoice requests based on the debtor contact person when 

you perform invoice request processing (click Invoicing at Modules → Logistics → Reports → Invoice 

→ To be invoiced). By default, this check box is selected. 

 

Purchase orders section 

Number: Starts with 

Type a starting number for the purchase order number. 

 

Contracts section 

Number 

Select a numbering convention to be used by contracts. The following formats are available for 

contracts: 

• None — This allows the contract number to be entered with any value and will not be generated by 

the system. 

• Sequence number — This is an automatically incremented number. 

• Account: Sequence number — The contract number starts with the account number, followed by a 

sequential number. For example, 1234:0001. 

• Account: Division: Sequence number — The contract number starts with the account number, 

followed by the division number, and then a sequential number. For example, 1234:100:0001. 

 

Warehouse section 

Default 

Select a default warehouse to be used for logistics operations. 
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4.7.2 Creating assortment properties 

Assortment properties allow items to be categorized within an assortment based on different attributes. 

For example, when the assortment “Bicycles” is created, a color property can be added with the options 

red, blue, and yellow. Assortment properties allow for a narrower search when looking for items. There 

are only 10 assortment properties available, but an unlimited number of options can be created for each 

property. 

To create and maintain assortment properties, function right 14 - Maintain Item assortment 

categories is required. Users with the Item management role have this function right. 

 

To create assortment properties: 

1. Go to Modules → Logistics → Setup → General → Assortment: Properties, and then click New. 

 

2. Under the General section, type a unique property code for the assortment property at Code. If you 

are modifying an existing assortment property, this code cannot be changed. 

3. At Description, type a description for the assortment property. The description will be displayed on 

the item card and in item reports.  

4. Select the assortment property category at Category to which the assortment property belongs to. 

A property can only be linked to one property category. When the value is needed in two property 

categories, then the property must be created twice. 

5. At Security level, select the security level type, or type the security level to determine the 

employees who will have access to the assortment property information. 

6. Under the Remarks section, you can type additional information about the meaning and use of the 

assortment property. 

7. If you have a picture that describes the assortment property, you can upload the picture under the 

Pictures section. At Upload, click Browse to select the picture file to be uploaded. 

8. Click Save to save the new assortment property. 

Note: 

• You can delete an assortment property after verifying that it is not used anywhere. If the 

property has been used, it cannot be deleted. To delete the property, go to Modules → Logistics 

→ Setup → General → Assortment: Properties, select the property which you want to delete, 

and then click Delete on the Items: Assortment Property page. 

• All fields with the "!" icon are mandatory. 
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At anytime, you can also define or edit the assortment property categories which you need to link to the 

assortment properties you want to create as described in step 4 of To create assortment properties. To 

do this, function right 13 - Maintain Item assortment names is required. Users with the Item 

management role have this function right. 

 

To define assortment property categories: 

1. Go to Modules → Logistics → Setup → General → Assortment: Properties, and then select an 

assortment category which you want to define. For example, select 3 - assortment 3. 

 

2. Under the General section, type a description for the new assortment category at Description. For 

example, type “Product Group”. 

3. Click Save to save the assortment category. You may want to create assortment properties like 

“Invoices”, “Letterhead”, and “Labels” and link them to the “Product Group” assortment category 

next. 
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4.7.3 Creating assortments 

Assortments are used to categorize items. They can be defined as categories which are used to identify 

groups of items with similar properties. When you create an item, it is mandatory to link it to an 

assortment. To create assortments, go to Modules → Logistics → Setup → General → Assortments, 

and then click New. 

To create and maintain assortments, function right 217 - Maintain Item assortment is required. Users 

with the Item management role have this function right. 

 

General section 

 

 

Assortment 

Type a unique numeric code for the assortment of up to a maximum of 10 digits. This code cannot be 

edited once the assortment is saved. By default, the next running number is displayed. For example, if 

the previous assortment code is “105”, the next assortment code will be “106”. 

 

Code 

Type a unique code of up to a maximum of 30 characters for the assortment. This code cannot be 

edited once the assortment is saved. 

 

Description 

Type a description for the assortment. 

 

Person 

Type or select a person that will be in charge of the assortment. The person can modify the settings for 

the assortment regardless whether the person has the relevant function rights or role. 
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Security section 

 

 

Security level 

Select the security level for the assortment. The security level will change once the security type is 

selected. For example, if Internal is selected, the security level will change to “10”. The security level 

determines whether the user is allowed to view the assortment. The security types available are: 

• All — Select this option to allow all users to view the assortment. 

• Customers — Select this option to allow only customers to view the assortment. 

• Partners — Select this option to allow only partners of the company to view the assortment. 

• Customers (Specific) — Select this option to allow only specific customers to view the assortment. 

• Partners (Specific) — Select this option to allow only specific partners to view the assortment. 

• Internal — Select this option to allow only internal users to view the assortment. 

 

Allow: New – Item 

Select this check box to allow new items to use this assortment. 

 

Price: Security 

Select the security level for the prices of the items in the assortment. The security level will change 

once the security type is selected. For example, if Internal is selected, the security level will change to 

“10”. This security level determines the user who is allowed to view the prices of the items in the 

assortment. The security types available are: 

• All — Select this option to allow all users to view the prices of the items in the assortment. 

• Customers — Select this option to allow only customers to view the prices of the items in the 

assortment. 

• Partners — Select this option to allow only partners of the company to view the prices of the items 

in the assortment. 

• Internal — Select this option to allow only internal users to view the prices of the items in the 

assortment. 
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G/L Account section 

 

 

Revenue/Deferred revenue/Deferred cost/Discount/Cost of goods sold/Purchase/Price 

differences 

Type or select the general ledger accounts to be used in the respective transactions involving the items 

linked to this assortment. 

 

Contract section 

 

 

Used in: Contracts 

Select this check box to allow the assortment to be used when creating contracts. 

 

Allow: New – Contract 

Select this check box to allow the assortment to be used only once for new contracts. 

 

Item – Selection 

Type an item selection to create a main contract item for the assortment whereby the main contract 

item can be linked to the contracts. For example, to create a main contract item with item code 

“DB0101”, type Items.ItemCode = ‘DB0101’. However, define the item selection only if one main 

contract item is used for an assortment. 
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Program – ID 

Type a program ID to generate vouchers. For example, “eVoucher.Document”. You will have to run a 

customized file, such as Exact.Contract.Voucher.dll to generate vouchers. 

 

Parameter 

Type a parameter to generate passwords for products. 

 

Document 

Select a document path for the assortment. 

 

Security level 

Select the security level for the assortment used in contracts. The security level will change once the 

security type is selected. For example, if Internal is selected, the security level will change to “10”. The 

security level determines whether the user is allowed to view the assortment in the contracts. The 

security types available are:  

• All — Select this option to allow all users to view the assortment in the contract.  

• Customers — Select this option to allow only customers to view the assortment in the contract.  

• Partners — Select this option to allow only partners of the company to view the assortment in the 

contract.  

• Customers (Specific) —Select this option to allow only specific customers to view the assortment 

in the contract.  

• Partners (Specific) — Select this option to allow only specific partners to view the assortment in the 

contract.  

• Internal — Select this option to allow only internal users to view the assortment in the contract. 

 

Properties section 

 

Under the Properties section, you can link assortment properties to the assortment. However, you can 

only do this after you have clicked Save to save the assortment. 

After you have clicked Save to save the assortment, you will see a New button on the header of the 

Properties section. Click New to link the assortment to the assortment properties you have created 

earlier at 4.7.2 Creating assortment properties. 

Note:  

All fields with the "!" icon are mandatory. 
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4.7.4 Catalogs 

Catalogs can be used to display the items of a certain assortment, or when implementing a web shop. 

Either way, it can be a very helpful in keeping items structured and to differentiate those items that are 

not available for the web shop. When working in an integrated scenario with Exact Synergy Enterprise 

and Exact Globe Next on the same database, the assortments are equivalent to each other. 

Catalogs can be used to display available items. There is no limit to the number of catalogs that can be 

created. The catalogs that are created and the assortments that are linked to them determine the way 

the products are presented in the web shop. The catalog is what customers see when logging on to the 

web shop. Therefore, it is important that it is clear to customers what they need to do if they want to buy 

an item. 
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4.7.5 Creating item relation types 

Relationships can be established between items. For example, a part item is an item that has a relation 

type with another item. For example, a finished product (parent item) needs to be shipped with the 

product manual (child item). Thus, the finished product is linked to the product manual by a relationship 

which is classified as mandatory. You can create and maintain item relation types in Exact Synergy 

Enterprise. 

To create and maintain item relation types, function right 24 - Maintain Item relation types is required. 

Users with the Item management role have this function right. 

 

To create item relation types: 

1. Go to Modules → Logistics → Setup → General → Item: Relation types, and then click New. You 

will see the following page: 

 

2. Under the General section at Type, type a unique numeric code for the relation type. This code 

cannot be edited once the type is saved. By default, the next running number is displayed. For 

example, if the previous relation type code is “50”, the next assortment code will be “51”. 

3. Type a description for the relation type at Description.  

4. At Status, select the status for the item relation type. The following is the brief description of the 

possible item relationships: 

• Default — This indicates a relationship and is not specific. 

• Mandatory — The child is mandatory when selecting the parent. The relationship is always top-

down. 

• Mandatory (One of set) — Maximum one of the children is mandatory when selecting the 

parent. 

• Mandatory (At least one) — Minimum one of the children is mandatory when selecting the 

parent. 

• Mandatory (One or none) — Minimum one of the children or none is mandatory when selecting 

the parent. 

• Optional — The child is optional when selecting the parent. 

• Optional (One of set) — The child is optional, but at least one of this set should be selected. 

• Replacement — No functionality at this time. 

• Trade-in — No functionality at this time. 

• Invalid — This child cannot be selected if the parent has already been selected. 
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5. Click Save to save the item relation type. 

Note:  

All fields with the "!" icon are mandatory. 
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4.7.6 Creating items 

You can create and maintain the items to be used in the system. To create items, go to Modules → 

Logistics → Entry → General → Items. 

To create and maintain items, function right 34 - Maintain World Items, except to change the 

division or function right 347 - Maintain Country items is required. Users with the Item management 

role have these function rights. 

 

General section 

 

 

Code 

Type a unique alphanumeric code for the new item. You can type up to 30 characters. If you are 

modifying the item information, this information cannot be edited. 

 

Country 

Select a country for the item. By default, an item is created with World as the country. When an item is 

sold in more than one country, item code-country combinations are created to register the (price) 

regulations for each country. 

 

Description 

Type a description for the item. 

 

Search code 

Type a search code for the item. 
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Division 

Select a division to be linked to the item. An item can be linked to a division, which can be used as a 

filter. 

 

Person 

Select a person to be linked to the item. The person will become the item’s owner, and can therefore 

edit and modify the item properties. An item can only have one person as its owner. 

 

Warehouse 

Select the default warehouse for the item. This warehouse will be set by the system in logistics 

transactions for the item. 

 

Type 

Select a type for the item. The following types are available: 

• Standard — Items that can be purchased, sold, and produced. 

• Phantom — Items that cover a logical set of cost, discounts, payment conditions, or components in 

business transactions, such as extra charges, payment conditions, and shipping methods. 

• Bulk issue — Items that are purchased, stored, manufactured, or sold in batches. Bulk issue items 

are usually items of relatively lower value and are small in size. 

• Labor hour — Labor capacity used to produce a manufactured item. 

• Machine hour — Machine capacity used to produce a manufactured item. 

• Contract — Items related to service management. 

• Reason codes — Items related to reason codes. Reason codes are used in the swap function, 

reject contract function, and termination for rental contracts to represent the reason for exchanging 

serialized rental equipment, rejecting a contract, or creating a termination respectively. 

Note:  

The item type determines how the item can be used in Exact Synergy Enterprise and Exact Globe 

Next. 

 

Active from 

Type or select a date starting from which the item is active. By default, the current login date is 

selected. 
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Active to 

Type or select a date after which the item is inactive. After the item is inactive, you will not be able to 

use this item for logistics transactions (sales orders, purchase orders, and internal use requests). 

Note:  

It is not necessary to fill in this date unless the inactive, blocked, or discontinued date of the item is 

known. 

 

Status 

Select a status for the item you want to create. The following statuses are available: 

• Blocked — Items that are blocked for use in all standard transactions, such as sales, purchase, 

assembly or manufacturing, receiving, and delivery. However, blocked items can still be used in bills 

of material, budget planning, and stock counts.  

• Discontinued — Items that are blocked for use in purchase transactions but can still be used in bills 

of material, sales, budget planning, and stock counts. 

 

Security level 

Type the security level to restrict the people who are allowed to use and view the item. 

 

Prices section 

 

 

Unit 

Type or select a unit of measure for one unit of the item. 
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Type 

Select a price model to determine the sales price of an item. The following price models are available: 

• Discounts — This price model is used to define price models that are dependent on the quantity of 

items sold. Sales prices are calculated based on the price per item. When viewing the item 

information, the prices shown are always per item. For example, the price for one unit of item A is 

EUR 200 per unit, EUR 180 per unit for two units, and EUR 150 per unit for five units. The total price 

calculated for three units sold is EUR 540 (3*180) and the total price for eight units sold is EUR 1200 

(8*150). 

• Variants — This price model is used to define price models that are not dependent on the quantity 

of the items sold. Sales prices are calculated based on the total price for a certain quantity of items. 

The price per piece is the total price divided by the quantity. For example, the total price for one unit 

of item B is EUR 200, two units is EUR 380, and five units is EUR 850. The total price calculated for 

three units sold is EUR 570((380/2) *3) and the total price for eight units sold is EUR 

1360((850/5)*8). 

 

Sales price 

Type or select a currency, and then type an amount to define the sales price of one unit of sale item. 

 

Costs 

Type or select a currency, and then type an amount to define the cost price of one unit of sale item. 

 

Attributes section 

 

Under the Attributes section, you can define the attributes of the item that determine the transactions 

allowed for the item. 

 

Sales/Buy/Stock controlled/From stock/Serial numbers/Billable/Part/Divisible/Policy/Make/No 

discount/Productive/Explode/Batch/Text/Print on invoice/Service 

Select the check boxes to define the attributes of an item. You can select more than one check box. 

The attributes selected allow you to use the item in specific circumstances. For example, if an item 

needs to be sold, then the Sales attribute must be selected. If an item uses serial numbers, the Serial 

numbers check box must be selected. At least one attribute must be set for each item. For more 

information on item attributes, see 4.7.7 More on item attributes. 
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G/L Accounts section 

 

 

Asset/Costs/Purchase/Revenue 

Type or select the general ledger accounts that will be used to register the relevant transactions for the 

item. By default, the general ledger accounts are filled in with the general ledger accounts of the 

assortment specified for the item under the Categories section. You can still change the accounts 

manually. 

 

Other section 

 

 

Replacement 

Type or select an item code to specify the replacement for this item if it is not available. 

 

Request – Shopping 

Type or select a request type to specify the request definition which is used to generate the sales order 

for the item. 

 

Request – Purchase 

Type or select a request type to specify the request definition which is used to generate the purchase 

order for the item. 
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Statistical code 

Type or select a statistical code for the item. Statistical codes are used by the Intrastat system to enable 

identification of different types of movement of goods, for example, regular import and export, transit 

traffic, and temporary relocation of stocks. 

Note:  

This function is used in Exact Globe Next (defined at System → Logistics → Intrastat). Intrastat is 

the system for collecting statistics on the movement of goods among member states of the 

European Union (EU). 

 

Net weight 

Type or select a value to specify the weight (in kilograms) of one unit of the item. 

 

Categories section 

 

 

Assortment 

Type or select an assortment to be linked to the item. This is mandatory. 

Note: 

• If the assortment is linked to assortment properties, you will see the assortment categories 

displayed after you have selected the assortment. At each assortment category, there is a list of 

assortment properties that are available for selection. Select the relevant assortment properties 

for the item at the respective assortment category. 

• All fields with the "!" icon are mandatory. 

Tip:  

After you have clicked Save to save the item, you can upload a picture of the item under the 

Picture section in the item card. 
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4.7.7 More on item attributes 

The following table summarizes the item attributes used in Exact Synergy Enterprise: 

Attributes Explanation 

Sales This is used for items to be sold either internally or externally. This must be set to 

display the item(s) in the catalog. If a sales item exists but should not be shown in 

the catalog, modify the availability and do not reset the Sales attribute. 

Buy These are items that are bought, either to resell or to use internally. After creating 

the item, the purchase attributes are linked to a report listing all supplier accounts 

that are linked to the item. 

Stock This determines if the item is a stock item. Click Stock to get a stock position 

report. 

From stock This has no functionality in Exact Synergy Enterprise. This is used in Exact Globe 

Next as an indicator that the shelf stock should always be available for this item. 

Serial 

numbers 

This is used to track the item with a serial number, or used if an item is a planning 

item. For example, assets, meeting rooms, hardware, and cars. 

Part This is used for product parts. Select this if the item is actually a part that is used to 

make another item. Click Part to start configuring the item. 

Divisible If selected, fractions on the item are allowed. 

Policy Policy attributes allow the item to contain policy information. 

Make This indicates the presence of a product structure for this item which can be used 

during the assembly, manufacturing, or delivery process. Only items with structures 

can be produced. 

No discount This attribute allows or prevents sales pricelists to be entered for this item, and 

allows or prevents a discount on the item when entering a sales transaction. 

Explode If the item has the Make attribute selected, the Explode attribute allows you to print 

a detailed delivery note to send with the shipment. This attribute also activates the 

ability to add conditions to the delivery of the item. The individual parts and delivery 

conditions for the item can be registered in the bill of materials. When the Explode 

attribute is selected, the Make attribute is mandatory. 

Batch This identifies the item as a batch Item. Batch numbers are unique numbers. 

Text Use the Text attribute for items that require additional text next to the item 

description or an item description longer than the standard item description field. 

The text will be displayed on quotations, orders, and invoices, and can be modified 

during the creation of a quotation, an order, or, an invoice on a case-by-case basis. 

The Sales attribute is mandatory if the Text attribute is selected. 

Service Select this attribute if the item is a service item. 
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4.8 PROCESSES: BACKGROUND 

Various background jobs can be executed to automate certain tasks in Exact Synergy Enterprise. You 

can view all the available background processes, the recent start dates of the background processes 

and whether the background processes are mandatory at Modules → System → Setup → Database → 

Set up company under the Processes: Background section. 

 

For more information on how to configure and run the background jobs, see Chapter 5 Background 

Jobs Configuration. 
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5. BACKGROUND JOBS 

CONFIGURATION  

With every installation of Exact Synergy Enterprise, there are a number of background jobs available 

that perform specific tasks on the database. This section describes the various background jobs that 

are included with Exact Synergy Enterprise. 

Conventions: 

Throughout this chapter, the command syntax of each background job is explained using the following 

conventions: 

• Parameters enclosed within square brackets ([ and ]) are optional. 

• The chevrons (< and >) signifies that you need to replace the text (including the chevrons) with 

appropriate values. 

• The command-line parameters are case sensitive. 
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5.1 CONFIGURING BACKGROUND JOBS 

The background jobs are executed by command and parameters. Therefore, the jobs can be scheduled 

using the Microsoft SQL Server Agent or Microsoft Windows Task Scheduler. 

 

5.1.1 Requirements to run background jobs 

The following must be observed in order to successfully run the background jobs: 

• A Microsoft Windows user that is part of the Administrator group should be present in Exact Synergy 

Enterprise. This user will be responsible for running the background jobs because some background 

jobs will interact with the domain controller, the Microsoft Exchange server and of course with Exact 

Synergy Enterprise. The user needs enough rights on the Microsoft Windows level and the 

Administrator role in Exact Synergy Enterprise. 

• The Microsoft Windows user name should be equal to the user ID in Exact Synergy Enterprise. 

• The Microsoft SQL Server Agent service or the Microsoft Windows task scheduler can be used to 

run the background jobs. The service or task should be started by the user as described above. 

• The user starting up the Microsoft SQL Server Agent service should have a Microsoft Outlook 

Express profile. Although Microsoft Outlook Express is not used for sending out e-mails, it is 

important to create this profile. The information entered is not important. 

• It is important to be logged on as the user that starts the background jobs when creating the profile. 
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5.1.2 Main process to run background jobs 

Exact Synergy Enterprise uses only one executable file, Exact.Process.exe, to run all the background 

jobs. The different background jobs are the Dynamic-link Library (DLL) files that are called by the 

Exact.Process.exe via parameters. 

The following summarizes the general command syntax with the three main parameters: 

 

The following is an example of the command to run a background indexing of Exact Synergy 

Enterprise documents: 

 

Apart from these generic parameters, each job may have specific parameters controlling the behavior. 
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5.1.3 Background jobs available 

The following table summarizes the available background jobs: 

Assembly Functions 

Exact.Jobs.SysMaint • Updates status of employees from Hired to Active and from Active 

to Inactive based on start and exit dates. 

• Creates Windows user account for new employees. 

• Informs managers or account managers of resellers on the user 

account and password through Task. 

• Creates documents for the manager of new employees, and informs 

them of the new ID. 

• Deletes Windows user accounts of inactive employee. 

• Updates the absence field in the humres table to indicate whether 

the employee is in or out of the office for the day. 

Exact.WordIndex • Updates the index tables in order to make use of the Enterprise 

search mechanism. 

Exact.Jobs.SysHrMail • Sends out e-mails for mail merge purposes. 

• Merges and creates requests. 

• Customers/Logistics batch update. 

• Cleans up the Not validated accounts. 

• Exports the HRM, Customers, and Financial reports to Microsoft 

Excel. 

Exact.Jobs.CRM • Validates and checks account statuses (non-validated, prospects 

and customers) based on sales forecasts and contracts. 

• Evaluates account ratings based on their contract values (for 

customers and resellers only). 

• Updates all databases defined in Exact Synergy Enterprise 

Customers from the central database. 

• Updates all licenses. 

Exact.Jobs.Documents • Recalculates all document counts and removes the New indication 

when using the summary views of Documents. 

• Calculates all existing document references for pictures. 

• Removes all the expired documents based on document expiry 

dates. 

• Removes all pictures in the database that are not used by any 

document. 

• Updates the documents versions. When a version is added for a 

specific document, this parameter will ensure that the new version is 

set to Active. 

Exact.Jobs.SysLogTool • Reduces the size of the database by deleting the old log entries at 

Modules → System → Reports → Log → Processes. 

Exact.Jobs.ConProcess • Processes contracts. 

Exact.Jobs.FinExchange • Imports financial entries automatically. 

Exact.Jobs.FinCheck • Compares financial figures with Exact Globe Next administration. 

Exact.Jobs.FinPending • Validates imported financial transactions. 
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Exact.Jobs.FinExcel • Imports transactions via Microsoft Excel. 

Exact.Jobs.SysExchange • Synchronizes appointments between Microsoft Outlook and Exact 

Synergy Enterprise Calendar. 

Exact.Jobs.Workspaces • Generate thumbnails for workspaces. 
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5.1.4 IFilters for indexing document attachments 

An IFilter is plug-in application that allows the indexing of contents in a file of a specific format. In order 

to index attachments in Exact Synergy Enterprise documents, you need the appropriate IFilter. For 

every extension, an IFilter should be installed on the server on which the full text background job is 

started. For more information about IFilters, see http://www.ifilter.org/ and 

http://msdn2.microsoft.com/en-us/library/ ms691105.aspx. 

 

Installation of Microsoft Office IFilters 

Microsoft Office IFilters is installed by default when you install one of the Microsoft Office applications 

like Microsoft Word, Microsoft Excel, or Microsoft PowerPoint. The Exact.Jobs.SysHrMail background 

job requires Microsoft Excel to create exports in the Microsoft Excel format. If this job is configured with 

Microsoft Excel, the IFilters will be available for the full text background process. 

 

Installation of PDF IFilters 

IFilters for the PDF format can be downloaded from the Adobe web site. Currently, Adobe has only 

IFilters available for 32-bit systems. If you require PDF IFilter for a 64-bit environment, you can get the 

PDF IFilter from Foxit at http://www.foxitsoftware.com/pdf/ifilter/. 

For the PDF IFilter, a path setting to the installation directory of Adobe or Foxit is needed. 

 

To configure path settings: 

1. Go to Start → Control Panel → System and Security, and then click System. 

2. In the left pane, select Advanced system settings.  

3. Under the Advanced tab, click Environment Variables. 

4. Under System variables, select Path in the Variable column, and then click Edit. 

5. Add the path at the end of the value at Variable value and click OK. 

6. Click OK on the Environment Variables page. 

7. Click OK on the System Properties page. 

Note:  

The steps above are based on Windows 7. 

 

http://msdn2.microsoft.com/en-us/library/
http://www.foxitsoftware.com/pdf/ifilter/
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5.1.5 Troubleshooting background jobs 

After setting up the background jobs, they should be tested. The first check is to start the jobs one by 

one and watch the job history of the Microsoft SQL Server Agent. The second most important check is 

to verify in Exact Synergy Enterprise whether errors were logged during execution of the jobs. To do 

this, go to Modules → System → Reports → Log → Processes where you can check whether the jobs 

have been executed properly. 
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5.2 RUNNING BACKGROUND JOBS 

Background job assemblies are the Dynamic-link Library (DLL) files that are called assemblies. In these 

assemblies are the specific functions that perform the background jobs. In order to execute these 

functions, you will need to call them using Exact.Process.exe, specifying the assembly and the 

function in the assembly. Some assemblies also support extra parameters. The functionalities of the 

assemblies, the class functions, and the parameters are described in detail in the following topics. 
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5.2.1 Exact.Jobs.SysMaint 

In Exact Synergy Enterprise, there are a number of HRM processes which can be automated using a 

background job. This background job performs the following functions: 

1. Edits details of people, financial components, and item details based on the start date and end date 

of employment: 

• Sets all statuses for people from Hired to Active on the day they begin working. 

• Sets all statuses for the people from Active to Exit on the day they stop working. 

• Sets the end date of financial components for people leaving the company. If the end date of the 

employment contract is defined, the end date of the financial component will be the end date of 

the contract. Otherwise, it will be the end date of the employment. 

• Reassigns the subordinates of people leaving the company to his or her manager. A task will be 

created for the manager informing him or her of the transfer of subordinates. 

• Reassigns the accounts, projects, and items of people leaving the company to his or her 

manager. A task will be created for the manager informing him or her of the transfer of 

responsibilities. 

• Removes all people leaving the company from projects in the Active or Proposed status, in 

which they are involved in. 

• Removes all people leaving the company as assistants to other people with the Active status. 

• Sets the status for people leaving the company to Blocked, denying him or her access to Exact 

Synergy Enterprise. 

• Removes all roles for people leaving the company. 

2. Creates or deletes Windows user accounts: 

• Creates Windows domain user accounts for people with the Active status of types Employee, 

Contractor, Student, and Temporary, who do not have Windows domain user accounts. 

• For new users, this background job fills in the Windows user profile with user details defined in 

Exact Synergy Enterprise. For existing users, this background job updates the Windows user 

profile with any updated information. Two important points must be taken into account 

concerning this functionality: 

o Windows user profiles are only available for environments using Active Directory Services 

and when the create Exchange Mailbox check box is selected (Modules → HRM → 

Setup → General → Settings). 

o The user profiles are only defined for people, not for the resellers. 

• Deletes Windows domain user accounts for all people leaving the company. Sets Microsoft 

Exchange mailboxes to inactive if it is set up to do so. 

• Creates Windows domain user accounts for reseller contacts without a Windows domain 

account. 

• Deletes Windows domain user accounts for all discontinued reseller contacts. 

• Creates Windows domain user accounts for customers that have been granted access to the 

customer portal. 

• Regenerates passwords for customers, in situations where they have forgotten the original 

password. 

• Deletes Windows domain user accounts for customers that have had their access to the 

customer portal revoked. 

• Creates a task informing the appropriate person of new and deleted accounts. For people, this 

person is the manager of the new person or the person leaving the company. For resellers, the 

person informed is the account manager if the new user is the main contact of the reseller. If the 

new user is not the main contact of the reseller, then the task is created for the main contact of 

the reseller. 
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3. Creates vacancies: 

• Creates a vacancy request automatically when a vacancy is created. 

• Vacancy request is approved. 

• The Exact.Jobs.SysMaint.dll background job takes place and the vacancy status is set to 

Approved. 

4. Allows new users remote access via VPN (Virtual Private Network) if the option is enabled in the 

HRM settings. 

5. Updates the absent flag in the humres table. This status indicates whether the user is out of office. 

6. Closes the HR periods and generates entitlements when this function is set in Exact Synergy 

Enterprise. 

7. Creates FTP directories for customers and resellers if the use Active Directory check box is 

selected at Domain: New – Customer (Pre-Win2000) and Domain: New – Partner (Pre-

Win2000) under the Server section on the HRM: Settings page. 

8. Adds or removes the members of a certain Exact Synergy Enterprise role to or from a certain 

Windows domain group. This option is applicable only where a group is assigned with any Exact 

Synergy Enterprise access role. There are three main tasks that are executed by 

Exact.Jobs.SysMaint based on the following sequence: 

• /FTP — This command is used to create the FTP folder.  

• /GMDomain — This command is used to create the Synergy domain group.  

• /NT — This command is used to create a normal task. 

Note:  

Each of the main tasks must be scheduled separately. 

9. When you run Exact.Jobs.SysMaint, the system will create NT user accounts for the people. The 

user account properties will not have the Email Addresses, Exchange General, Exchange 

Features, and Exchange Advanced tabs. 

10. The following properties will be created for resellers or customers with NT accounts: 

• SetUserPassword — This property is used to generate a new password. 

• NewUserDE.Properties("displayName").Value = sAccountName — This property refers to the 

display name. 

• NewUserDE.Properties("sAMAccountName").Value = sLoginName — This property refers to the 

user login name. 

• NewUserDE.Properties("userPrincipalName").Value = FullLogonName(oNewUserDE.Path, 

sLoginName) — This property refers to the principal name of the user (an alternative name for 

the user to log in). 
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Note:  

The NT account creation is only applicable for first time creation. Subsequently, there will not be 

any updates to the fields (no synchronization). 

 

Technical information 

The following tables are involved when running Exact.Jobs.SysMaint: 

• humres 

• Absences 

• RequestTasks 

• AbsenceTypes 

• BacoProcessLog 

• cicmpy 

• cicntp 

When running Exact.Jobs.SysMaint, the background job will first check the statuses, start dates, 

contract end dates, and inactive dates of all employees. When values are defined in these fields, 

appropriate actions will be taken. For example, when an employee starts working today, the job will 

change the status of the employee from Hired to Active. A Windows account will also be created for 

this employee. Where this account is created depends on the settings which can be set up via Modules 

→ HRM → Setup → General → Settings. The password will be generated in a task for the manager of 

the employee. 

After checking the details of the employees, the background job will then check whether there are 

accounts that have been granted portal access and whether there are contact persons of resellers that 

have been granted portal access. If there are such accounts, the background job will generate a 

username and a password for these new accounts. The Windows accounts will also be created in the 

domain specified via Modules → HRM → Setup → General → Settings. 

In the case of giving portal access for customers, a task is created for the account manager with login 

details. An e-mail will be sent to the e-mail address of that account containing the login details. For 

resellers, the same applies but the first portal access is given to the main contact person. In the initial 

stage, a task is created for the account manager and an e-mail is sent to the main contact. After this, 

the main contact person is responsible for giving portal access to his colleagues. 

After giving portal access to the accounts, the background job checks whether there are employees 

absent. This is done based on the Out of office setting in the request definition. Based on this, the 

background job searches for employees who are absent with this setting turned on. Then it checks the 

date in the requests and compares them with the current date. When these two dates match, the status 

for the employees is set to Out of office. 

 



CHAPTER 5 | BACKGROUND JOBS CONFIGURATION 

295 

 

Command syntax 

The following is the command syntax for Exact.Jobs.SysMaint: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.SysMaint/CLASS:SysMaint/DBCONFIG: 

<database>[/NT][/NOPDC][/FTPR:<directory>][/FTPC:<directory>][/FTPDIV:<#1;...;#n>] 

[/FTPEXP:<days>] 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

/NT Executes normal tasks (creates or updates NT accounts, reassigns 

subordinates). 

/NOPDC Creates or deletes Windows user accounts when there is no Primary 

Domain Controller in the HRM settings. 

/NOEMPACCOUNT Updates the Windows user accounts status for Hired or Exit employees 

but not Active employees. 

/FTPR:<directory> Reseller contact person root directory on the FTP server. 

/FTPC:<directory> Customer root directory on the FTP server. 

/FTPDIV:<#1;#2;...;#n> List of division codes to which the customers or resellers belong, each 

separated by a semi colon. 

/FTPEXP:<days> Number of days after which the content of the FTP directory expires. 

/IGNOREBLOCKED Lists the active users (hired people and active employees) with the 

Blocked status. 

/L Updates the LogonScript property of the NT account for a new recruit 

with the name specified after the /L parameter (for example, 

/L:ADCLogonScript.bat). 

/RAS Grants all new employees the remote access permission (Dial-in or VPN) 

only if Active Directory is used. 

/IM Grants all new employees the right to use the primary Instant Messaging 

Server on the Active Directory domain. 

/GMDomain Refers to the domain server name. 

/GMRole Adds or removes the members of a certain Exact Synergy Enterprise role 

to or from a certain NT domain group. The value(s) of this parameter have 

to be equal to the ID(s) of the role(s). 

/E Refers to the FQDN (Fully Qualified Domain Name) of the Microsoft 

Exchange Server 2010. 

/ESEURL Refers to the URL for Exact Synergy Enterprise. 

/MAILBOXDATABASE Defines the mailbox database name, which can be included in the 

command line to force the background job to create mailboxes 

automatically. Use this only if there is a failure in creating mailboxes (with 

errors) when running the background job. 
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System settings 

The relevant settings in Exact Synergy Enterprise can be accessed at Modules → HRM → Setup → 

General → Settings. 

 

The settings in the Server and Absence sections determine how and where new employee entries are 

created and also where accounts for customers and resellers are created if given portal access. When 

portal access is given, you can also determine which type of request is created for the account manager 

and you can make the relevant adjustments in the e-mail that is sent to the account. 

 

Reports and troubleshooting 

To verify in Exact Synergy Enterprise whether errors were logged during execution of the jobs, go to 

Modules → System → Reports → Log → Processes where you can check whether the jobs have been 

executed properly. 
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5.2.2 Exact.WordIndex 

Enterprise search is an advanced functionality that allows you to rate content that is stored in 

requests, documents, and document attachments. The following are some examples of how content is 

rated based on the criteria defined: 

• The number of times the search term exists in the requests, documents, or attachments. 

• The number of times the documents are referenced to. 

• The number of references that exist to other information carriers. 

The extensions of attachments that can be searched on content-wise are “.doc”, “.docx”, “.ppt”, “pptx”, 

and “.pdf”. Apart from relevance ranking, the Enterprise search functionality also incorporates: 

• Synonym search — This is based on a self-defined list of synonym words that are linked to each 

other. For example, if “proposal” = “quotation”, searching for the term “proposal” will in this case also 

provide you information where “quotation” is used. 

• Do you mean — Whenever the search term is wrongly spelt, the system will look for better 

alternatives in the database and propose this as the term to use. For example, searching for 

“qoutation” will result in the system proposing “quotation” instead. 

• Expertise search — When using the people search field, you can search for a person and the 

documents that this particular person has written. For example, searching for “SQL 2005” will give 

you a list of the relevant people that have written on this topic. 

There can be many requests in an implementation, but what is important is that the Exact.WordIndex 

process is performed in the most efficient manner. 

This document will describe the steps that should be taken to get populated full text tables for the 

search engine. Two background jobs should be created, one to index the documents, requests, and 

attachments and another to optimize and enable the Do you mean functionality. 

 

Technical information 

The following tables are involved in the Enterprise search functionality: 

• Words 

• WordReferences 

• WordSynonyms 

In the first two tables, the words are linked to the GUIDs of the documents, document attachments, and 

requests in which they are found, including the data used for calculating the relevance. When a user 

searches for certain words in Exact Synergy Enterprise, the words are checked in the tables mentioned 

and the results are shown to the user. The WordSynonyms table stores the user-defined synonyms, 

which are defined at Modules → System → Setup → Full-text index → Synonyms. 

In addition, an entry is made in the BacoSettings table after each run, which states when the job was 

last executed. When the job is executed again, it will not index documents that were created or last 

modified before that time. It will only index documents that are created or last modified after that time. 
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Command syntax 

The following is the command syntax for Exact.WordIndex: 

Exact.Process.exe/ASSEMBLY:Exact.WordIndex/CLASS:IndexDocuments/DBCONFIG:<databas

e> [/Filter:<value>] [/ Selection:<n>] [/TimeStampSetting:<name>] [/MaxEntities:<n>] 

[/MaxMinutes:<n>] [/Abort:1] [/Descending] [/ CacheWords] [/Bulk] 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

/Filter:<value> The filter can be used to index a specific set of entities. For example, 

<value> can be: “bd.ModifiedDate>2004-01-01” 

“Absences.HID=45662”. 

/Selection:<n> The entities are always processed in the order of timestamps where 

<n> is: 

• 0 - Process will continue from where it has last finished. 

• 1 - All entities will be processed. 

The timestamp of the last processed entity is by default, stored in the 

FullTextDocTimestamp setting. A different setting name can be 

specified with /TimeStampSetting. 

/TimeStampSetting:<name> Use this option to specify a setting name that will be used to save the 

timestamp of the last processed entity. This option is very useful if you 

want to run more instances of the process. Every instance can process 

a different range (use /Filter) and save the state as a different setting. 

/MaxExtities:<n> Specifies to process <n> number of entities. 

/MaxMinutes:<n> Specifies the process to execute <n> number of minutes and terminate 

after the time has elapsed. The program might run a bit longer than 

specified, in order to complete all insert and update queues. 

/Abort:1 Aborts all the running instance of this job for this database. 

/Descending Specifies that the entities must be processed in descending order. 

/CacheWords Cache all existing words. Caching will speed up the process only if a 

lot of entities must be processed. Do not use this if there are only a few 

entities to process. New words are not dynamically added to the 

cache. Therefore, when you are starting to build the index, it is better 

to stop the process after some entities (for example, 1,000) are done, 

and then restart the process to cache the words that are just inserted. 

/Bulk Enables “bulk inserts”. This method might speed up the process 

because it decreases the number of roundtrips to the database server. 

 

System settings 

There are no specific system settings required. 
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Reports and troubleshooting 

To verify in Exact Synergy Enterprise whether errors were logged during execution of the jobs, go to 

Modules → System → Reports → Log → Processes where you can check whether the jobs have been 

executed properly. 
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5.2.3 Exact.Jobs.SysHrMail 

The Exact.Jobs.SysHrMail background job performs several tasks: 

• Marketing — This allows you to update some fields of all the accounts found based on the search 

criteria. This functionality is available via Modules → CRM → Reports → Accounts → Search and 

can only be used to update fields of accounts and contact persons. 

• Export — This allows you to export the search results to a Microsoft Excel sheet. After indicating the 

information that you want exported to the Microsoft Excel sheet, you can create the task for 

Exact.Jobs. SysHrMail. After running the background job, a task will be created with the Microsoft 

Excel sheet attached. 

• Mail Merge — This sends an e-mail to all accounts or people listed in the search results. You can 

prepare a mail merge layout with Baco tags and a predefined text. After running the background job, 

that document will be sent to all accounts or people listed in the search results. 

• Request — With this function, you can create a request for every person listed or with every 

account listed as the linked account in the request. This is an easy way to create multiple requests 

for people and accounts. 

• Cleaning up of accounts — This removes non-validated accounts that fall within the criteria 

defined. 

• Deduplication — The background job either generates a preview of duplicate accounts to be 

merged or physically merge the duplicate accounts and its contacts together. A Microsoft Excel 

report is generated for each deduplication task - preview or actual merge. The duplicate accounts 

will be merged based on the merge settings which are set by the user. 

 

Technical information 

The following tables are involved when running Exact.Jobs.SysHrMail: 

• MailMergePending 

• BacoAppLog 

When setting up the mail merge, all information will be entered in MailMergePending. The status of the 

mail merge is also stored in this table with the value “0”, which indicates that the mail merge still has to 

be executed and the value “1”, which indicates that the mail merge task has been processed. The data 

that will be sent is also stored in the table via a SQL query. 

When the job is running, it will check MailMergePending for new tasks and performs the tasks listed as 

“to do”. After processing the tasks, the status is changed to “1” and the log entries are entered in 

BacoProcessLog. In MailMergePending, you can check which type of report has been processed or 

is going to be processed based on the “report type”. There are seven possible values for this field: 

• R — Mail merge using HRM (people) data. 

• C — Mail merge using Customers (accounts) data. 

• CNT — Mail merge using the data of contact persons. The e-mails are sent to all contact persons of 

the specified account. 

• XR — Microsoft Excel export for HRM (people) data or other types of Exact Synergy Enterprise data 

using a DLL to create the query or validation. 

• XC — Microsoft Excel export for Customers data or any other types of Exact Synergy Enterprise 

data that inserts a SQL query into MailMergePending (without separate DLL). 

• XF — Microsoft Excel export for financial data. 

• OPT — Microsoft Excel export for people options data. 
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Command syntax 

The following is the command syntax for Exact.Jobs.SysHrMail: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.SysHrMail/CLASS:SysHrMail /DBCONFIG:<database> 

[/X:<option>] 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

/X:<option> Performs only the job where <option> is: 

• XCT — Only processes Microsoft Excel contract exports. 

• XP — Only processes Microsoft Excel procurement exports. 

• XF — Only processes Microsoft Excel financials exports. 

• OPT — Only processes Microsoft Excel exports for the HRM option 

transactions. 

• BC — Only processes Microsoft Excel exports for the Customers 

batch updates. 

• BL — Only processes Microsoft Excel exports for the Logistics batch 

item updates. 

• CL — Only clears up non-validated accounts. 

• BA — Performs the deduplication process. 

If /X is not defined, the job will execute all process steps except the CL 

option. 

 

System settings 

In order to run this background job properly, two important points need to be taken into consideration on 

the server where this job is executed: 

• Microsoft Excel must be installed. The administrator who runs the Microsoft SQL Server Agent 

needs to have started Microsoft Excel at least once because only then will a profile be created for 

the administrator. 

• Microsoft Outlook Express must be installed on the server with an account defined for the user or 

administrator who runs the Microsoft SQL Server Agent. For this account, it is important that sending 

mail is possible while receiving mail is less important. 

The most important setting in Exact Synergy Enterprise for running Exact.Jobs.SysHrMail can be 

found at Modules → HRM → Setup → General → Settings. 
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The Server and Port fields determine where the e-mails are sent to. Exact Synergy Enterprise is not a 

mail server and therefore requires a mail server, for example from the ISP or software like Microsoft 

Exchange, to get e-mails to their destination. 

At Server, enter the name or IP address from the Microsoft Exchange server or the address of the mail 

server. The standard port for SMTP is “25”. However, this can change based on the settings of the mail 

server. When these settings are not filled in correctly or not left blank, Exact.Jobs.SysHrMail will not 

be able to send e-mails or perform exports to Microsoft Excel. 

You can also set up where the documents resulting from a Microsoft Excel export are created in Exact 

Synergy Enterprise. You can access this at Modules → System → Setup → Settings - General → 

Processes. You can set a default main category, category, or subcategory for all types of Microsoft 

Excel exports. 

For the deduplication process, the merge settings can be defined at Modules → Customers → Reports 

→ Quality analysis → Deduplication where you can define the master settings, merge selection criteria, 

account merge conditions, and contact merge conditions. 

 

Reports and troubleshooting 

When running Exact.Jobs.SysHrMail, the job will enter log entries which can be viewed at Modules → 

System → Reports → Log → Processes. There are a few error messages which are known to be 

displayed in Exact Synergy Enterprise. These are due to wrong settings either in Exact Synergy 

Enterprise or on the server itself. The following describes the error messages and solutions. 

 

Permission denied 

This may be displayed when the application is unable to take control of a Microsoft Excel application 

instance it has created to perform Microsoft Excel exports for HRM or Financial. If you encounter this 

error, please check the DCOM security settings for the Microsoft Excel application object. This can be 

done by running DCOMCNFG from Run in the Start menu, selecting the Microsoft Excel application 

object, viewing its properties, and checking the rights under the Security tab. 

 

Permission error when performing single mail merge 

In order to merge images when performing a single mail merge, a “TempImages” folder will be created 

to temporarily store all images used during the single mail merge operation for all users. To ensure that 

you will not encounter the error message for permission rights during the single mail merge action, the 

following must be carried out: 

• Rights to Microsoft Windows “temp” directory in C:\ is set for all users. 

• “TempImages” folder in C:\windows\temp is empty. Images in this folder will be deleted whenever 

the next user performs a single mail merge. 

 

Application-defined or object-defined error or Object variable or with block variable not set 

This error message may be displayed when the user running the Microsoft SQL Server Agent is not a 

domain administrator or a local administrator. The user running the Microsoft SQL Server Agent must 

be a valid user in the Exact Synergy Enterprise database with the Administrator role and have 

administrative rights on the server or in the domain. 
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Error at create report, report name ClassesGroupsActuals, type (Financial Excel Export), creator 

id (ServiceSQL0001). Error description – ActiveX component can’t create object 

This error message may be displayed when the file ClassesGroupsActuals.xls is not found in the rep 

subfolder of the folder where Exact Synergy Enterprise is installed. If the file is not there, create an 

empty Microsoft Excel sheet with the name. 
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5.2.4 Exact.Jobs.CRM 

Exact.Jobs.CRM can perform three functions using the following classes: 

• AccountStatus 

• CRMRating 

• updateaccountdatabases 

You can run all these functions in separate instances. As you can also specify the range for 

updateaccountdatabase, for example, you can run the job on separate account code ranges at the 

same time. 

 

AccountStatus 

This class has two main processes: 

• Forecasts process — Associate or Not Validated accounts with Sales Forecast requests, as well 

as inactive Associate or Prospect accounts linked with non-expired Sales Forecast requests in the 

Open or Approved statuses, are converted to Prospect accounts with the Active status. On the 

other hand, Prospect accounts without any Sales Forecast request are changed to Not Validated 

accounts. 

• Contracts process — Prospect, Associates, Not Validated, and Customer accounts with active 

contracts are set as type Customer. In this case, those with active service items are set to the 

Active status while those without active service items are set to the Passive status. On the other 

hand, if a Customer account does not have any active contracts, the account is set to the Inactive 

status. 

 

CRMRating 

Based on the totals of items and service values of each Customer or Reseller account (except those in 

the Exit status) and all its subsidiaries, CRMRating calculates the combined contract value and gives a 

rating from “1” (highest) to “7” (lowest) to the account based on Exact Synergy Enterprise rating rules. 

 

updateaccountdatabases 

This is only applicable in an Active Service Provider (ASP) model where there is one central company-

wide Exact Synergy Enterprise database for the ASP and separate databases for one or more 

customers of the ASP. The function of this class is to update the customer databases as necessary. 

 

Technical information 

The following tables are involved when running the AccountStatus or CRMRating classes of 

Exact.Jobs.CRM: 

• cicmpy — Accounts 

• Items — Items 

• ItemNumbers — Contracts 

• BacoSettings — Last Run date (AccountStatus) or CRMRatingLastRun (CRMRating) 

• RatingAmounts — Rating rules (CRMRating only) 

• RequestTypes — Request types (AccountStatus only) 

• Requests — Requests (AccountStatus only) 
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AccountStatus 

The following is the flow of the Forecasts process: 

• First, it checks Associate and Not Validated accounts for linked Sales Forecast requests. If there 

are Sales Forecast requests linked and all mandatory fields of the account are filled, the account is 

set as a Prospect account with the Active status. 

• After the first check is completed, it checks for Prospect accounts without any Sales Forecast 

requests linked and changes the account type to Not Validated with the Not Validated status. 

• Then, in the third run, it checks for Prospect and Associate accounts that are not in the Active 

status but linked with active Sales Forecast requests that are in the Open or Approved status. For 

these accounts, if the mandatory account fields are filled, the accounts will be changed to type 

Prospect with the Active status. 

The following is the flow of the Contracts process: 

• First, it checks Prospect, Associates, and Not Validated accounts linked to contracts. For these 

accounts where the contracts are not active, the accounts are changed to type Customer with the 

Inactive status. If the contracts are active, the accounts are set to type Customer with the Active 

status for contracts with active service items or the Passive status if not. 

• Then, in the second run, it checks Customer accounts for the same conditions and applies the 

same rules. 

 

Updateaccountdatabases 

When Exact Synergy Enterprise is updated, the central database must first be updated. Then, all the 

customer databases must be updated. This can be done by going into Exact Synergy Enterprise 

environment for all these databases. Another option is to use the updateaccountdatabases class of 

Exact.Jobs.CRM. 

For the updateaccountdatabases class, Exact.Jobs.CRM will go through all accounts in the central 

Exact Synergy Enterprise database for each account where a database is defined. The versions of 

these databases are then compared with the version of the installed Exact Synergy Enterprise and 

updated if necessary. 
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Command syntax 

The following is the command syntax for Exact.Jobs.CRM: 

Exact.Process.exe/ASSEMBLY:Exact.WordIndex/DBCONFIG:<database>/CLASS:<function> 

[/M:1] [/AC1:<start>] [/AC2:<end>] [/LIC:<path>] 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

/CLASS:<function> Specifies the job function to perform where <function> is: 

• AccountStatus 

• CRMRating 

• updateaccountdatabases 

/M:1 If specified, this runs the Contracts and Forecasts processes for the 

AccountStatus class. Otherwise, it runs only the Forecasts process. 

Applicable only when /CLASS is AccountStatus. 

/AC1:<start> Specifies the start of the account codes range to update, including 

<start>. This can be used with /AC2. If used alone, all accounts with 

codes equal to or greater than <start> will be updated. If both /AC1 and 

/AC2 are not specified, all accounts will be updated.Applicable only 

when /CLASS is updateaccountdatabases. 

/AC2:<end> Specifies the end of the account codes range to update, including <end>. 

This can be used with /AC1. If used alone, all accounts with codes 

smaller than or equal to <end> will be updated. If both /AC1 and /AC2 are 

not specified, all accounts will be updated. Applicable only when /CLASS 

is updateaccountdatabases. 

/LIC:<path> Specifies the path and filename of the license file (for example, 

“C:\Lic\NewLic.elc”) to apply to customers database after updating. 

Applicable only when /CLASS is updateaccountdatabases. 

 

System settings 

In order for proper operation of CRMRating, each rating must have an amount range linked to it. The 

rating rules for Customer and Reseller can be defined at Modules → Marketing → Setup → Rating: 

Rule. It is advisable to schedule CRMRating once a day at a less busy time. The application can only 

be executed by users with function right 337 - Allows to execute background rating application. 

Users with the Administrator role have this function right. 

 

Reports and troubleshooting 

To verify in Exact Synergy Enterprise whether errors were logged during execution of the jobs, go to 

Modules → System → Reports → Log → Processes where you can check whether the jobs have been 

executed properly. 
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5.2.5 Exact.Jobs.Documents 

Exact.Jobs.Documents is a background job which performs four basic functions: 

• If you upload a document with pictures into Exact Synergy Enterprise, the pictures in that document 

are also saved in the database. When you delete the document, the pictures remain in the database 

but there are no links to them. When this background job runs, it checks for pictures that are not 

linked to any document and deletes those pictures. This will ensure the database is not using too 

much disk space. 

• At Modules → Documents → Reports → Statistics, you can view different overviews related to the 

documents in your database. For example, you can view the number of documents that are linked to 

the main categories. These overviews are updated every time the background job runs. 

• When creating a document, you can enter a date after which the document expires. When the 

background job runs, it deletes all expired documents. 

• The background job updates active document versions. When a new version is created for a certain 

document, this new version needs to be activated. This can be done manually by the creator or the 

administrator. It can also be done automatically by the background job. 

 

Technical information 

The following tables are involved when running the Documents background job: 

• BacoDiscussions — Documents 

• BacoDiscussionCounts — Counts new documents 

• BDPictureRefs — Links between documents and pictures 

• BacoDiscussionPictures — Pictures 

 

Command syntax 

The following is the command syntax for Exact.Jobs.Documents: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.Documents/CLASS:DocScheduler/DBCONFIG: 

<database> /C:<option> 

Command 

syntax 

Description 

/DBCONFIG: 

<database> 

The virtual directory of the database as in the db.config file. Take note that the 

name of the virtual directory is case-sensitive. 

/C:<option> Specifies the job to perform where <option> is: 

• Counter — Recalculates all document counts and removes the “New” indicator 

displayed in summary view of documents. 

• DelExpiryDoc — Removes documents based on document expiry date. 

• Picture — Removes pictures that are not used by any document. 

• FillPicture — Calculates all existing document references to pictures. This 

action is also executed when the Picture option is used but only for pictures 

where the BDPictureFilled value is “N”. 

• DocVersions — Updates the document versions and set the new version to 

“active” when versioning is added for a specific document. 
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Note:  

You can only add one specific /C parameter. Add a separate scheduled job for each parameter 

option you want to execute. 

 

System settings 

To let the background job delete documents which have expired, you need to specify a date at the 

Deletion date field in the document properties while editing the document. 

In order to make full use of the document version parameter, the version control functionality needs to 

be used in Exact Synergy Enterprise. Version control can be activated in a document type at Modules 

→ Documents → Setup → Maintenance → Document: Types. 

 

Reports and troubleshooting 

To verify in Exact Synergy Enterprise whether errors were logged during execution of the jobs, go to 

Modules → System → Reports → Log → Processes where you can check whether the jobs have been 

executed properly. 

When checking those entries, you may see the following messages: 

 

Exact.Jobs.Documents is designed to start deleting pictures only when there are more than 1,000 

pictures. If there are less than 1,000 pictures, the pictures are not deleted. 
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5.2.6 Exact.Jobs.SysLogTool 

The Exact.Jobs.SysLogTool background job is responsible for truncating the log entries that have 

been made while using Exact Synergy Enterprise. 

Every action from every user results in log entries being made in the database. Over time, this can 

result in a huge database where most of the size is due to log entries from several years ago. To 

prevent this, Exact.Jobs.SysLogTool can be used to reduce the size of the database by deleting old 

log entries. Apart from cleaning up old log entries, the background job also updates the overviews of 

page views for documents and applications. These overviews can be found at Modules → System → 

Reports → Page Views. 

 

Technical information 

The following tables are involved when running Exact.Jobs.SysLogTool: 

• BacoProcessLog 

• BacoAppLogDays 

• BacoAppLogHours 

• BacoAppLogApps 

• BacoAppLog 

• BacoErrorLog 

• EbcDataLog 

• CompanyLogs 

• HRErrorLog 

• XMLEvents 

Exact.Jobs.SysLogTool job checks for all log entries on the day they were created. If the entries were 

created past the number of days set in Exact Synergy Enterprise, the entries will be deleted from the 

table. 

 

Command syntax 

The following is the command syntax for Exact.Jobs.SysLogTool: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.SysLogTool/CLASS:SysLogTool 

/DBCONFIG:<database> 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

 

System settings 

There are no specific system settings required. 

 

Reports and troubleshooting 

To verify in Exact Synergy Enterprise whether errors were logged during execution of the jobs, go to 

Modules → System → Reports → Log → Processes where you can check whether the jobs have been 

executed properly. 
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5.2.7 Exact.Jobs.ConProcess 

In Exact Synergy Enterprise, you are able to create and maintain contracts for your customers. These 

contracts need to be prolonged at one point and doing this manually can be a lot of work. Therefore, a 

background job Exact.Jobs.ConProcess is created. This background job enables you to prolong 

contracts automatically at a certain date. The background job is also able to validate, modify, and 

budget the contract details. 

When you create a contract for a customer, you must enter a prolongation date. This date determines 

when the prolongation of the contract will start. After the creation of the contract, the next thing to do is 

to prolong the contract after some time. At Modules → Customers → Reports → Contracts: 

Prolongation → Processes, you can indicate what the background job should do and which contracts 

should be taken into account. In the page below, you can see the available options. 

 

From the page, you can see the Validation, Modified, and Prolongation buttons. These buttons 

determine what the background job does. 

After entering the necessary information, you will find that an entry has been created. This entry is 

made for the background job. The next time Exact.Jobs.ConProcess runs, dependent on the 

scheduling, it will find the newly created entry and will perform the action requested. 

 

After Exact.Jobs.ConProcess has finished, the status of the entry will change from New to 

Processed. The results can be viewed by clicking on the link in the column type. When a document is 

created, there will also be a link in the Document column. Clicking on that link will show you the 

document with the results of the job. 

 

Technical information 

The following database tables are involved when running Exact.Jobs.ConProcess: 

• ItemProcess — This is where the application looks for jobs and enters the results 

• BacoDiscussions — Document with results 

• Absences 

• RequestTasks 

• ItemNumbers 

• BacoProcessLog — Log entries for background job 

• EbcDataLog — Log entries for changed data 
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Command syntax 

The following is the command syntax for Exact.Jobs.ConProcess: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.ConProcess/CLASS:ConProcess 

/DBCONFIG:<database> 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

 

System settings 

There are a number of settings in Exact Synergy Enterprise which have influence on the way 

Exact.Jobs.ConProcess works. To define the settings, go to Modules → Customers → Reports → 

Contracts: Prolongation → Parameters and click New. 
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From this page, the contract prolongation settings can be entered per division. Apart from the process 

parameters, you need to set up the category which the document with results is created. This can be 

done at Modules → System → Setup → Settings - General → Processes. 

 

By clicking on one of the links in the Type column, you can set up the category in which the documents 

are created. 

 

Reports and troubleshooting 

 

From the page, you see an error message that is given by the Exact.Jobs.ConProcess background 

job. The error occurred because the user who executed the Microsoft SQL Server Agent did not have 

the necessary rights to perform the prolongation. In this case, the user was “Service”, so the error 

message consisted of the username of the user who was running SQL Server Agent. 
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5.2.8 Exact.Jobs.FinExchange 

There are several ways of exchanging data between Exact Globe Next and Exact Synergy Enterprise. 

One of the methods includes a direct database link via a background job. Compared to an XML 

exchange, this job will give you improved performance and basic financial checks. However, you need 

to ensure that the master data between the source system, Exact Globe Next, and the target system, 

Exact Synergy Enterprise, is in sync. Via this background process, financial transactions and related 

documents are exchanged. 

 

Technical information 

The following tables are involved when running the background exchange of data: 

• Financial transactions 

• Related documents 

To keep each of the databases in sync with the other, a timestamp is stored in both the databases, 

indicating the last moment of data exchange. With every run of the background job, this timestamp will 

be updated. During replication, only records which have been modified after this timestamp will be 

exchanged. 

 

Command syntax 

The following is the command syntax for Exact.Jobs.FinExchange: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.FinExchange/CLASS:FinExchange/DBCONFIG:<data

base> /C:<#1,...,#n> /B:<n> [/R:<yyyy>-<p>][/EG:<GUID>] [/BS:<scenario>] 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

/C:<#1,...,#n> Lists the division codes to use for the data exchange. For multiple 

divisions, separate the division codes with commas. 

/B:<n> Indicates whether financial budgets need to be replicated where <n> is: 

• 0 — Budgets will not be replicated. 

• 1 — Budgets are replicated. 

If /B is not specified, option 1 is used. 

/R:<yyyy>-<p> Specifies to re-import a previously imported period where <yyyy> is year 

and <p> is period number (for example, 2007-2). 

/EG:<GUID> Specifies to export one single financial entry based on the entry GUID 

/BS:<scenario> Indicates the budget scenario to be used for replication. 

 

System settings 

There are no specific system settings required. 
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Reports and troubleshooting 

If the process logged in Exact Synergy Enterprise shows that the background job has been executed for 

a specific company but no data was exchanged, it is possible that the timestamps in the different 

databases were not in sync.  

The data exchange takes place based on timestamps. This can be checked via the following SQL query 

on both databases: 
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5.2.9 Exact.Jobs.FinCheck 

The Exact.Jobs.FinCheck background job compares the financial figures in Exact Synergy Enterprise 

with Exact Globe Next back-office administrations. 

 

Technical information 

For each division, the check is done per financial year, financial period, or general ledger account 

against whether the total amount in the division currency in Exact Synergy Enterprise is the same as 

the total amount in the division currency in the back-office administration. 

Note:  

The financial figures mentioned are referring to the processed financial entries only. In other words, 

budgets and unprocessed financial entries are not taken into account. Also, the origin of financial 

figures is not important for the check. It will take into account both the financial entries created in 

Exact Synergy Enterprise and the back-office administration. 

Besides the checks, this application will also give information whether there are still financial entries 

waiting to be replicated from the back-office administration to Exact Synergy Enterprise. 

This job can run automatically in the background on a scheduled basis. After each check, the results, 

success or failure, will be stored in the division log and the detailed information from the check will be 

stored in a newly created document. This document will be stored using the document type (in the 

default category mentioned in the definition of this type) defined in the financial settings for the import of 

documents attached to financial entries. 

When the job runs, it will check the general ledger accounts of the databases belonging to Exact 

Synergy Enterprise and Exact Globe Next. The financial figures are compared and any differences are 

logged. The background job will not correct the differences. The administrator has to do corrections 

instead. 

The following database tables are used: 

• BacoDiscussions — Creating documents with results 

• Grtbk — General ledger accounts 

• XMLTopicHistory — Log with XML replication entries 

• BacoProcessLog — Log with background job entries 

• gbkmut — Financial transactions 

• BacoSettings — Log of last run date 

• CompanyLogs — Log per division) 
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Command syntax 

The following is the command syntax for Exact.Jobs.FinCheck: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.FinCheck/CLASS:FinCheck /DBCONFIG:<database> 

/C:<#1,...,#n> 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

/C:<#1,...,#n> Lists the codes of the divisions to check. For multiple divisions, separate 

the division codes with commas. 

 

System settings 

To run this background job, function right 363 - Allows to import financial entries from Exact Globe 

Next is required. Users with the Administrator role have this function right. The security level of the 

document will be defined by the document type used. 

Before starting this background job, the following must be configured: 

• Modules → HRM → Setup → Organization → Divisions: Select the divisions for which this 

background job must be executed and fill in the back-office details for each of them. 

• Modules → Financial → Setup → General → Settings, under the Import section at Document: 

Type and under the Import: Check section at Document: Deletion date. It is useful to set a 

deletion date for the documents created by the check, so that these documents will be automatically 

deleted. This is done by setting the Document: Deletion date. 

• Make sure that there is a default category configured for the selected document type and that the 

document type configuration should have the value Yes (Optional) for Item, Assortment, Person, 

Account, Project, and Financial. 

 

Reports and troubleshooting 

The results of the financial comparison can be accessed at Modules → Financial → Reports → Analysis 

→ Division: Status. 

• Divisions - Status — This is referring to the data in the Check column. Clicking the date hyperlink 

displays the document with the detailed information. 

• Division log — Click the Log hyperlink in the Action column. Next, select Financial (Check) at 

Source. Clicking the hyperlink in the Remark column displays the document with the detailed 

information. 

• Data management — Click the Management hyperlink in the Action column. 
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5.2.10 Exact.Jobs.FinPending 

The Exact.Jobs.FinPending background job validates and processes financial transactions that are 

imported from Microsoft Excel via the Exact.Jobs.FinExcel background job. This background 

application needs to be executed only when financial data is imported via Microsoft Excel sheets. For 

example, if the financial data is imported on a Friday, the background job needs to be executed only on 

that Friday evening or during the weekend. 

Depending on the frequency of import for these financial transactions, the Exact.Jobs.FinPending 

background job can adhere to the same frequency as Exact.Jobs.FinExcel but after the import is 

completed. 

 

Technical information 

The following tables are involved when running Exact.Jobs.FinPending: 

• TransactionsPending — This is the table where the transactions are located after being imported 

from Microsoft Excel sheets. 

• gbkmut — This is the table where the transactions are located after running. 

Exact.Jobs.FinPending. 

• BacoProcessLog — A log entry is created in this table. 

During the import, the transactions will first be placed in the TransactionsPending table because these 

transactions have the “Unprocessed” status. The Exact.Jobs.FinPending background job will then 

validate these transactions and process them.  

Exact.Jobs.FinPending first checks the TransactionsPending table for transactions that are entered 

manually. Transactions that are imported from Microsoft Excel sheets are also recognized as this. 

These transactions will be compared with the existing transactions in gbkmut, based on EntryNo. If 

there are existing transactions with the same EntryNo, then those transactions will be deleted. 

Subsequently, after the checks have been performed, the imported transactions will be moved from the 

TransactionsPending table to the gbkmut table where all processed transactions are stored. The 

transactions in the TransactionsPending table will be deleted when the move is successful. The 

transactions are then regarded as Processed. 

 

Command syntax 

The following is the command syntax for Exact.Jobs.FinPending: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.FinPending/CLASS:FinPending 

/DBCONFIG:<database> /C:<#1,...,#n> 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

/C:<#1,...,#n> Lists the codes of the divisions to perform this job. For multiple divisions, 

separate the division codes with commas. 

 

System settings 

There are no specific system setting required. However, the background job will only validate 

transactions that are available. 



CHAPTER 5 | BACKGROUND JOBS CONFIGURATION 

318 

 

Reports and troubleshooting 

If you have executed the background job, you may still see many entries available at Modules → 

Financial → Entry → Transactions → Process. Although Exact.Jobs.FinPending can help to process 

valid entries, there are some entries that it cannot process automatically. You will need to complete 

these manually. 
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5.2.11 Exact.Jobs.FinExcel 

There are several ways of exchanging data between Exact Globe Next and Exact Synergy Enterprise. 

One of the means is the import of a Microsoft Excel file which is attached to a document. The imported 

entry can be stored as a budget entry or as an actual financial entry. 

 

Technical information 

Your users can create documents in specific categories and the attachments of these documents can 

be imported as financial entries via this background job. Based on the document type, it can be 

determined whether a budget or actual transaction has been imported.  

The table involved in the creation of entries is gbkmut. 

 

Command syntax 

The following is the command syntax for Exact.Jobs.FinExcel: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.FinExcel/CLASS:FinExcel/DBCONFIG:<database> 

[/C:<#1,...,#n>] 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

/C:<#1,...,#n> Lists the codes of the divisions to execute the import and exclude 

documents of other divisions. For multiple divisions, separate the division 

codes with commas. 

 

System settings 

There is no specific system settings required. 

 

Reports and troubleshooting 

To verify in Exact Synergy Enterprise whether errors were logged during execution of the jobs, go to 

Modules → System → Reports → Log → Processes where you can check whether the jobs have been 

executed properly. 
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5.2.12 Exact.Jobs.SysExchange 

The Exact.Jobs.SysExchange background job allows you to replicate appointments from the calendar 

in Exact Synergy Enterprise to the calendar in Microsoft Outlook and vice versa. 

This means that appointments have to be entered only once, either in Exact Synergy Enterprise or 

Microsoft Outlook, to be registered in both environments. Therefore, when a company is already using 

Microsoft Outlook to register appointments, the replication will ensure that the appointments are shown 

in Exact Synergy Enterprise as well. 

 

Technical information 

Exact.Jobs.SysExchange does not exchange calendar entries with the Microsoft Outlook client but 

with the Microsoft Exchange server.  

Note:  

If you are using Microsoft Exchange Server 2010 or higher, you need to install Exact Exchange 

Integrator to implement the Exchange calendar synchronization. For more information, see 7.8 

Exact Exchange Integrator. 

The following tables are involved when running Exact.Jobs.SysExchange: 

• humres 

• BacoSettings 

• Absences 

When Exact.Jobs.SysExchange is running, it checks the people that have turned on the flag for 

synchronization. This is checked in humres where SynchronizeExchange will indicate whether the 

calendar of the person needs to be synchronized. The value “1” indicates that synchronization needs to 

be carried out while the value “0” indicates that no synchronization is required. In BacoSettings, 

Exact.Jobs.SysExchange checks whether the person has specified additional request types to be 

synchronized with Microsoft Exchange. 

Depending on the direction set for the synchronization, Exact.Jobs.SysExchange will create activities 

in Microsoft Outlook for all selected request types. When the synchronization is done in both directions, 

activities from Microsoft Outlook will be created according to the request types selected in Exact 

Synergy Enterprise. 

 



CHAPTER 6 | BACKGROUND JOBS CONFIGURATION 

321 

 

Command syntax 

The following is the command syntax for Exact.Jobs.SysExchange: 

Exact.Process.exe/ASSEMBLY:Exact.Jobs.SysExchange/CLASS:SysExchange 

/DBCONFIG:<database>/E:<exchange>/DST:<n> [/M:<n>] [/L:<file>] [/CD:<n>] [/X:<n>] [/A:<n>] 

Command syntax Description 

/DBCONFIG:<database> The virtual directory of the database as in the db.config file. Take note 

that the name of the virtual directory is case-sensitive. 

/E:<exchange> Specifies the name of the Microsoft Exchange server that stores the 

mailboxes. 

/DTS:<n> Specifies Daylight Saving Time adjustments where <n> is: 

• 0 — Adjustment without DST time format, recurring appointments will 

not be updated. 

• 1 — Adjustment according to DST time format, recurring appointments 

will not be updated. 

• 2 — Adjustment according to DST time format, recurring appointments 

will be updated. 

/M:<n> Specifies whether to block user from logging in after failures where <n> is: 

• 0 — Report login failures and stop after 10 login failures. 

• 1 — Report login failures and do not stop after 10 login failures. 

• 2 — Do no report login failures and do not stop after 10 login failures. 

If /M is not specified, option 0 is used. 

/L:<file> Specifies the full path and file name of the file where an extensive log is to 

be written (for example, “C:\Log\ExchangeLog.txt”). 

/CD:<n> Includes cycle through people where <n> is: 

• 0 — Both synchronization and deletion are enabled. 

• 1 — Synchronization enabled, deletion disabled. 

• 2 — Synchronization disabled, deletion enabled. 

If /CD is not specified, option 0 is used. 

/X:<n> Specifies the synchronization type where <n> is: 

• 0 — Synchronize both calendar and contacts. 

• 1 — To synchronize contacts only. 

• 2 — To synchronize calendar only. 

If /X is not specified, option 0 is used. 

/A:<n> Specifies server option where <n> is: 

• 0 — There is only one Microsoft Exchange server. 

• 1 — There are multiple Microsoft Exchange servers. 

If /A is not specified, option 0 is used. 
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System settings 

You can decide whether synchronization of the calendar with Microsoft Outlook is required by a setting 

on your personal card. To do this, click Edit while viewing your personal card and select or clear the 

Synchronize calendar check box under the Office section. 

 

You can specify more extensive synchronization settings by clicking  Customize while viewing your 

Calendar. You can choose to synchronize contact persons from Exact Synergy Enterprise with 

Microsoft Outlook or vice versa under the Synchronize: Contacts (MS Exchange) section. The first 

time Exact.Jobs.SysExchange runs, it will only synchronize the contact persons from Exact Synergy 

Enterprise with Microsoft Outlook. Only the contact persons for which you are the account manager of 

will be synchronized. 

Whenever the information for a contact person in Microsoft Outlook is changed, the changes will also 

be applied to the contact in Exact Synergy Enterprise. Contact persons which were already created in 

Microsoft Outlook will not be synchronized to Exact Synergy Enterprise as they might be private contact 

persons. 

In Exact Synergy Enterprise, you can indicate whether appointments need to be synchronized with the 

Microsoft Outlook calendar. By default, all request types with the Calendar check box selected at 

Request types in the request type definition will be synchronized with Microsoft Exchange. 
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Users can add certain request types which will be synchronized by selecting the request types at 

Request types: Other. 

The administrator in Exact Synergy Enterprise can set up the types of request that need to be created 

when an activity is imported from Microsoft Exchange. This can be done via Modules → System → 

Setup → Settings - General → Calendar. 

 

In addition, the administrator can also set up the range used for synchronizing appointments between 

Microsoft Exchange and Exact Synergy Enterprise. 

Apart from the settings in Exact Synergy Enterprise, there are also settings which need to be checked 

on the Microsoft Exchange server via the Microsoft Exchange System Manager. 

 

Reports and troubleshooting 

To verify in Exact Synergy Enterprise whether errors were logged during execution of the jobs, go to 

Modules → System → Reports → Log → Processes where you can check whether the jobs have been 

executed properly. 
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5.2.13 Exact.Jobs.Workspaces 

Exact.Jobs.Workspaces is a background job that will automatically generate thumbnails for 

workspaces. These thumbnails are displayed when viewing the catalog of workspaces or when viewing 

a list of workspaces that you have searched for via the top menu of your Exact Synergy Enterprise. 

This background job will only generate thumbnails for new workspaces, and regenerate thumbnails for 

workspaces that have been modified. If a person has checked out a workspace to make changes to it, 

but has yet to check in the workspace, only that particular person will be able to see the changes 

reflected in the thumbnail. For existing workspaces that do not have any change, the thumbnails will not 

be regenerated. 

 

Command syntax 

The following is the command syntax for Exact.Jobs.Workspaces: 

<ESE installationfolder>\bin\Exact.Process.exe /DBCONFIG:<virtualdirectory> 

/ASSEMBLY:Exact.Jobs.Workspaces /CLASS:WorkspaceThumbnailGenerator 

Command syntax Description 

/DBCONFIG:<database> This refers to the entry in the db.config file that contains the information 

about the location and the name of the database. Take note that the 

name of the virtual directory is case-sensitive. 

/ASSEMBLY This refers to the storing of respective functions in the DLL. 

/CLASS This refers to a specific function or task within the DLL. 

  



CHAPTER 6 | SECURITY CONSIDERATIONS 

325 

 

6. SECURITY CONSIDERATIONS 

With an e-business application like Exact Synergy Enterprise, security measures are necessary to 

ensure that business critical information is safe. This section will discuss security in relations to the 

infrastructure used to run Exact Synergy Enterprise as well as address other perspectives. Every 

organization conducting business over the Internet should consider the impact and risks of insufficient 

security measures. Security in relation to Information Technology is much more than what is described 

here. However, these measures are known to enhance security in a way that this is comfortable and 

more than acceptable for most commercial companies. 

References: 

• http://www.sans.org 

• http://www.sans.org/rr/papers/44/1309.pdf 

• http://www.sans.org/rr/papers/53/543.pdf 

 

Balancing Security, Functionality, and Cost 

When considering security, you must optimize security while still providing flexibility in functionality. In 

general, one can say that the safest computer is one that is not attached to any network. While this 

results in maximum security, the advantages of using shared resources on a network are lost. The other 

extreme is to open all services to the entire Internet, allowing all functionality to be accessed by anyone. 

However, it has high risks of attacks from viruses, spyware applications, or other malicious programs, in 

addition to leaving sensitive information unsecured. 

The following diagram illustrates the dichotomy of security and functionality, as well as the factor costs. 

This diagram shows that ultimate security results in virtually no functionality, and ultimate functionality 

results in poor security. The goal is to establish a balance between functionality and security that allows 

the organization to conduct business efficiently without compromising on business critical information 

and processes. The third aspect is cost. While the optimal balance can be reached in most cases, it will 

often result in high IT costs. 

The two main points to consider are: 

• whether it is worth the risk not to spend on security, and 

• whether the costs actually contribute to a safer environment or result in improved continuity in any 

other form. 

http://www.sans.org/
http://www.sans.org/rr/papers/44/1309.pdf
http://www.sans.org/rr/papers/53/543.pdf
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ISO or OSI Multilevel Security 

A secure environment is not accomplished with a single security measure. To ensure security 

throughout an organization, numerous technical, organizational, and procedural measures must be 

taken. The different steps that can be taken will be handled in a structured manner using the ISO/OSI 

reference model. This model describes communication of IT solutions over a seven-layer model. The 

lowest level represents the hardware level and the highest represents the application layer. All layers 

will be described in details. 

However, this document is not about the model but only using the model to give the different measures 

a place in a commonly known framework. Furthermore, two extra layers are added to the model to 

better explain security as a holistic concept. 
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6.1 PHYSICAL LAYER 

In the ISO or OSI model, this layer is responsible for handling the physical connection between end 

points. It is about voltages and wavelengths. In the perspective of security and Exact Synergy 

Enterprise, measures that relate to security on a hardware level should be considered. 

 

6.1.1 Secure server rooms 

Physical access to a server gives a person access to all information stored on the server. Still, a lot of 

companies leave their business critical information wide open to everyone with access to the building. 

Keep your server in a locked and preferably cooled room. The physical connections between computers 

that form the network are also vulnerable to attacks. A network wire, router, or switch that is hijacked 

can be abused with the right equipment and knowledge. 

 

6.1.2 Failover systems and redundancies 

If there are high demands on availability, investments in failover systems can be worthwhile. The idea of 

failover is in essence very simple. All single points of failures are made redundant by adding a second 

piece of hardware. In practice though, it can be quite complicated. With regard to Exact Synergy 

Enterprise, examples of redundancies are: 

• having at least two web servers, 

• having redundant Internet connections, and 

• clustering the Microsoft SQL Server on which the database is running. 

These measures can be quite costly to implement within the company. However, more and more 

companies outsource these types of services to specialized hosting partners. One could also consider 

power failure measures when discussing redundancies. A server that loses its power is likely to lose 

data. 

 

6.1.3 Backup systems 

Making backups of business critical data also seems very obvious, but in practice even larger 

companies are suffering setbacks because of hardware failures and an insufficient backup policy. In the 

backup procedure, it also provides a thorough testing mechanism to ensure that backups are useful 

when required. 

 

6.1.4 De-militarized zones 

De-militarized zones (DMZ) are used as a buffer zone between the Internet and the intranet in which 

services offered should be accessible over the Internet. Examples of services that are normally offered 

in a DMZ are web services, File Transfer Protocol (FTP) services, and e-mail services. People should 

have access to these services. However, if a security breach occurs, unauthorized users should only 

have access to resources within the DMZ and not to resources in the intranet where the critical data 

resides. Firewalls or routers are used to create DMZs. 
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6.1.5 Intranet and Internet 

There is a clear distinction between the intranet and Internet. The intranet hosts all network resources 

that belong to the company. In some cases, Exact Synergy Enterprise should not be published to the 

public Internet. In these cases, Exact Synergy Enterprise can be used as an intranet solution without 

any problems. Some of the benefits, such as working at home, will then be disabled. Further on we will 

show you how to circumvent this. 

 

6.1.6 Other measures 

Several other security measures can be given a place in this layer. Take note that these measures and 

others belong to more than one layer: 

• Biometric scanners (iris scan and finger print scan) 

• Video and audio surveillance 

• Electronic access mechanisms for locking and logging 

• Personal Identification Number (PIN) and password protection in combination with card reader 

systems 
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6.2 DATA LINK LAYER 

The data link layer is the domain of Virtual Local Area Networks (VLAN), Wide Area Network (WAN) 

protocols like Asynchronous Transfer Mode (ATM), and Frame Relay. Wireless protocols like 802.11 

also belong to this layer. This layer has long been neglected from a security point of view. 

 

 



CHAPTER 6 | SECURITY CONSIDERATIONS 

330 

 

6.3 NETWORK LAYER 

This layer handles data routing by sending outgoing packets, in the right direction and to the right 

destination, and receiving incoming data packets. The network layer handles routing and forwarding, 

and operates on the Internet Protocol (IP) level. It is also the last layer with a direct relationship to the 

physical aspect of networking, which is the addressing of network devices. 

 

6.3.1 Firewalls and IP filtering 

The primary form of a firewall operates on this level. Any firewall can filter inbound and outbound IP 

traffic based on IP addresses or IP domains. For an Exact Synergy Enterprise environment, this type of 

filtering will be useful, but only when it is combined with the filtering of a higher level in the ISO or OSI 

model. 

 

6.3.2 Internet Protocol Security 

The Internet Protocol Security (IPSec) encrypts IP traffic between hosts and thus, provides data 

protection. Data is not normally encrypted this way on the Internet. Instead, it is normally handled with 

the Secure Socket Layer (SSL). 

 

6.3.3 Proxy servers 

A proxy server is used for two reasons: 

• caching of frequently visited web sites to reduce Internet traffic, and 

• providing a single point of access to network services outside the intranet and thereby, providing 

control. 

For Exact Synergy Enterprise, this could be useful in cases where environments are hosted outside the 

internal network. However, the proxy server itself will not enhance the security of the Exact Synergy 

Enterprise environment. 
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6.4 TRANSPORT LAYER 

This layer manages the end-to-end control, such as determining whether all packets have arrived and 

error checking. It ensures complete data transfer. On this level, a firewall is most likely used to filter 

traffic on several levels. The following diagram gives a simplified illustration of the traffic between the 

client, the web server, and the Microsoft SQL Server. 

 

 

6.4.1 Virtual Private Networking tunnel and encapsulation 

Virtual Private Networking (VPN) is a technique that enables computers that are on the Internet to 

virtually become a part of the intranet over an encrypted tunnel set up from the client. Using a VPN 

client, a connection can be established with the internal network on which Exact Synergy Enterprise is 

running. After the connection has been set up, you can access Exact Synergy Enterprise just as if you 

were in the office. A standard VPN client is available within the Microsoft Windows operating system but 

there are several other VPN host/client applications on the market as well. 
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6.4.2 Secure Socket Layer 

The disadvantage of a VPN connection is that the client needs to have a VPN client installed that needs 

to be configured. Since Exact Synergy Enterprise may be used by all levels of users, including those 

who may not be highly computer literate, this could cause a lot of overhead on support departments. 

Another method called Secure Socket Layer (SSL) is available especially for web services. It requires 

almost no extra effort on the client side but still boosts security extensively. SSL is built upon Public Key 

Infrastructure (PKI) and provides a layer between the Hypertext Transfer Protocol (HTTP) and the 

Transmission Control Protocol (TCP). 

There are three major advantages of using SSL to secure an Exact Synergy Enterprise environment: 

• It is used the same way that web sites running HTTP are used. The end user only needs to type 

“https” in front of the URL instead of “http” so there is no extra overhead for instructing end users. 

• Traffic over HTTPS is encrypted, unlike traffic over HTTP. It is almost impossible to decrypt 

intercepted messages. 

• A three-way trust relationship is set up between the client, the server, and an independent issuer of 

the SSL key that ensures the client that the server belongs to the company it claims to be. 

 

6.4.3 Firewalls, network ports, and protocol filtering 

The firewall operates on different levels in the model. However, it can be used most effectively in the 

transport level. The firewall in this level can be used to filter on protocols like TCP, User Datagram 

Protocol (UDP), Internet Control Message Protocol (ICMP), and on sub protocols like TCP/UDP port 

numbers. 

The ports used for the transport layer protocols represent a service running on a server. Each service 

“listens” to a specific port, waiting to take action upon network requests. Commonly used ports are Port 

80 for HTTP, Port 25 for Simple Mail Transfer Protocol (SMTP), and Port 21 for FTP. The idea is to 

configure the firewall in such a way that only traffic for a certain service (transport layer filter on port) is 

allowed to a certain address or address range, and into a certain direction (network level filter on 

address or address range in certain direction). 

The preceding diagram showed a simplified scheme of the port numbers that should be opened on the 

firewall for an Exact Synergy Enterprise environment. The following table shows all relevant port 

numbers: 

Source Destination Port number Comment 

Client PC Web server 80 TCP HTTP for traffic over the Web 

Client PC Web server 443 TCP HTTPS for secure web traffic 

Web server SQL server 1433 TCP & UDP SQL server (default) 

Web server Domain controller 137 & 139 TCP 

389 & 3268 TCP 

NetBIOS LDAP (3268 only 

occasionally) 
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6.5 SESSION LAYER 

The realm of password recognition, Kerberos, biometrics, hardware tokens, and software tokens; this 

layer sets up, coordinates, and terminates conversations, exchanges, and dialogs between the 

applications at each end. It deals with session and connection coordination. A lot of functionalities of 

mechanisms in the other layers have functions in this layer. 
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6.6 PRESENTATION LAYER 

This layer, usually part of an operating system, converts incoming and outgoing data from one 

presentation format to another. For example, the presentation layer converts a text stream into a 

window with the newly arrived text. Sometimes called the syntax layer, encryption mechanisms like SSL 

functions also run on this level. From an Exact Synergy Enterprise maintenance point of view, not much 

influence can be exercised on this level. 

 



CHAPTER 6 | SECURITY CONSIDERATIONS 

335 

 

6.7 APPLICATION LAYER 

This is the layer at which communication partners, quality of service, user authentication and privacy, 

and any constraints on data syntax are identified. In the context of this section, measures with regard to 

the hosting operating systems will also be handled. 

 

6.7.1 Operating Systems 

Exact Synergy Enterprise is highly dependent on the Microsoft technology. Because of this, several 

security measures on this level are to be handled as well. Several measures should be taken to 

optimize security: 

• Minimize the functionalities activated on the web server:  

Microsoft Internet Information Services (IIS) comes with several “handy” features that increase 

vulnerability. Install only the minimum features necessary for running Exact Synergy Enterprise. 

• Install service packs, hot fixes, and patches provided by Microsoft on a regular basis: 

Microsoft operating systems comes with a tool called Automatic Update that helps system 

maintainers keep the system up-to-date. Updates should be installed on the client PCs, the web 

servers, the Microsoft SQL Server, and any other server on the network. 

• Network management:  

Make sure people do not have more rights on the domain than necessary. 

• Install the minimum components necessary: 

Microsoft operating systems come with a lot of additional features that undermine security. A general 

rule for configuring operating systems for both performance and security is to install or activate only 

the necessary components to run Exact Synergy Enterprise. 

 



CHAPTER 6 | SECURITY CONSIDERATIONS 

336 

 

6.7.2 Exact Synergy Enterprise 

Exact Synergy Enterprise is designed to share information throughout an organization, providing an 

integrated solution for organizational processes. Because of this philosophy, Exact Synergy Enterprise 

is very open, unlike most traditional programs where many areas are shielded unless people get access 

to them. People can perform a lot of actions and have access to a lot of information using this product. 

The Exact Synergy Enterprise program has two methods that can be used simultaneously to shield 

functionalities and information: 

• Security Level — A vertical structured way of shielding information. 

• Roles and Function rights — A horizontal structure that gives access to functionalities to 

whomever that has the appropriate role. 
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Security levels 

Security levels specify who is allowed to see or create something. For example, when a user has 

security level 12, the user will be able to see everything equal to or lower than security level 12 but not 

something that has a security level higher than 12. 

Security levels are pretty straightforward. However, there are some specific security levels that provide 

more flexibility in the system. An example of such a security level is the HR-specific security level (100). 

A document that is set to security level 100 will only be visible to the linked person, the manager of the 

person, and people with specific HR roles. 

 

Level Description Who can access and/or modify Portal 

0 All Everyone can view the information External 

1 Customers • All customers 

• All partners 

• All employees 

• Customer 

• Reseller 

• Employee 

2 Partners • All partners 

• All employees 

• Reseller 

• Employee 

3 Customer 

(Specific) 

• The customer linked as the account 

• The reseller of the linked customer 

• The partner linked as the account 

• All employees 

• Customer 

• Reseller 

• Reseller 

• Employee 

4 Partner (Specific) • The reseller of the customer in the request 

• The partner linked as the account in the 

request 

• All employees 

• Reseller 

• Reseller 

• Employee 

5-9 Not used Not applicable N/A 

10-98 Internal • The creator or owner 

• The linked person 

• Users with equal or higher security level 

• Employee 

• Employee 

• Employee 

99 Creator • The request creator 

• The current actor of the request 

• Employee 

• Employee 

100 Person (Specific) • The creator or owner 

• The linked person 

• The manager of the linked person 

• People with HR and HR assistant roles 

based on the division of the linked person 

• Employee 

• Employee 

• Employee 

• Employee 

101 Project (Specific) • The creator or owner 

• Members of the linked project 

Employee and 

Reseller 

 



CHAPTER 6 | SECURITY CONSIDERATIONS 

338 

 

Roles and function rights 

In addition to the security level, any user can also be a member of one or more functional roles which 

grants this user extra rights in a specific part of Exact Synergy Enterprise. The roles consist of function 

points that are actually the entry points to certain functionalities. Role levels can give access of up to 

five levels. 

Level Description 

Corporate Gives access to all entities throughout the environment. 

Group Divisions can be grouped. This level gives access to all divisions belonging to 

the same group that the user’s division belongs to. 

Division Gives access to entities within the user’s division. 

Cost center group These are cost centers within a division. These cost centers can be grouped 

similarly to divisions. Having a role on this level will give access to all cost 

centers in this cost center group. 

Cost center Gives access to entities in the user’s cost center. 

Examples of what function rights can give access to: 

• HR-specific information (absence overviews, contracts, salary slips) 

• Financial information on meta level (Balance, P&L, Aging analysis) 

• Maintenance applications on meta- and actual data 
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6.8 USER LEVEL 

This level is not part of the ISO/OSI model. However, to fully understand what security is about, it is 

necessary to add this level. The weakest link in the whole security structure is humans. No matter how 

well shielded all systems are, human errors and human trust can still make security fail. A few examples 

are: 

• Passwords consisting of partners, children, and pets. 

• Passwords that are taped to monitors. 

• Leaving a PC unguarded while logged on to the system. 

• Giving the password to someone who is calling and claiming to work for the helpdesk. 

Although some technical measures to mitigate these dangers will be discussed, the most important 

thing is to create awareness among users. People learn to lock their houses when they leave for work 

in the morning. They lock their cars and put their money in a bank. Why? Over the years, humans have 

learned to do these things to protect their assets. Nowadays, information is also an asset, and it should 

be taken care of in that perspective. 

 

6.8.1 Having something and knowing something 

The principle of having something and knowing something is a common security measure. The best 

example of an implementation of this system is the electronic cash withdrawal system. With your card, 

you can withdraw cash from a machine if you have the card and know the PIN code. With only one of 

the two, you cannot withdraw cash. Similar systems exist for network systems. People only get access 

to the network by having something and knowing something. 

Card reader systems, fingerprint scanners, and USB keys are all devices used in combination with a 

password. Of course, it is also possible to just have something to get access, but then again if a 

malicious user could get a hold of that thing, he could easily get unauthorized access. 

 

6.8.2 Password policies 

In Active Directory, it is fairly simple to ensure that passwords are not so easy that other people can 

guess them. With the help of the Microsoft security model called Policies, or, in Active Directory terms, 

Group Policy Objects, an administrator can configure the system so that certain rules are applied when 

defining passwords. These rules have an effect on: 

• The minimum length of a password. 

• The complexity of the password. 

• The maximum period of time a password can be used before it must be changed. 

• The minimum period of time before a password can be changed. 

• The password history, or the number of different passwords that should be used before a password 

can be re-used. 

 

6.8.3 Automatic logoff 

With the help of Group Policy Objects, it is also possible to force PCs to log off automatically after a 

certain period of inactivity. This prevents the computer from being hijacked if people walk away from it 

without logging off. This can also be achieved in combination with a USB key system. The system will 

automatically log off when a user removes the USB key.  



CHAPTER 6 | SECURITY CONSIDERATIONS 

340 

 

6.9 POLICIES AND PROCEDURES 

As stated earlier, despite all advanced technological measures, the system still is most vulnerable at the 

user level. Apart from steering the behavior through technical measures, it is most important that people 

are aware of the consequences that security breaches can have for a company and themselves. 

Normally this awareness consists of: 

 

6.9.1 Education 

Since the appearance of the PC on virtually every desk at companies, a division has been created 

between people who know and people who do not know. One of the modern threats in the world is the 

inability to handle computers. Educating people about computers goes beyond teaching them how to 

operate the different applications. A certain amount of energy should also be invested in creating 

computer security awareness. 

 

6.9.2 Policies 

Policies are applied across all platforms. However, defining them in the highest layer implies that well-

defined and clear policies represent responsible behavior with regard to security throughout the layers. 

Policies themselves will not force people to follow the rules. However, they will set the boundaries that 

can be measured, and people can be made responsible for correct conduct according to these policies. 

Exact Synergy Enterprise can be used as a tool to inform all responsible people about the policies. For 

more strict control, a mechanism can be configured that will force people to accept these policies, 

placing responsibility directly on the users. 
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7. RELATED MATTERS 

Apart from installing and setting up Exact Synergy Enterprise, there are several subjects related to the 

Exact Synergy Enterprise implementation. These are matters, such as updating Exact Synergy 

Enterprise, configuring Microsoft Office Add-in, integrating Exact Synergy Enterprise with back-office 

systems, and setting up the maintenance plan for daily database backup. 

With the introduction of Windows Server 2008 R2, Exact has made efforts to ensure Exact Synergy 

Enterprise is compatible with this operating system. This is also covered in this chapter. 
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7.1 UPDATING EXACT SYNERGY ENTERPRISE 

Exact continues to improve Exact Synergy Enterprise. As new versions of Exact Synergy Enterprise 

become available, customers and resellers can download and update their Exact Synergy Enterprise 

implementation. Exact Synergy Enterprise program files can be updated through the Internet. In cases 

where Internet access is not available at the location where  

When Exact Synergy Enterprise is installed, such as for customers using Exact Synergy Enterprise in a 

LAN environment, an update CD-ROM can be created by downloading the files from another location 

with Internet access.  

Updating Exact Synergy Enterprise can be divided into two major steps. In the first step, the Exact 

Synergy Enterprise program files in all application servers need to be updated. The second step, where 

the SQL database is updated, happens when Exact Synergy Enterprise is first accessed after the 

updating of program files. 
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7.1.1 Exact Synergy Enterprise program files update 

In order to update Exact Synergy Enterprise over the Internet or create the update installer CD-ROM, 

the Exact Internet Installer is required. You can download this application from one of the following 

web sites: 

• Customers — https://customers.exact.com 

• Resellers — https://partners.exact.com 

• Employees — https://employees.exact.com 

 

To update Exact Synergy Enterprise program files 

The procedure to update Exact Synergy Enterprise is the same as the procedure to install Exact 

Synergy Enterprise from the Internet. See 3.1.2 Installing Exact Synergy Enterprise from the Internet for 

the procedure. The difference between updating and installing is that during the update, only the newer 

files are downloaded. 

 

 

While performing the update as described at 3.1.2 Installing Exact Synergy Enterprise from 

the Internet, take particular interest in these points: 

• Select the new release that you want to update to at the Release field. 

• Check the folder at Installation directory to ensure that it is the installed folder of the current Exact 

Synergy Enterprise that you want to update. 

• Select the appropriate update method at Update software. 

 



CHAPTER 7 | RELATED MATTERS 

344 

 

Selecting the appropriate update methods 

The update method that you specify at Update software in the Exact Internet Installer is of particular 

concern. You can select to update each Exact Synergy Enterprise file that requires updating as each 

file is downloaded or after all required files are downloaded: 

• During download — Each file that requires updating is updated as it is being downloaded from the 

update server. To accommodate this, the installer will stop the IIS web server during the whole 

download and update process. Once the update is completed, the installer will restart the IIS web 

server. 

• After download — The files are updated only after all new files have been downloaded from the 

update server. The installer does not stop the web server during the download process. Once all 

new files have been downloaded, the installer will stop the web server to update the files. Once the 

update is completed, the installer restarts the IIS web server. 

As the actual updating of files takes only a short time compared to downloading the files, it is 

recommended to select After download on a slow internet connection to minimize the service 

disruption. However, you should also consider the time to update the SQL database in your plan as 

Exact Synergy Enterprise will not be available during the database update. 

 



CHAPTER 7 | RELATED MATTERS 

345 

 

7.1.2 Updating the Exact Synergy Enterprise database 

After updating the Exact Synergy Enterprise program files, the SQL database may also need updating, 

if the database model is updated in the new release. In this case, when you access the updated Exact 

Synergy Enterprise for the first time, you will see the Database: Update page. 

The Exact Synergy Enterprise implementation will not be available to the users before and during the 

database update. In the database update process, several SQL scripts may perform the following tasks: 

• Make required changes to the database, such as adding extra columns to tables. 

• Rebuild the Repository of Exact Synergy Enterprise. 

• Add information to Exact Synergy Enterprise system tables, such as a new function right. 

 

To update the Exact Synergy Enterprise database: 

1. Under the Login section, define the authentication method to log into the Microsoft SQL Server in 

order to create the database. If the current Microsoft Windows login has administrative rights on the 

database server and you want to use the Windows Authentication method, select the Integrated 

security check box. Otherwise, clear the check box and type the Microsoft SQL administrator login 

name and password at Login name and Password respectively. 

 

Note:  

In order to update the database, only Microsoft SQL administrator rights are required and the user 

does not even have to be using Exact Synergy Enterprise. However, an Exact Synergy Enterprise 

administrator without administrative rights on the Microsoft SQL Server will not be able to update 

the database. 

2. Click Update to update the database. You will not be able to cancel the process. 
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3. Wait while the database is updated. The Status: Create section will be displayed below the Login 

section to show you the update status. After the database has been updated, the Exact Synergy 

Enterprise environment will be loaded if you are a person with an Active status in Exact Synergy 

Enterprise. 



CHAPTER 7 | RELATED MATTERS 

347 

 

7.1.3 Updating Exact Synergy Enterprise automatically 

You can configure an automated task using the Microsoft Windows Scheduled Task or the Microsoft 

SQL Server Agent to automatically update Exact Synergy Enterprise periodically. This is possible as the 

Exact Internet Installer accepts command line parameters. There are two versions of the Exact 

Internet Installer. 

The first one is the product-specific Exact Internet Installer. The executable file is named 

ProductUpdater_T15_XX.exe where XX is the language code (AE - American English / DE - German / 

NL - Dutch). If you are running the product updater from the command line using full silence option, the 

interface language does not matter. 

Conventions: 

Throughout this topic, the command syntax of each installer is explained using the following 

conventions: 

• Parameters enclosed within square brackets ([ and ]) are optional. 

• The chevrons (< and >) signifies that you need to replace the text (including the chevrons) with 

appropriate values. 

• The command line parameters are case-sensitive. 
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The following table is a summary of the command syntax for ProductUpdater_T15_XX.exe. Take note 

that the parameter options are case-sensitive. 

ProductUpdater_T15_XX.exe[/R:<release>][/IM:<n>][/W:<URL>][/USER:<login>] 

[/PW:<password>][/DOMAIN:<domain>][/I:<folder>][/TTL:<title>][/CNT:<name>] 

[/GDR:<gender>][/EML:<address>][/PH:<number>] [/S:<n>] [</RO] 

Command syntax Description 

/R:<release> Specifies the <release> of the software to update to. In the interactive mode, 

this is the Release field. 

/IM:<n> Specifies installation mode where <n> is: 

• 0 — Internet installation 

• 1 — Creation of CD installation 

• 2 — CD installation 

If /IM is 2, only the /I, /S, and /RO parameters are applicable. In the interactive 

mode, this is the Install mode field. 

/W:<URL> Specifies that the files are to be downloaded from this <URL>. Unless 

informed otherwise, this is “https://update.exactsoftware.com”. In the 

interactive mode, this is the Web site field. 

/USER:<login> Specifies the <login> name to the update server as provided by Exact. In the 

interactive mode, this is the User field. 

/PW:<password> Specifies the login <password> to the update server. In the interactive mode, 

this is the Password field. 

/DOMAIN:<domain> Specifies the login <domain>. For Exact customers and resellers, the domain 

is “EWEB”. In the interactive mode, this is the Domain field. 

/I:<folder> Specifies the <folder> to update or install Exact Synergy Enterprise. In the 

interactive mode, this is the Installation directory field. 

/TTL:<title> Specifies the contact salutation where <title> is: Afd., Dhr., Dr., Fr., L.S., 

M.,Mevr., Mme., Mr., Mrs., Ms., Sr., Sra., or Srta.. In the interactive mode, 

this is the salutation selection of the Name field. 

/CNT:<name> Specifies the contact <name>. In the interactive mode, this is the Name field. 

/GDR:<gender> Specifies the contact gender where <gender> is: Male or Female. 

/EML:<address> Specifies the contact e-mail <address>. 

/PH:<number> Specifies the contact telephone <number>. 

/S:<n> Enables the silent mode where <n> is: 

• 1 — Partial silence. No input needed but may ask for confirmation. 

• 2 — Full silence. No user interaction is required. 

/RO Sets the option to perform only repair of current installation. 
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Apart from the simple Exact Internet Installer, you can also use the more advanced product updater, 

SynergyProductUpdater.exe. The interactive interface is available only in English. The 

SynergyProductUpdater.exe is more suitable for automatic updates in the silent mode where it 

supports extra functions, such as: 

• Downloading Exact Synergy Enterprise online help files into your server. 

• Selecting to download only online help files in a specified language. 

• Updating files related to the legislation of only a specific country. 

• Eight installation modes including network installation modes. 

The following table is a summary of the command syntax for the advanced product updater. Take note 

that the parameter options are case-sensitive. 

SynergyProductUpdater.exe[/P:<code>][/R:<release>][/IM:<n>][/NETDIR:<UNC>][/W:<URL>][/US

ER:<login>][/PW:<password>][/DOMAIN:<domain>][/I:<folder>][/LANGUAGE:<code>][/COUNTR

Y:<code>][/TTL:<title>][/CNT:<name>][/GDR:<gender>][/EML:<address>][/PH:<number>] [/S:<n>] 

[/DEMO][/HELP] [</RO] 

Command syntax Description 

/P:<code> Specifies the <code> of the product to download. For Exact Synergy 

Enterprise, the product code is “Synergy.NET”. 

/R:<release> Specifies the <release> of the software to update to. In the interactive mode, 

this is the Release field. 

/IM:<n> Specifies installation mode where <n> is: 

• 0 — Internet workstation installation 

• 1 — Internet network installation 

• 2 — Internet network installation update 

• 3 — LAN workstation installation 

• 4 — LAN workstation update 

• 5 — Creation of CD installation 

• 6 — CD workstation installation 

• 7 — CD network installation 

If /IM is 3 or 4, only the /P, /R, /NETDIR, and /I parameters are applicable. If 

/IM is 6 or 7, only the /P, /I, /S, and /RO parameters are applicable. In the 

interactive mode, this is the Install mode field. 

/NETDIR:<UNC> Specifies the <UNC> (Uniform Naming Convention) network path from where 

the files will be downloaded when /IM is 3 or 4. In the interactive mode, this is 

the Path to network installation field. 

/W:<URL> Specifies that the files are to be downloaded from this <URL>. Unless 

informed otherwise, this is “https://update.exactsoftware.com”. In the 

interactive mode, this is the Web site field. 

/USER:<login> Specifies the <login> name to the update server as provided by Exact. In the 

interactive mode, this is the User field. 

/PW:<password> Specifies the login <password> to the update server. In the interactive mode, 

this is the Password field. 

/DOMAIN:<domain> Specifies the login <domain>. For Exact customers and resellers, the domain 

is “EWEB”. In the interactive mode, this is the Domain field. 

/I:<folder> Specifies the <folder> to update or install Exact Synergy Enterprise. In the 

interactive mode, this is the Installation directory field. 
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Command syntax Description 

/LANGUAGE:<code> Specifies to download only help files of the specified language where <code> 

is: 

• AR — Arabic 

• HR — Croatian 

• CS — Czech 

• DA — Danish 

• NL — Dutch 

• EN — English 

• ET — Estonian 

• FI — Finnish 

• FR — French 

• DE — German 

• EL — Greek 

• HU — Hungarian 

• ID — Indonesian 

• IT — Italian 

• JA — Japanese 

• KO — Korean 

• NO — Norwegian 

• PL — Polish 

• PT — Portuguese 

• RO — Romanian 

• RU — Russian 

• CH — Simplified Chinese 

• SK — Slovak 

• ES — Spanish 

• SV — Swedish 

• TH — Thai 

• ZH — Traditional Chinese 

• TR — Turkish 

• VI — Vietnamese 

This is to be used together with /HELP. In the interactive mode, this is the 

Language field. 

/COUNTRY:<code> Specifies the demo company database to download where <code> is: 

• BE — Belgium 

• DE — Germany 

• NL — The Netherlands 

• LU — Luxembourg 

This is to be used together with /DEMO. In the interactive mode, this is the 

Country field. 

/TTL:<title> Specifies the contact salutation where <title> is: Afd., Dhr., Dr., Fr., L.S., M., 

Mevr., Mme., Mr., Mrs., Ms., Sr., Sra., or Srta.. In the interactive mode, this 

is the salutation selection of the Name field. 

/CNT:<name> Specifies the contact <name>. In the interactive mode, this is the Name field. 

/GDR:<gender> Specifies the contact gender where <gender> is: Male or Female. 

/EML:<address> Specifies the contact e-mail <address>. 
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Command syntax Description 

/PH:<number> Specifies the contact telephone <number>. 

/S:<n> Enables the silent mode where <n> is: 

• 1 — Partial silence. No input needed but confirmation may be asked. 

• 2 — Full silence. No user interaction is required. 

/DEMO Sets the option to download a sample company database for demonstration. 

/HELP Sets the option to download online help files into your server. 

/RO Sets the option to perform only repair of current installation. 

/FU Sets the option to uninstall the previous version first before installing the 

updated version. 

Note:  

If a parameter has not been specified, the previous values as set in the command line or interactive 

mode of the installer are used except for the password value. You will need to specify the password 

in the command line if you want to use the full silence option. 

 

Caution:  

The password is specified in plain text in the command line. Take necessary precautions to avoid 

security issues. 
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7.2 INSTALLING EXACT SYNERGY ENTERPRISE USING MSI 

In order to get the latest MSI and MSP packages, do the following: 

1. Log in at the Exact customer portal and click on the link for downloads (this is typically at 

https://customers.exact.com/docs/sysmsiupdater.aspx) to open the Download options page. 

 

2. Select the relevant product line at Product line and the corresponding release number at Release. 

3. At FTP server, select the server from which you want to download. 

4. Select the relevant installation at Install mode. 

5. At Platform, select the appropriate platform version that you want to download. 

6. Click Download to start downloading the file. 

7. Click Run to start the installation immediately or Save to save the file to your computer for 

installation at a later time. 

 

To install Exact Synergy Enterprise: 

1. Go to the Start menu, click Windows Explorer and browse the folder where you saved the 

downloaded Exact Synergy Enterprise Installer. 

2. Double-click the Exact Synergy Enterprise installer (the .msi file). 

3. Select the installation language and click OK to proceed. 

 

4. On the Welcome page, click Next to continue. 
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5. On the End-User License Agreement page, select the I accept the terms in the License 

Agreement check box, and then click Next. 

6. Select the location where you want Exact Synergy Enterprise to be installed. For example, 

“C:\Program Files\eSynergy” and click Next to proceed. The default path for installation is 

“C:\Program Files\Exact Synergy Enterprise”. 

 

7. Click Install to start the installation process. 

 

8. Once completed, click Finish to start Exact Synergy Enterprise. 

 

To restore the Exact Synergy Enterprise database to a Windows Server 2008 R2 machine: 

To restore the Exact Synergy Enterprise database, see 3.2.3 Opening an existing Exact Synergy 

Enterprise database. 
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7.3 SYNERGY OFFICE INTEGRATION 

Synergy Office Integration allows for closer integration between Exact Synergy Enterprise and 

Microsoft Office. With Synergy Office Integration, you will be able to access Exact Synergy Enterprise 

and all its related functions using Microsoft Outlook.  

In addition, you will be able to perform functions, such as saving and viewing documents, saving 

presentations, and spreadsheets directly and easily to Exact Synergy Enterprise. 

Note:  

You may not need to install Office Add-in if Synergy Office Integration has already been 

installed. Synergy Office Integration offers more advanced features which are not available in 

Office Add-in. 

 

Requirements and prerequisites 

The following requirements must be met before Synergy Office Integration can be installed: 

• Verify the validity of the version of Synergy Office Integration via Modules → System →  Setup → 

Settings – General → Preferences. The Office Integration version field is displayed under the 

General section if you have selected the Corporate (Office Integration) tab. Otherwise, update 

Exact Synergy Enterprise. 

• Enable the Binary, DocumentManagement, DocumentType, and Profile web services at Modules 

→ System → Setup → Web services → Settings. 

• Microsoft .NET Framework version 4.7. 

• Microsoft Visual Studio Tools for the Microsoft Office system (version 3.0 Runtime) (x86) or 

Microsoft Visual Studio Tools for the Microsoft Office system (version 4.0 Runtime) 32-bit or 64-bit. 

• Windows Installer 3.1 or higher. 

• Windows 7 (32-bit or 64-bit). 

• Microsoft Office 2019 (32-bit). 

Note:  

To download Microsoft .NET Framework version 4.7,  Microsoft Visual Studio Tools for Microsoft 

Office system (version 3.0 Runtime) (x86), and Microsoft Visual Studio Tools for Microsoft Office 

system (version 4.0 Runtime) 32-bit or 64-bit, see the Exact Synergy Office Integration (Doc ID 

18.826.648) or see Installing Synergy Office Integration (Doc ID 18.987.215) in Exact Synergy 

Enterprise. 

 

http://www.exactsoftware.com/docs/DocView.aspx?DocumentID=%7b1d2db994-e05f-4fe8-994c-b6bfa43694fb%7d
http://www.exactsoftware.com/docs/DocView.aspx?DocumentID=%7bb9e7073e-608e-4cd4-9ac3-558bad9afb86%7d&NoSubject=1&NoHeader=1
http://www.exactsoftware.com/docs/DocView.aspx?DocumentID=%7bb9e7073e-608e-4cd4-9ac3-558bad9afb86%7d
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7.3.1 Installing Synergy Office Integration 

To install Synergy Office Integration: 

1. Go to Modules → System → Setup → Settings – General → Preferences. 

2. Under the General tab, under the Office: Installations section, select Synergy Office Integration. 

3. On the System: Installation page, select Download. The following message will be displayed: 

 

4. Click Save and specify a location at which to save the file. 

5. Locate the file that you have saved and double-click the file. The following message will be 

displayed: 

 

 

6. Click Next. 
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7. The following message will be displayed. To accept the terms on the End-User License 

Agreement page, select the I accept the terms in the License Agreement check box and click 

Next. 

 

8. The following message will be displayed. Click Install to proceed. 
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9. Once the installation is completed, click Finish. 
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7.3.2 Using Synergy Office Integration for the first time 

Before you use Synergy Office Integration for the first time, it has to be configured correctly. This is to 

ensure that no problems are encountered when you save documents or e-mails to Exact Synergy 

Enterprise. The default document types need to be determined for the different usage within the 

different applications. To do this, go to Modules → System → Setup → Settings – General → 

Preferences, click the Corporate (Office Integration) or Office Integration tab, and then define the 

fields.  

You can access the Corporate (Office Integration) tab only if you are an administrator. One point to 

note when selecting document types for the fields is to ensure that the selected document type is 

accessible by all target users. This is because some document types have higher security levels than 

others and are, thus, not accessible to some users. 

When starting each of the Microsoft Office applications for the first time after Synergy Office 

Integration has been installed, you will see the following: 

 

Click Install to proceed. After the installation, if there is an updated version of Synergy Office 

Integration available, you will be informed and asked whether you want to upgrade to the latest 

version. 

Next, a page will be displayed for you to begin the configuration wizard. You can choose to perform the 

configuration at a later stage. However, to use the Synergy Office Integration features, you must first 

complete the configuration wizard. 

Caution:  

Your Exact Synergy Enterprise portal must be added to the “Trusted sites” zone in Microsoft Edge 

to allow Synergy Office Integration to function properly. 
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To set up Synergy Office Integration using configuration wizard: 

1. Open Microsoft Word, Microsoft Excel, Microsoft Outlook, or Microsoft Power Point. If you are 

opening the Microsoft application for the first time after installing Synergy Office Integration, you 

will see the following page: 
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2. Click Next to begin the configuration. 

Note:  

If you click Later, the configuration will be started when you use any of the Synergy Office 

Integration feature. 

 

 

3. At Web address, fill in the web site URL of the Exact Synergy Enterprise software that you want to 

connect to. 

4. At Authentication Mode, select one of the following token-based authentication models: Windows 

Authentication, Basic Authentication, WAAD Authentication, or Auth0 Authentication. 
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5. At Username and Password, fill in your Exact Synergy Enterprise login details, and then click 

Next. The system will then check if your system fulfills all prerequisites needed for the 

configuration. Two possibilities can occur: 

• If the system fulfills all prerequisites, click Next to proceed with the configuration. Once it is 

completed, click Finish to exit the configuration wizard, and then restart your MS Office 

applications for the settings to take effect. 

• If the system does not fulfill one prerequisite or more, you will see the following page: 

 

Note:  

If the configuration fails to proceed, contact your system administrator to resolve the critical points. 

You can also click the More information hyperlink in the configuration wizard to obtain more 

information on the critical points. 
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Every time you start a Microsoft Office application, the Synergy ribbon or toolbar is available for you. 

However, when you access any features under the Synergy ribbon or toolbar for the first time, a login 

page will be displayed for you to type your user name and password, as displayed in the following: 

 

Note:  

Should the corporate default web site be changed while a user is logged in to Synergy Office 

Integration, the user will be prompted again to re-login to the new web site. 

 

As of product update 261, the WAAD authentication and Auth0 authentication no longer requires for the 

user name and password to be defined in the SOI configuration wizard screen. See the following 

configuration steps for the WAAD authentication and Auth0 authentication: 

 

WAAD authentication 

 

6. In the following screen, select WAAD Authentication at the Authentication Mode field. 
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7. Define the Authority, ClientID, and APP ID URI fields. 

8. Click Next. 
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9. The following multi-factor authentication login screen will be displayed: 

 
10. Type the authentication code. 

11. Click Verify. 

12. The standard screens will be displayed and you can proceed with the configuration accordingly. 
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Auth0 authentication 

 

1. In the following screen, select Auth0 Authentication at the Authentication Mode field. 

 
2. Define the Authority and ClientID fields. 

3. Click Next. 
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4. The following multi-factor authentication login screen will be displayed: 

 
5. Type the authentication code. 

6. Click . The standard screens will be displayed and you can proceed with the configuration 

accordingly. 
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7.4 MICROSOFT OFFICE ADD-IN 

Microsoft Office Add-in integrates Microsoft Office with Exact Synergy Enterprise through an interface 

that can directly communicate with Exact Synergy Enterprise. The following describes the applications 

that support Office Add-in: 

• Office Add-in for Microsoft Word allows documents to be uploaded to Exact Synergy Enterprise, 

and documents created in Exact Synergy Enterprise can be opened in Microsoft Word. Furthermore, 

documents can be uploaded in batches from Microsoft Word to Exact Synergy Enterprise and mail 

merges can be performed in Microsoft Word with the data obtained from Customers in Exact 

Synergy Enterprise. 

• Office Add-in for Microsoft Excel can be used to create Customers reports from Exact Synergy 

Enterprise and Customers contacts can be uploaded to Exact Synergy Enterprise. 

• Office Add-in for Microsoft Outlook can be used to store incoming and outgoing e-mails as 

documents in Exact Synergy Enterprise. 

• Office Add-in for Microsoft PowerPoint can be used to upload and download PowerPoint 

presentations to Exact Synergy Enterprise. 

Note:  

It is advisable to install Synergy Office Integration over Office Add-in to fully optimize Exact 

Synergy Enterprise functionalities. 
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7.4.1 Before installing Microsoft Office Add-in 

The following summarizes the Office Add-in requirements: 

• Users must have the Administrator role on the local PC. 

• Update to the latest Microsoft Data Access Components (MDAC). 

• MSXML 3.0 and MSXML 4.0 components are installed. 

• Exact Synergy Enterprise web site is added to the Microsoft Internet Edge trusted sites list. 

Note: 

• Office Add-in uses XML to upload documents to the server. The MSXML 4.0 components are 

required only for the application server while the minimum requirement for client computers is 

MSXML 3.0. 

• For the latest system requirements for Synergy Office Integration and Office Add-in, see 

System Requirements - Synergy Office Integration and Office Add-in (Doc ID: 20.963.409) in 

Exact Synergy Enterprise. 

 

Registering the MSXML components 

Microsoft Office Add-in depends on Microsoft XML components. These components are installed and 

registered in the system once users install Office Add-in to their client workstation. However, if the 

MSXML components are no longer registered in the system somehow, you will have to manually 

register the components again in order to continue using Office Add-in. For example, if MSXML 3.0 is 

not installed, you will not be able to select main categories, categories, and subcategories when saving 

a document. 

 

To register MSXML components: 

1. Go to the Start menu and click Run. Type cmd.exe at Open and click OK to start the command 

prompt. 

2. At the command prompt, type the following command: 

for %1 in (%systemroot%\system32\msxml*.*) do @regsvr32.exe %1 /s 

3. Press the ENTER key to register the MSXML components. 

Note:  

To execute this command, you must have local administrator rights for the workstation.  

4. Type exit and press ENTER to close the command prompt. 

 

 

https://employees.exact.com/docs/DocView.aspx?DocumentID=%7bf38f9a34-3a49-49c0-ad0d-ecb40e35adb3%7d&NoHeader=1&NoSubject=1
https://employees.exact.com/docs/DocView.aspx?DocumentID=%7bf38f9a34-3a49-49c0-ad0d-ecb40e35adb3%7d
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7.4.2 Installing Microsoft Office Add-in 

Office Add-in has to be installed in Exact Synergy Enterprise before the feature is available in 

Microsoft Word, Microsoft Excel, Microsoft Outlook, and Microsoft PowerPoint. 

Caution:  

Make sure that all Microsoft Office applications are closed before installing Office Add-in. 

 

Changing security settings in Microsoft Internet Edge 

You may need to change some security settings in Microsoft Internet Edge in order to install the Office 

Add-in successfully. 

 

To change security settings in Internet Edge: 

1. In Microsoft Edge, click  and select Internet options. 

2. Click the Security tab and select Trusted sites under the Select a zone to view or change 

security settings section. 

3. With Trusted sites selected, click Sites. 

 

4. Type the URL of your Exact Synergy Enterprise portal, click Add, and then click Close. 
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5. With Trusted sites still selected, click Custom level under the Security level for this zone 

section. 

 

6. Select Prompt in Initialize and script ActiveX controls not marked as safe for scripting under 

the Settings section. 

7. Click OK to save the settings. 

Caution:  

Your Exact Synergy Enterprise portal must be added to the “Trusted sites” zone in Microsoft Edge 

to allow Office Add-in to function properly. 

 

Installing Microsoft Office Add-in using the online installer 

The easiest way to install Microsoft Office Add-in is by using the online installer in Exact Synergy 

Enterprise. 
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To install Microsoft Office Add-in: 

1. Go to Modules → System → Setup → Other → Installation: Microsoft office Add in. You will see the 

following page: 

 

2. Under the Office Add-In section, click Install. If you see a warning page by Microsoft Edge, click 

Install. 

3. After a successful installation, click Close to exit. 

 

Manually installing Microsoft Office Add-in 

If you have problems installing the Office Add-in from Exact Synergy Enterprise, you can install it 

manually. Remember to close all Microsoft Office applications before installing Office Add-in. 

 

To install Microsoft Office Add-in manually: 

1. Get the SynergyOfficeAddin.CAB file from an administrator with access to the folder where Exact 

Synergy Enterprise installed on the application server. This file can be found in the cab subfolder. 

2. Create a folder in the C: drive and name it Office Add-in synergy. 

3. Put the SynergyOfficeAddin.CAB file in the Office Add-in synergy folder. 

4. Go to the Start menu, and click Run. Type cmd.exe in the Open box and click OK to start the 

command prompt. 

5. At the command prompt, type the following command: 

extrac32 /e /1”c:\Office Add-in synergy” “c:\Office Add-in synergy\SynergyOfficeAddin.CAB” 

6. Press ENTER to extract the content of SynergyOfficeAddin.CAB into the Office Add-in synergy 

folder. 

7. Once the extraction is completed, type the following command at the command prompt: 

regsvr32 c:\ “Office Add-in synergy”\SynergyOfficeAddin.dll 

8. Press ENTER to install and register Office Add-in into the system, and then click OK. 

9. At the command prompt, type exit and press ENTER to close the command prompt. 
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7.4.3 Setting up Office Add-in in Microsoft Office 

Once Office Add-in is installed, some settings must be defined in Microsoft Office. For example, you 

need to define the Exact Synergy Enterprise portal so that documents can be uploaded to and 

downloaded from Exact Synergy Enterprise. The settings for Microsoft Office and Microsoft Excel are 

the same. 

 

To set up Office Add-in in Microsoft Word and Microsoft Excel: 

 

1. Open Microsoft Word or Microsoft Excel. 

Note:  

Make sure that at least a blank document or spreadsheet is opened in the application before 

proceeding. 

2. Click the Add-Ins tab in the ribbon. Then, click Exact Synergy and select Settings. 

 

3. Type the Exact Synergy Enterprise portal address at Web site.  

4. Select the Rebuild check box if you want to rebuild the Office Add-in menu whenever the web site 

is updated. 

5. Select the Database: Default check box if you want Office Add-in to access the default portal 

database. Clear the check box if you want to define a different database. 

Note:  

If you define a different database, take note that the database name setting is case-sensitive. 

6. At Language, select a language to use for the Office Add-in menu. This does not affect the 

contents of the documents that are uploaded to or opened from Exact Synergy Enterprise. 

7. At Type: Address, select the address type to extract from the Exact Synergy Enterprise 

Customers data to use in the Microsoft Word mail merge function. A customer account in Exact 

Synergy Enterprise can have different address types, such as Visit, Invoice, Postal, and Delivery. 

8. Type the size of data to download per data package (XML page) at Page size. This determines the 

amount of data that is transferred in each package between Exact Synergy Enterprise and Office 

Add-in. 
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Tip:  

A smaller number means a more responsive Office Add-in but longer download time. For example, 

if you decide to cancel a document download from Exact Synergy Enterprise, a smaller number 

means that Office Add-in can cancel the download faster. 

 

9. Click OK to save. 

Note:  

All fields with the “!” icon are mandatory. 

 

To set up Microsoft Office Add-in for Microsoft Outlook: 

1. Open Microsoft Outlook. Then, click Exact Synergy under Add-Ins in the menu and select 

Settings. 

 

2. Type the Exact Synergy Enterprise portal address at Web site.  

3. Select the Database: Default check box if you want Office Add-in to access the default portal 

database. Clear the check box if you want to define a different database. 

4. At Language, select a language for the Exact Synergy Enterprise interface. This does not affect the 

contents of the e-mails that are uploaded to or opened from Exact Synergy Enterprise. 

5. Type or select your division specified in Exact Synergy Enterprise at Division. 

6.  Click the E-mail: In or E-Mail: Out tab to set up incoming or outgoing e-mails. 
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7. At Upload in either tab, select the one of the following options: 

• Never — Select this option to disable uploading or downloading of e-mails into Microsoft 

Outlook from Exact Synergy Enterprise. 

• Manually — Select this option to manually upload or download e-mails with Exact Synergy 

Enterprise using the Save command under the Office Add-in menu. 

• Automatically: Notify — Select this option to display a notification message asking whether 

you want to upload the e-mail to Exact Synergy Enterprise whenever there is a new e-mail. 

• Automatically: Always — Select this option to automatically upload or download all e-mails 

with Exact Synergy Enterprise without notification. 

8. Select the Ignore: Internal check box to exclude internal company e-mails from the upload or 

download. 

9. At Type, select a document type to upload the e-mails as this type of document. This is optional. 

10. Select a document main category, category, and subcategory at Main category, Category, and 

Subcategory respectively to save e-mails into the respective categories. 

11. Type or select the security level for the uploaded e-mails at Security. 

12. At Assortment, select the document assortment of the uploaded e-mails. 

13. Type a subject prefix at Subject: Header. When an e-mail is uploaded, this will be prefixed to the e-

mail subject to become the document title. 

14. Select the Save as: Draft check box to save all uploaded e-mails as documents in draft status. 

Clear the check box to upload e-mails as documents in normal status. 

Tip:  

Documents in draft status can be read or modified only by the document creator or owner. 

15. At Include: Attachments, select one of the following options: 

• Never — Select this option if you do not want to upload e-mail attachments. 

• Notify — Select this option if you want the system to ask you whether you want e-mail 

attachments to be uploaded. 

• Always — Select this option to upload attachments in all e-mails without notification. 

Note:  

If an e-mail has more than one attachment, Exact Synergy Enterprise will store one attachment in 

the document and the other attachments in reply documents. 

16. At E-Mail, select one of the following options: 

• Include: All — Select this option to upload all received e-mails to Exact Synergy Enterprise. 

• Include: List — Select this option to upload only e-mails from the listed addresses to Exact 

Synergy Enterprise. 

• Exclude: List — Select this option to upload all e-mails to Exact Synergy Enterprise except 

those from the listed addresses. 

17. Type an e-mail address in the box next to the Add button and click Add to include the e-mail 

address in the list. You can repeat this step to add more addresses. 

Tip:  

To remove an e-mail address from the list, select the address and click Delete. 
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18. Click OK to save your settings. 

Note:  

All fields with the “!” icon are mandatory. 
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7.5 INTEGRATION WITH EXACT BACK-OFFICE PRODUCTS 

Although the installation of Exact Synergy Enterprise is fairly simple, the Exact Synergy Enterprise 

environment can be rather complex. 

Integrating Exact Synergy Enterprise with Exact Globe Next can lead to confusion especially with 

regard to: 

• storage of the Microsoft Windows user accounts for the different types of users (resellers, 

customers, and employees), 

• addressing more databases with one program environment, or ASP model; and 

• other technical aspects of Exact Synergy Enterprise setup. 

 

7.5.1 Consolidating Exact Synergy Enterprise and Exact Globe Next 

Integration of operations can lead to a more efficient, cost effective, and high service level environment 

for customers. The combination of Exact Synergy Enterprise and Exact Globe Next can run together in 

a multi-database setup known as the “consolidated scenario”. 

In this scenario, there are multiple back-office administrations. At the same time, multiple different 

databases are maintained: one for Exact Synergy Enterprise and one for every Exact Globe Next 

administration. The databases interact with each other using XML. The tool for this, Asimport.exe, is 

provided with Exact Globe Next. 

These back-offices can be located anywhere and may be of any type, as long as the application can 

handle Exact XML-Scheme. However, the preferred application is Exact Globe Next because of the 

similar database structure. 

Data entered or modified in Exact Synergy Enterprise is downloaded to the appropriate Exact Globe 

Next back-offices and vice versa. By executing this upload and download frequently, the data in both 

administrations will be up to date. 

 

In this scenario, the integration is not limited to one company as a back-office administration can be 

added at any time. Instead of doing a financial consolidation with various outdated spreadsheets, this 

scenario allows you to do an automatic financial consolidation in Exact Synergy Enterprise, based on 

live data coming from the back-office administrations. 

Tip:  

This scenario can be used for a new installation of Exact Synergy Enterprise and Exact Globe Next 

or when linking Exact Synergy Enterprise to an existing Exact Globe Next database. 
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To consolidate Exact Synergy Enterprise and Exact Globe Next: 

Start by entering master data into the Exact Synergy Enterprise database. Then, use Asimport.exe to 

distribute the data to the Exact Globe Next databases. This keeps the numbering and coding of 

relations between the applications and databases as synchronized as possible. 

Keep these in mind to successfully use Asimport.exe: 

• Exact Synergy Enterprise and Exact Globe Next must be of the same batch. 

• The user running Asimport.exe must exist as a person with appropriate rights in both databases. 

• The user running the application must log into Exact Synergy Enterprise on the server where the job 

is to be executed. 

• The Exact Globe Next administration code must match the division code in Exact Synergy 

Enterprise. 

• The Exact Globe Next license must contain the needed XML server options. 

• For each Exact Globe Next administration, enter or schedule a separate command. 
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7.6 PREPARING MICROSOFT WINDOWS SERVER 2008 R2 

Once the Microsoft Windows Server 2008 R2 operating system is installed, it must be set up 

accordingly to install and run Exact Synergy Enterprise. The server should already be connected to the 

network, properly named, and if necessary, added to the appropriate domains. 

 

7.6.1 Removing unnecessary operating system components 

The server machine installed with Microsoft Windows Server 2008 R2 is intended for commonly used 

applications and data processing. To optimize operations, servers should be configured for dedicated 

purposes. This means that applications that are not required for the intended purposes should not be 

installed. 

In order to optimize dedicated Microsoft Windows Server 2008 R2 machines for Exact Synergy 

Enterprise, remove all unnecessary operating system components. In a dual-server or multi-server 

setup, only IIS should be installed on the web server while all components should be removed for the 

database server. 

 

To remove Microsoft Windows Server 2008 R2 components: 

1. Go to Start → All Programs → Administrative Tools → Server Manager.  

2. In the left pane, click Features. 

3. Next, click Remove Features. 

 

4. When you have finished selecting features that you want to remove, click Next, and then click 

Remove. 

Caution:  

The configuration described is recommended for a dedicated Exact Synergy Enterprise 

environment. If any of the servers is required to perform other tasks, the required components for 

the tasks should not be removed. 
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7.6.2 Optimizing operating system log files settings 

The Microsoft Windows Server 2008 R2 operating system keeps logs of applications, security, and 

system events. The file sizes of these event logs can be optimized to maintain server performance. 

 

To optimize Microsoft Windows Server 2008 R2 event logs: 

1. Go to Start → All Programs → Administrative Tools → Server Manager. Expand Diagnostics, 

Event Viewer, and Windows Logs. 
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2. Right-click the Application log and select Properties. You will see the following: 

 

3. Under the General tab, set the Maximum log size (KB) field to 1024 KB. 

4. At When maximum log size is reached, select Overwrite events as needed (oldest events first). 

5. Click OK to accept the changes. 

Repeat the same procedure for the Security and System logs. To make the changes effective, right-

click each log and select Clear all Events. When prompted, you can click Yes to save the events 

currently in the log to a file, or click No to discard the log. 

 



CHAPTER 7 | RELATED MATTERS 

381 

 

7.6.3 Optimizing disks for better management 

It is good practice to create logical partitions for the server hard disks. Apart from providing a clear 

structure, this also minimizes data loss in the event of a system crash. A good backup and disaster 

recovery plan are also recommended. 

Generally, the following three logical partitions are recommended: 

• System partition for the operating system 

• Program partition for applications 

• Data partition to store the data 

Exact Synergy Enterprise and Microsoft SQL Server 2008 R2 can be installed in the program partition. 

In a dual-server or multi-server setup, only the system and program partitions are needed for the 

application server. The database server should have all three partitions. 

 

Managing disk partitions 

 

You can create and manage logical partitions using the Disk Management console in Microsoft 

Windows Server 2008 R2. To open this management console, go to Start → All Programs → 

Administrative Tools → Server Manager → Storage → Disk Management. Alternatively, go to Start and 

click Run, and then type diskmgmt.msc at Open and click OK. 

Tip:  

You cannot resize a partition using the Disk Management console in Microsoft Windows Server 

2008 R2. You should plan the partitions before installing the operating system or use a third-party 

tool. 
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7.7 SETTING UP SQL DATABASE MAINTENANCE PLAN 

A periodic backup maintenance plan can be set up in Microsoft SQL Server 2008 R2 to keep a copy of 

the Exact Synergy Enterprise database. This can be done using the Microsoft SQL Server 2008 R2 

Maintenance Plan Wizard as a preventive measure in case of data loss due to unforeseen 

circumstances. 

 

To create SQL Server backup plans: 

1. Start the SQL Server Management Studio. 
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2. Right-click Maintenance Plans in the Object Explorer panel, and then click Maintenance Plan 

Wizard. 

 

3. Click Next. 
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4. Type relevant information at Name and Description. At Schedule, click Change to customize the 

schedule of the backup maintenance plan. Then, click Next to continue. 
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5. The Job Schedule Properties screen is available only when you click Change on the Select Plan 

Properties screen. Specify the frequency and daily frequency of the backup plan as required under 

the Frequency and Daily frequency sections respectively. For example, you can set the backup to 

occur weekly on Sunday at 8 PM. To continue, click OK. 
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6. Select the relevant check boxes from the list of tasks to be included in the backup maintenance 

plan. For example, select the Back Up Database (Full) and Back Up Database (Transaction 

Log) check boxes. To continue, click Next. 
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7. Specify the sequence in which the selected tasks will be performed. Select a task and click Move 

Up or Move Down to move the tasks to the preferred sequence. To continue, click Next. 
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8. Select the Exact Synergy Enterprise database to be included in the backup plan. 

 

9. Select Disk at Back up to and select Create a backup file for every database. At Folder, specify 

the folder where the backup file will be stored. Select the Verify backup integrity check box, and 

then click Next to continue. 
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10. Since the Back Up Database (Transaction Log) check box has been selected earlier as the next 

backup task, the backup plan wizard will proceed to customize the details of transaction log backup, 

as shown in the following: 

Note:  

The backup transaction log is only allowed on databases that have the recovery model set to Full. 
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11. Select All user databases (excluding master, model, msdb, tempdb) and click OK. 
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12. Select Disk at Back up to and select Create a backup file for every database. At Folder, specify 

the folder where the backup file will be stored. Select the Verify backup integrity check box, and 

then click Next to continue. 
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13. For reporting options, click Next to continue. 
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14. A summary of actions in the backup maintenance plan will be listed. Read the summary. To 

complete the backup maintenance plan, click Finish. 

 

15. The results of the actions in the backup plan are listed to indicate whether there are any 

unsuccessful actions. Click Close to exit. 
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7.8 EXACT EXCHANGE INTEGRATOR 

Exact Synergy Enterprise now supports Microsoft Exchange 2010 and 2013, as well as Exchange 

Online. This section describes the prerequisites and installation steps required to set up the 

synchronization between Microsoft Exchange and Exact Synergy Enterprise for product update 254 

onwards. 

Note: 

• For product updates 250 to 253, see Installing Exact Exchange Integrator (Microsoft Exchange 

2010) (Doc ID 23.783.632) at the Exact Synergy Enterprise web site. 

• For product updates 244 to 249, see Installing Exact Exchange Synergy Enterprise Integrator 

(Exchange 2010) (Doc ID 20.918.101) at the Exact Synergy Enterprise web site. 

This is written with an expectation that all user accounts are on Microsoft Exchange 2010 or higher. 

References made to Microsoft Exchange in this document refers to Microsoft Exchange 2010 and 2013, 

unless the specific version is mentioned. 

 

7.8.1 Prerequisites 

• Personal computer 

- x64 architecture-based (64-bit) 

• Operating system 

- Microsoft Windows Server 2008 R2 Standard and Enterprise Edition 

• Operating system for installing management tools 

- Microsoft Windows 7 and above 

• Exact Synergy Enterprise 

- Product update 254 onwards 

• Database system 

- Microsoft SQL Server 2008 R2 and above 

• Others 

- Microsoft .NET Framework version 4.7 

- Messaging Queue (MSMQ) 

- For more information, see http://www.microsoft.com/exchange/2010/en/us/system-

requirements.aspx 

 

http://www.microsoft.com/exchange/2010/en/us/system-requirements.aspx
http://www.microsoft.com/exchange/2010/en/us/system-requirements.aspx
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7.8.2 Service account 

This account is to be used for the automated synchronization between Microsoft Exchange Server and 

Exact Synergy Enterprise. This account has to be a valid user within Exact Synergy Enterprise and 

Microsoft Exchange Server. This is the same user account that you use to start the background jobs for 

Microsoft Exchange 2007, or you can create accounts specifically for this synchronization. This account 

is also used to run the Windows services responsible for the synchronization.  

This service account must meet the following requirements: 

• This service account exists in the Active Directory of the same domain as Exact Synergy 

Enterprise, or as a local user in the server that is installed with Exact Exchange Integrator.  

• This service account must exist in Exact Synergy Enterprise as a person with these function rights: 

- 624 — Entity Services Create: Requests 

- 625 — Entity Services Read: Requests 

- 626 — Entity Services Update: Requests 

- 627 — Entity Services Delete: Requests 

- 641 — Entity Services Create: Binary 

- 642 — Entity Services Read: Binary 

- 643 — Entity Services Update: Binary 

- 644 — Entity Services Delete: Binary 

• This service account must exist in the Exchange server, and with a valid e-mail address. 

• This service account must be granted impersonation rights in the Exchange server. For more 

information, see 7.8.3 Assigning impersonation rights to the service account. For a hosted 

installation Exchange server (hosted externally and not within the same domain), check with the 

provider on assigning impersonation rights to the service account. 

• The Autodiscover service has to be enabled for a hosted installation or Exchange Online. For more 

information on configuring exchange services for the Autodiscover service, see 

http://technet.microsoft.com/en-us/library/bb201695(v=exchg.141).aspx. 

• If Autodiscover is used and the Exchange server is a hosted installation (Exchange Online, or 

hosted externally and not within the same domain), the service account must use the same 

password in the Exchange server and Exact Synergy Enterprise. 
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7.8.3 Assigning impersonation rights to the service account 

Exchange Impersonation enables a service account to impersonate given user accounts. This enables 

the service account to perform operations by using the permissions that are associated with the 

impersonated accounts, instead of the permissions that are associated with the service account. For 

more information, see http://msdn.microsoft.com/en-us/library/bb204095.aspx. 

Note:  

The setting up of the application impersonation for Exchange Online is different. For more 

information, see Assigning Application Impersonation in Exchange Online/Office 365 (Doc ID 

23.837.651) at the Exact Synergy Enterprise web site. 

 

To assign impersonation rights to the service account: 

1. Log in to the Exchange server as an administrator. 

2. Open Exchange Management Shell. 

3. Run New-ManagementRoleAssignment cmdlet and type the command based on the following 

parameters: 

New-ManagementRoleAssignment -Name:<impersonationAssignmentName> -

Role:ApplicationImpersonation -User:<service account> 

• impersonationAssignmentName — This refers to the friendly name of the role assignment.  

• service account — This refers to the service account created above. 

 

http://msdn.microsoft.com/en-us/library/bb204095.aspx
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7.8.4 Installing Exact Exchange Integrator 

In typical scenarios, Exact Synergy Enterprise is installed on individual web servers and job servers are 

set up in similar methods. In some cases, both the job and web servers can reside on one physical 

server. 

1. Run the deployment package ExchangeIntegrator.msi on the server side. This can be found in 

the cab folder of the Exact Synergy Enterprise installation folder. The Exact Exchange Integrator 

Setup wizard will be displayed. 
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2. Click Next. The Prerequisite Information page will be displayed if any missing prerequisites 

are found on the server. The prerequisites must be installed before proceeding. For more 

information, see 7.8.1 Prerequisites. Click Next. 

 

3. Select I accept the terms in the License Agreement, and then click Next. 

4. On the Custom Setup page, options Exact Exchange Sync Server, ESE to MS Exchange Sync, 

and MS Exchange to ESE are available. The first feature, which is Exact Exchange Sync Server 

must be installed regardless of whether the services are installed on a single physical server or 

multiple physical servers or which synchronization direction is to be installed. Install the remaining 

features based on scenario A or B, as explained in the following: 
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Scenario A: Installing on multiple physical servers 

• Web server 

• Select the option ESE to MS Exchange Sync, and then click Browse to browse for the Exact 

Synergy Enterprise installation folder. 

• Disable the feature MS Exchange to ESE Sync, and then click Next. 
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• Job server 

• Select the option MS Exchange to ESE Sync, and then click Browse to browse for the Exact 

Synergy Enterprise installation folder. 

• Disable the feature ESE to MS Exchange Sync, and then click Next. 
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Scenario B: Installing on a single physical server 

• Choose the features to install, depending on the preferred direction of the synchronization. If both 

directions are required to be installed, all options need to be selected. Click Browse to browse 

for the Exact Synergy Enterprise installation folder.  

• Click Next. 
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5. Define the following fields, and then click Next. 

• Exact Synergy Enterprise SQL Server 

Type the SQL Server of the database for Exact Synergy Enterprise. If the SQL Server name 

contains an instance, for example "DataServer\SQL2014", the SQL Server instance should be 

case-sensitive. 

• Exact Synergy Enterprise Database 

Type the Exact Synergy Enterprise database name. 

• Exact Synergy Enterprise Web Address 

You need to create a virtual directory on the server that is installed with Exact Exchange 

Integrator to connect to the Exact Synergy Enterprise web site. For example, when you create a 

virtual directory called Synergy to connect to Exact Synergy Enterprise, the web address might 

be <server name>/Synergy. Then in the wizard, use <server name>/Synergy as the Exact 

Synergy Enterprise web address. 
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6. Choose the appropriate options, and then click Next. 

• Exchange Web Service URL 

Select Use Autodiscover so that the Microsoft Exchange URL will be discovered automatically 

by the synchronization service. For the Exchange Online server version or a hosted 

environment, the Use Autodiscover check box must be selected. Otherwise, select the Manual 

option and provide a fixed URL. Type the Exchange Web Service URL in the text box.  

• Exchange Server Installation  

Select either On-Premise or Hosted to determine whether the Exchange server is on premise 

or hosted externally. The Exchange Online server version is hosted externally, hence Hosted 

has to be selected. 
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7. Define the User Name and Password, and then click Next. 

• User Name 

Type the service account name. For more information, see 7.8.2 Service account. For example, 

“<domain>\<service account>”, “<machine name>\<service account>”. For the Exchange Online 

server version, use “<domain>\<service account>”. 

• Password 

Type a password for the service account. For the Exchange Online server version or hosted 

exchange server version, the password has to be the same as in Exact Synergy Enterprise and 

Exchange Online or the hosted environment. 
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8. Exact Exchange Integrator is now ready to install. Click Install. 

 

9. Once the installation has completed, click Finish to exit. 
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10. After the installation has completed, follow instructions in the following to encrypt the password for 

the service account and store it to the configuration file: 

• In the same server that Exact Exchange Integrator is installed, go to Start → Command Prompt.  

• In Command Prompt, go to folder <Exact Synergy Enterprise installation folder>\bin.  

• Type in this command, GeneratePassword.exe “<service account password>”, then press Enter. 

Note:  

You must include the quote (“ ”).  

• Exit from Command Prompt.  

• For the Exchange Online server version, make the following change in the 

Exact.MacroManager.Exchange.config: 

• Browse to the Exact Exchange integrator \ XML folder, and open the 

Exact.MacroManager.Exchange.config file using Notepad. Look for the <macro 

id="eseauthn">, and change the value to “1”. The reason you make this change in 

Exact.MacroManager.Exchange.config is that Basic Authentication is a must for 

Exchange Online. In notation of Exact Exchange Integrator, “1” means 'Exact Synergy 

Enterprise is using the Basic Authentication'. 

• In IIS, ensure that the Basic Authentication is “Enabled” for Synergy application. 

• Restart Windows services: 

• Exact Exchange Synchronization Puller Monitor  

• Exact Exchange Synchronization Resolver Monitor 
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7.8.5 Performing checks after installation 

Next, you need to verify if the process has been completed successfully by doing the following: 

1. Go to Computer management → Event viewer → Window logs → Application. Make sure there is 

no installation error from ExchangeIntegrator.msi. 

2. Go to Computer management → Services. Make sure the following services are installed and 

started by default:  

• Exact Exchange Synchronization Puller Monitor (for multiple physical servers installation, 

only installed on the background job server). 

• Exact Exchange Synchronization Resolver Monitor (installed on both the background job 

and web servers). 
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7.8.6 Uninstalling Exact Exchange Integrator 

There are two ways to uninstall the Exact Exchange Integrator. 

 

To uninstall via MSI: 

1. Run the deployment package ExchangeIntegrator.msi on the server side. 

 

2. Click Remove to uninstall. 

 

To uninstall via Add/Remove programs: 

1. Go to Start and click Control Panel. 

2. Search for the application Exact Exchange Integrator. 

3. Select the application and click Uninstall or Remove (depending on the operating system). 
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7.8.7 Defining parameters 

After installing Exact Exchange Integrator, the administrator is able to change some settings of the 

synchronization framework via the configuration file called Exact.MacroManager.Exchange.config, 

which is deployed to two different folders: 

• The XMD folder of Exact Synergy Enterprise installation. For example, C:\Program Files\Exact 

Synergy Enterprise\xmd 

• The XMD folder of Exchange Integrator inside the Exact Synergy Enterprise installation folder. For 

example, C:\Program Files\Exact Synergy Enterprise\Exchange Integrator\xmd 

Note:  

Any changes made to the configuration file will require Windows services in both the web server 

and job server to be restarted. For more information, see 7.8.5 Performing checks after installation. 

Each setting in the configuration file is a pair of macro and value. Macro is the name of the setting and 

value is the value of the setting. 

 

Parameters 

• eseexchadministration 

Do not modify this setting. Modifying this setting will cause the synchronization to fail. 

• exchadministration 

Do not modify this setting. Modifying this setting will cause the synchronization to fail. 

• eseexchconnectionparams 

This setting defines the SQL Server, SQL database, and application path of Exact Synergy 

Enterprise. 

- /S — The SQL Server of the Exact Synergy Enterprise database. 

- /D — The SQL database of the Exact Synergy Enterprise. 

- /APP — The path where Exact Synergy Enterprise is installed. 

• exchconnectionparams 

This is the Exchange Web Service URL. If Use Autodiscover is selected, this setting is blank. 

• autodiscover 

This setting determines whether the Exchange Web Services URL is discovered using autodiscover 

or a manual fixed URL. 

- 0 — Using manual fixed URL. Parameter exchconnectionparams must be defined with 

Exchange Web Service URL. 

- 1 — Using autodiscover. Parameter exchconnectionparams is blank. 

• exchangeinstallation 

This setting determines whether the Exchange server is an on-premise installation or hosted 

installation. 

- 1 — Exchange server is an on-premise installation. 

- 2 — Exchange server is a hosted installation. 

• exchfixeduser 

This is the service account used for the synchronization process. 
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• Exchfixeduserpassword 

- This is the encrypted password of the service account. This password is required if autodiscover 

is used.  

- This password can be updated to the configuration file via command GeneratePassword.exe. 

For more information, see 7.9.4 Installing Exact Exchange Integrator. 

• Exchpullerinterval 

- This setting is defined in the unit of seconds. 

- The default is 60 seconds. 

- This setting affects synchronization from the Exchange server to Exact Synergy Enterprise. 

- The Windows service Exact Exchange Synchronization Puller Monitor is responsible to pull 

all notifications related to any creations, updates, or deletions of appointments from the 

Exchange server, and this action will be carried out at every interval defined in this setting. 

- For example, if the setting is 60 seconds, Exact Exchange Synchronization Puller Monitor 

will connect to the Exchange server every 60 seconds and check for any new notifications, and 

pull all of them and submit for the synchronization process. 

• Exchpullertouchcheckfreq 

- This setting is defined in the unit of minutes. 

- The default is 1,440 minutes. 

- This setting affects the synchronization of recurring appointments with no end date, from the 

Exchange server to Exact Synergy Enterprise. 

- The Windows service Exact Exchange Synchronization Puller Monitor is responsible for 

checking for any notification on recurring appointments with no end date from the Exchange 

server. This action will be carried out at every interval defined in this setting. 

- For example, if the setting is 1,440 minutes, Exact Exchange Synchronization Puller Monitor 

will connect to the Exchange server every 1,440 minutes and retrieve recurring appointments 

with no end date and submit for the synchronization process. 

- For more information on synchronization of recurring appointments with no end date, see 

Understanding recurring appointments with no end date (Doc ID 23.790.522) at the Exact 

Synergy Enterprise web site. 

• Exchpullertouchinterval 

- This setting is defined in the unit of days. 

- The default is 90 days. 

- Recurring appointments with no end date will be updated and extended to the corresponding 

appointments in Exact Synergy Enterprise to not more than the number of days defined from the 

last updated appointment date in the series. For example, if the setting is 90 days, the 

corresponding recurring appointments in Exact Synergy Enterprise will be extended to not more 

than 90 days from the last updated appointment date in the series. 

- For more information on synchronization of recurring appointments with no end date, see 

Understanding recurring appointments with no end date (Doc ID 23.790.522) at the Exact 

Synergy Enterprise web site. 

• eseexchqueue 

Do not modify this setting. Modifying this setting will cause the synchronization to fail. 

• eseurl 

This is the Exact Synergy Enterprise web address. 

• eseauthn 

This setting defines whether Exact Synergy Enterprise is using the Basic or Integrated 

authentication. 

- 0 — Exact Synergy Enterprise is using the Integrated authentication. 

- 1 — Exact Synergy Enterprise is using the Basic authentication. Using this setting, 

exchfixeduserpassword must be defined. 
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• L 

- This setting defines the path and name of the synchronization log file. 

- The default is C:\synclog. It means the synchronization log file will be created in the root of C: 

drive, with the file name starts with synclog. 

- The final file name will have date and time appended to the file name and with the extension 

log. For example, C:\synclog_20120727_152537.log. 

- If the synchronization log file is to be created in a folder, the user must create the folder as the 

synchronization will not create the folder. 

- For example, if the synchronization log file is to be created to the folder exchlog in drive C: with 

the file name starting with synclog, the folder exchlog must be created in drive C:, and the 

setting will be defined as C:\exchlog\synclog.This setting defines the path and name of the 

synchronization log file. 

• DST 

- Daylight saving time setting for recurring appointment synchronization. 

- 0 — Adjustment without DST time format. Recurring appointments in Exact Synergy Enterprise 

will be updated if the last modified timestamp of the appointment from the Exchange server is 

more recent compared to the timestamp when the synchronization was last executed. 

- 2 — Adjustment according to DST time format. Recurring appointment types will always be 

updated, regardless of the timestamp. 

• Z 

- This setting allows users to be excluded from the synchronization processes. 

- The setting uses the person id (res_id in the table Humres). 

- The person id list is comma (,) separated. 

• R 

- This setting defines which user is allowed for synchronization processes. 

- Only the user listed here is allowed for synchronization; an empty list means everyone is 

allowed. 

- The setting uses the person id (res_id in the table Humres). 

- The person id list is comma (,) separated. 
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7.8.8 Frequently asked questions 

1. Why do I get the error, "The HTTP request is unauthorized with the client authentication scheme 

"Negotiate". The authentication header received from the server was "NTLM"."? How do I solve this 

error? 

To solve the error, disable the loopback check in the registry, as explained in the following steps: 

 

• In the Registry Editor, locate and click the registry key, 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Lsa  

• Create the value DisableLoopbackCheck and enter 1 in the Value data box  

• Click OK.  

• Restart your PC.  

For more information, see Authenticate problems by using of NTLM at 

http://developers.de/blogs/damir_dobric/archive/2009/08/28/authentication-problems-by-using-of-

ntlm.aspx. 

2. Why do I get the error message "Not supported Exchange server version" when synchronizing 

to the Exchange server? How do I solve this error? 

This error is due to the Exchange server version defined in Exact Synergy Enterprise and it does 

not correspond to the actual Exchange server version. To solve this, perform the steps in the 

following: 

 

• Log in to Exact Synergy Enterprise.  

• Go to Modules → HRM → Setup → General → Settings. 

• Under the Server section, select the create Exchange Mailbox check box at Domain: New – 

People (Pre-Win2000) and select the appropriate version from the dropdown list at the 

Exchange server version field. 

• Click Save, and then Close. 

 

3. Why do I need to back up the configuration file Exact.MacroManager.Exchange.config before I 

make any changes? Where should I keep the older version? 

It is always good to create a backup of the configuration file before making changes to it, but be 

aware of where to keep the backup file. Do not keep the backup file in the folder that houses the 

configuration file. 

 

 

 

http://developers.de/blogs/damir_dobric/archive/2009/08/28/authentication-problems-by-using-of-ntlm.aspx
http://developers.de/blogs/damir_dobric/archive/2009/08/28/authentication-problems-by-using-of-ntlm.aspx
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8. ADDITIONAL INFORMATION 

8.1 ONLINE CUSTOMER SERVICE 

Exact offers comprehensive telephone and online support to its customers, with measured and proven 

responsiveness. In addition to quality support, you will have a variety of tools to help you get the most 

from your service plan. 

Log on to the Exact customer portal at https://customers.exact.com/ or the reseller portal at 

https://partners.exact.com. You will need an ID and password to log on. If you do not have an ID and 

would like to request one, please contact our Customer Support Representative. 

 

https://partners.exact.com/
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8.2 ABOUT EXACT SOFTWARE 

Established in 1984, Exact is one of the world’s leading providers of business software solutions. Its 

integrated solutions comprise traditional Enterprise Resource Planning (ERP) as well as related 

software solutions, such as Human Resource Management (HRM), Customer Relationship 

Management (CRM), Project Management, and Electronic Workflow. 

Exact is headquartered in Delft, the Netherlands and has offices in Europe, the Middle East, North and 

South America, Asia, Australia, and Africa. With around 2,700 employees, subsidiaries in more than 40 

countries, and solutions available in 40 languages, Exact currently serves customers in more than 125 

countries across all five continents.  

Exact Holding N.V. has been listed on Eurolist by Euronext Amsterdam since June 1999. 
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APPENDIX A: WEB GARDEN IN IIS NOT 

COMPATIBLE WITH EXACT SYNERGY 

ENTERPRISE 

Microsoft Windows Server 2003 is shipped with version 6.0 of Microsoft Internet Information Services 

(IIS). In this version of IIS, the Web garden is introduced. 

A Web garden is an application pool served by more than one worker process. This functionality is not 

compatible with Exact Synergy Enterprise because a Web garden does not support ASP session state. 

This means that the maximum number of worker processes for the application pool to which Exact 

Synergy Enterprise belongs needs to be “1”. 

Exact Synergy Enterprise uses session state information to avoid unnecessary database queries. This 

means that some information of the current connection is stored within the session. Because ASP 

session data is kept inside the worker process, session data gets lost when a request is served by a 

different worker process. 

IIS maps the requests to worker processes using the client IP address and source port. If an application 

keeps a connection alive and uses the same source port, its requests get routed back to the right 

worker process. However, if the application does not keep a connection open, or the source port differs, 

the next request will be routed to any of the worker processes. The source port can differ if the client 

has to go through a proxy or firewall. In this case, the client cannot be guaranteed to always use the 

same source port. 

For more information see IIS 6.0 Session State May Be Lost If You Use Web Gardens with ASP 

Applications in the Microsoft Knowledge Base at http://support.microsoft.com/kb/822171. 
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APPENDIX B: IMPLEMENTATION 

CHECKLIST 

Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

SYSTEM     

General     

Regional Options     

Any slogan or message to use as the Banner?     

Database     

Set up Company (system checklist/verification)     

Does your company report or transact in multiple 

currencies? Specify currencies 
    

What countries does you company have employees? 

Specify countries 
    

How is your company divided for reporting purposes? 

Specify divisions 
    

What are the cost center/P&L reporting levels? Specify cost 

centers 
    

Security     

Will the current list of roles satisfy the functional needs of 

the organization? 
    

Do additional roles need to be created for workflow? Roles 

(can create additional roles and add, delete, show users of 

roles) 

    

Delegation     

Function Rights     

HRM     

References     

Job Group (has standard list)     

Job Activities (has standard list)     

Job Title (has extensive list with default security level 

associated) 
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Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

Active Countries (need to activate necessary countries)     

Locations (create list of office locations; this needs to be 

done after the countries have been activated) 
    

Organization     

Does your company have an updated organization chart?     

Does your company have updated Job Descriptions for all 

levels of the organization chart? 
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Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

People     

How many employees will be using the system?     

Do you require former employees to be entered in the 

system? If so, how many? 
    

Can these records be loaded manually?     

• Name     

• User Name     

• Country     

• Job Title     

• Cost Center     

• Division     

• Manager     

• Security Level (if different from standard)     

• Additional item fields     

• Address     

• E-mail Address     

• Phone     

• Start Date     

• Birthday/Anniversary     

• Digital Picture (can only be added after the personal 

card has been saved) 

    

Schedules     

At what level does your company establish work 

schedule/holiday schedule? (not immediate required 

information) 

    

• Public Holidays     

• Schedules (shifts, days, et cetera)     

• Division or individual schedules     

DOCUMENTS     

Where are the documents stored? (file 

cab/server/desktops) 
    

What historical information is required?     
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Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

How is knowledge capital currently shared across your 

organization? 
    

What Taxonomy fits your business? 

(organizational/functional/ other) 
    

What documents are created out of business processes?     

Document Types     

Do level and/or role dictate who can see certain document 

based information? 
    

Access by Role     

Required Fields     

Default Security Level     
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Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

Miscellaneous     

Main Category (choose appropriate property - No (Not 

in use, Yes (Optional), Yes (Mandatory)) 

    

• Items     

• Assortments     

• People     

• Account     

• Language     

• Division     

• Project Transaction     

Category     

Subcategory     

Review Settings     

Layouts (Normal, FrontPage, Document, et cetera)     

Pictures     

WORKFLOW     

What processes should be included in Exact 

Synergy Enterprise? 

    

At what timeframe should they be included?     

Are the processes documented? (flow diagrams)     

How should requests be categorized? (function or 

process) 

    

Request Categories     

Group similar requests?     

Request Types     

Do requests require the creation of additional roles for 

routing? 

    

Define workflow     

Entry Fields     

Required Fields     

Default Security Level     
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Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

CUSTOMERS     

Where are your company’s lead, prospect, and 

customer information maintained? 

    

What system(s) are currently in place? What 

processes? 

    

What is your Business model? (direct to customer, 

reseller, hybrid) 

    

Who is(are) the Business Owner(s) of this process?     

General     

Who will perform the data cleaning?     

Titles (salutation)     

Address Types     

Free fields (5 date, 5 text, 5 number, 5 Yes/No fields)     
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Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

Other     

How will account codes be generated - manual or 

systematic? 
    

Are your account codes numeric or alphanumeric?     

Does your company plan to use form letters/documents 

and e-mails? 
    

• Settings     

• Mail Merge     

• Account code increment     

• Server settings for customers     

MARKETING     

Who is the Business Owner of the Marketing processes?     

What are the logical categories to divide your customer 

base for directed marketing and sales efforts? 
    

Sectors (example: Manufacturing, Agriculture, et cetera)     

Code (unique id)     

Description     

Sub sectors     

Sizes (example: 0-99, 100-499, et cetera)     

Classifications     

Source (example: Phone, Magazine, Web site, et cetera)     

Rating: Rule     

Customers     

Resellers     

Portal     

Are you planning Web access for your employees?     

Are you planning Web access for your customer base?     

Are you planning Web access for your reseller/distributor 

base? 
    

Are you planning Web access for your supplier base?     

Employee: Page - support     

Customer: Page - support     
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Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

Reseller: Page - support     

Supplier: Page - support     

LOGISTICS     

What system owns Items?     

How many Items exist?     

Who owns the Item creation process?     

Are catalogs used to provide targeted offerings?     

Activities     

Who owns the determination of Catalogs?     

Items     

Assortments/Assortment Properties     

New Items     

Catalogs     

New Catalogs     

Assign Items to Catalogs     

PROJECTS     

What projects should be entered into Exact Synergy 

Enterprise? 
    

Projects     

• Free Fields     

• Settings     

How are Projects currently tracked - Financial/Progress?     

What criteria should be used to establish a project?     

Who owns Projects?     

FINANCIAL     

G/L Accounts     

• Chart of G/L’s     

• Categories     

Budgets     

• Scenarios     
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Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

• Entries     

Who owns Financial?     

DATA CONVERSIONS     

Human Resources     

Data Cleanup     

Manual/Systematic Upload     

Number of Data Sources     

Accounts: Customer, Prospect, Lead, and Supplier     

Data Cleanup     

Manual/Systematic Upload     

Number of Data Sources     

Items     

Data Cleanup     

Manual/Systematic Upload     

Number of Data Sources     
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Activities Owner Due 

Date 

Date 

Completed 

Result / 

Answer 

TRAINING     

Human Resources     

Number of End Users/Locations     

Customers     

Number of End Users/Locations     

Workflow     

Number of End Users/Locations     

Documents     

Number of End Users/Locations     

Projects     

Number of End Users/Locations     

Financial     

Number of End Users/Locations     

Logistics     

Number of End Users/Locations     
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APPENDIX C: EXACT SYNERGY 

ENTERPRISE FIELD TERMS 

These are field terms that will need to be defined. The following examples explain how Exact has 

chosen to define and use them. 

 

Customers 

Term Description 

Transaction Financial transactions to link to. 

Assortment Product (Exact Globe Next, Exact Synergy Enterprise). 

Rating Graphical way to report the number of the accounts that are assigned a certain 

rating based on the license value. 

Active The account is linked to a contract, service items are linked to the contract. 

Blocked The account is not allowed to receive any type of service or delivery. Can be a 

result of having outstanding amounts that are too high or long overdue. 

Exit The associate is not interested in one of the products or services. 

Passive The account is linked to a contract. No service items are linked to the contract. 

Pilot The account participates in a pilot project. 

Reference The customer has a testimonial linked and can be used for commercial 

purposes. 

Not Validated An account that is entered via web request; manual check of every record is 

required. 

Associate An account that does not sell your product and therefore is partnered in other 

areas like development, hardware, et cetera. 

Bank An account that provides financial services to you. 

Division An account that is your company or is a part of your organization. 

Prospect An account that is interested in one of your products. 

Reseller An account that sells your products/dealer. 

Supplier An account that provides goods or services to you. 

 

 

 

 



APPENDIX C | EXACT SYNERGY ENTERPRISE FIELD TERMS 

427 

 

Logistics 

Term Description 

Assortments Used to group the same kind of items together. Every item can only belong to 

one assortment. So the assortment should be unique for every individual 

item. There is no maximum to the amount of assortments used inside one 

company. 

Item release Version numbers of the items. This functionality is particularly useful if you 

are required to maintain different versions of your items. Releases are linked 

to assortments. 

Items Items are the basic objects in Logistics. Items are grouped according to 

assortments so you need to create assortments first before creating items. 

Item Relation You can create a parent and child relationship between items. A sub-

assembly item can be linked as a child item to an end product item. The 

relationship between the sub-assembly item and the end product item can be 

defined with the item relation type. For example, when you define the 

relationship between the sub-assembly item and the end product as 

mandatory, this means that the sub-assembly item is always required when 

you select the end product. 

Status Determines what relation type that you wish to use. Use any of the status to 

determine the relationship between two items. There are 9 types of status 

you can define, namely Default, Mandatory, Mandatory (one of set), 

Mandatory (at least one), Optional, Optional (one of set), Replacement, 

Trade in, and Invalid.  

For example, an end product is made of two components and these two 

components are compulsory parts to make the end product. As such, the 

relationship between the end product and the components are mandatory. 

You can configure this relationship between them with the relation type 

defined here. 
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APPENDIX D: EXACT SYNERGY 

ENTERPRISE DATABASE TABLES 

Exact Synergy Enterprise is very strong in storing data in a structured way and with a little bit of 

creativity virtually every important piece of information in any organizational process can be stored. In 

order to generate relevant information based on this information, several reporting functionalities are 

available in Exact Synergy Enterprise. For every module, a sub–menu, Reports which discloses a 

variety of reporting functionalities can be found. The most powerful report is the Pivot analysis, while 

the Search reports and more specific reports are also very useful. 

Despite all the reporting functionalities, information is sometimes desired in a format that cannot be 

provided with standard Exact Synergy Enterprise. In these cases, third party reporting tools can be 

addressed to fulfill the need, as explained in these few examples: 

• SQL Reporting services is a powerful web based reporting tool that can be used under the SQL 

Server license and integrates perfectly in the Exact Synergy Enterprise environment. 

• MS Access via ODBC connection with the database views, can be build. 

• MS Excel uses the powerful Pivot functionality to create multi-level reports and upload the 

generated reports right back into Exact Synergy Enterprise using the Exact Synergy Enterprise 

Office Add-in Exact Synergy Enterprise SDK, and then builds the desired reports fully integrated in 

the Exact Synergy Enterprise GUI. 

• Crystal Reports. 

Since the Exact Synergy Enterprise database is an open SQL database, any tool that can retrieve 

information out of the Microsoft SQL database can be used to create customized reports. In order to 

create adequate reports, some knowledge about the tables and the purposes for which they are used is 

necessary. This document describes the most commonly used tables and explains how entities are 

referenced using the relevant key. 

Caution:  

Do not write information directly into the tables. Exact Synergy Enterprise uses a validation layer to 

make sure all data entered into the database are correct and writing directly into the database could 

mess up the integrity of the data. 
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General 

In virtually every table in Exact Synergy Enterprise, one will find references to people and divisions. The 

reference to people in particular, will be found multiple times in the form of capturing the ID of the 

creator, modifier, or owner of the entity. The column names differ between the different tables. The 

following list shows the most commonly used columns: 

Entity Column 

Creator syscreator, createdby, creator 

Modifier sysmodifier, modifiefdby, modifier 

Owner res_id, resid, cmp_acc_man, owner, Responsible, Ownerperson, empid, emp_id, 

Humresid 

Also, the division is stored in almost every Exact Synergy Enterprise table and again the column names 

used to store the division can vary, as displayed in these few examples: 

• division 

• company 

• companycode 

• administration 

• comp 

• divisioncode 

Every click in Exact Synergy Enterprise is logged in the table BacoApplog. This log is used to show 

who read, created, modified data, and when this was done. For example, the log for documents that 

have been read fetches its information from this table. 

• BacoApplog — Stores information of every click people make. 

• EbcDataLog — Stores changes made in records. What is logged can be specified in Exact Synergy 

Enterprise via Modules → System → Setup → Settings - Database → Log: Data. 

• BacoProcessLog — Stores information about the activity of the background jobs. 

• BacoErrorlog — Stores errors occurring in Exact Synergy Enterprise. 

 

HRM 

The main identity of the HRM module is the people captured in the system. Virtually all other modules 

have references to people in one way or another. The reference used in both the tables and visually in 

the graphical interface is the id which can be found on top of a personal card. The table in which the 

people are stored is called HUMRES, and this table contains people, vacancies, applicants, and contact 

persons from resellers that are granted web access. The other tables containing HRM metadata mostly 

start with HR…. 

Characteristics Values 

Main table HUMRES 

Reference key res_id (integer) 

Reference user interface ID 

Meta data tables Mostly start with HR… 
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Customers 

The Customers module stores its main entity; the relation in the table Cicmpy. Most tables storing 

metadata for the Customers module start with Ci… However, a few important exceptions can be found 

like the table Addresses that stores address information per contact person or account and the tables 

DivisionDebtors and DivisionCreditors that store debtor and creditor information per division. 

It is important to know that when writing reports that involve information about relations, in almost all 

cases, the cmp_wwn column is used to refer to an account except for the financial table GbkMut. This 

table uses the debnr or crdnr column as a reference to accounts, and in consolidated scenarios this 

means joining the DivisionDebtors and DivisionCreditors table with the Debtor and Creditor fields. 

Characteristics Values 

Main table Cicmpy 

Reference key cmp_wwn (GUID) 

Reference user interface Account code 

Metadata tables Mostly start with Ci… 

 

Documents 

The Documents module stores its records for documents in the table BacoDiscussions. These 

documents are referenced by people via the document number. However, in the tables, a GUID is used 

as reference. The tables containing metadata for the Documents module mostly start with 

BacoDiscussions…. 

Characteristics Values 

Main table BacoDiscussions 

Reference key ID (GUID) 

Reference user interface Document number (HID) 

Metadata tables Mostly start with BacoDiscussion… 

 

Documents can be linked to several other entities using the key for that entity, as displayed in these few 

examples: 

Entity Column Link to table 

People HumResID Humres 

Account CmpWwn Cicmpy 

Item ItemCode Items 

Project ProjectNr PRProject 
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Workflow 

The Workflow module stores its main entity request in the table Absences. The table stores a 

readable number in the column HID that is also shown in the user interface as the request number. 

Technically, a GUID is stored in the column ID to reference this entity. Tables related to the Workflow 

module either start with Absence… or Request…. A few examples of tables are explained in the 

following: 

• RequestTasks — All requests that are displayed in the workflows of people are stored in this table. 

• AbsenceTypes — The definition of the different request types are stored here. 

• RequestFieldOptions — All fields that can be added to a request type definition are stored here. 

Requests can be linked to a variety of other entities. These references are stored in the table 

Absences. 

Characteristics Values 

Main table Absences 

Reference key ID (GUID) 

Reference user interface Request number (HID) 

Metadata tables Start with BacoDiscussion… or Request… 

 

The following table shows how the most commonly used references are stored: 

Entity Column Link to table 

Person HumResID Humres 

Account CustomerID Cicmpy 

Contact person CustomerContactID Cicntp 

Item ItemCode Items 

Project ProjectNumber PRProject 

Document DocumentID BacoDiscussions 

 



APPENDIX D | EXACT SYNERGY ENTERPRISE DATABASE TABLES 

432 

 

Logistics 

The Logistics module stores its main entity in the table Items using the reference itemcode both in the 

user interface as well as in the tables. All other tables directly linked to items start with Item…. A few 

examples of item tables are: 

• ItemCountries — Stores item information per country. Every item has at least one record in this 

table for the World item. 

• ItemDivisions — Only used in the consolidated scenario, items, and their general ledger accounts 

are stored per division and the XML exchange procedure looks at this table to determine which 

items to upload or download. 

Characteristics Values 

Main table Items 

Reference key ItemCode 

Reference user interface ItemCode 

Metadata tables Start with Item 

 

Projects 

The Projects module stores its main entity in the table PrProject using the column ProjectNr as a 

reference in both the user interface as well as the tables. Other tables related to this module start with 

either Pr… or Project…. 

Characteristics Values 

Main table PrProject 

Reference key ProjectNr 

Reference user interface ProjectNr 

Metadata tables Start with Pr… or Project… 
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Financial 

The main financial table is Gbkmut, and this table uses the column Transactionguid to reference to 

records in the tables. From the user interface, there can be several ways to look at financial 

transactions. These include perspectives from the customers, suppliers, and the employees. Item, 

project, general ledger, and transaction types are also angles used to look at financial transactions. 

Other tables related to the Financial module start mostly with Account… but tables like Bedryf, 

Valuta, and bdgvers are also related to financial data. 

Characteristics Values 

Main table Gbkmut 

Reference key Transactionguid 

Reference user interface Bkstnr 

Metadata tables Start with Account… 

 

Financial entries can be linked to a variety of other entities resulting in the possibility to view 

transactions from all the angles described earlier. A list with how other entities are linked to the financial 

table can be viewed in the following: 

Entity Column Link to table 

Person res_id Humres 

Account cmp_wwn Cicmpy 

Item artcode Items 

Project project PRProject 

Document DocumentID BacoDiscussions 

G/L account reknr Grtbk 

Debtor debnr and debtor Cicmpy and 

DivisionDebtors 

Creditor crdnr and creditor  Cicmpy and 

DivisionCreditors 
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APPENDIX E: USING HOST HEADER 

NAMES TO CONFIGURE MULTIPLE 

WEB SITES 

Microsoft Internet Information Services (IIS) allows you to map multiple web sites with the same port 

number to a single IP address by using a feature called Host Header Names. By assigning a unique 

host header name to each web site, this feature allows you to map more than one web site to an IP 

address. This section provides step-by-step instructions for hosting multiple web sites by using a single 

Internet Protocol (IP) address. 

 

To configure websites by using the Host Header Names feature: 

1. Go to Start → Control Panel → Administrative Tools → Internet Information Services (IIS) Manager. 

2. In the left pane, expand the server node, expand Sites, and select the required web sites to 

configure the host header name. 

3. In the Actions pane, under Edit Site section, click Bindings. 

4. On the Site Bindings screen, select the required binding, and then click Edit. 

 

5. At Host name, type a host header for the site, for example, “”. 
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6. Type the port number at Port, and then select the IP address from the IP address list. 

 

7. Click OK. 

Note:  

To configure this web site with additional identities, click Add. Use the same IP address and Port, 

but define a unique host header name for each identity, and then click OK. For example, if you want 

to access the same web site from both the Internet and a local intranet, you could configure the web 

site identity in the manner shown in the following example: 

IP Address           TCP Port       Host Header Name 

192.168.0.100         80               www.dbike.com 

192.168.0.100         80               dbike.com 

Register the host header names with the appropriate name resolution system, for example, a Domain 

Name System (DNS) server or, in the case of a small network, a Hosts file. The web sites are now 

configured to accept incoming Web requests, based on their host header names. 

Do not assign a host header name to the default web site. Many programs expect the default web site 

to use an IP address of (All Unassigned), Port 80, and no host header name. 

 

Troubleshooting 

Clients using the IP address are unable to connect to the web sites 

Since there is more than one web site configured to the IP address, you must use host header names 

to connect to the web sites. When you attempt to connect to the web sites using the IP address, you will 

receive the following error messages: 

• The page cannot be found. 

• The page you are looking for might have been removed, had its name changed, or is temporarily 

unavailable. 

 

http://www.dbike.com/
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Clients using host header names are unable to connect to the web sites 

Multiple host header names must be mapped to the single IP address via a DNS server or a Hosts file. 
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APPENDIX F: CONFIGURATION SQL 

SERVERS 

1. Keep all software patches up to date. Software patches provide solutions to known security issues. 

Check software provider web sites periodically to see if there are new patches available for 

software used in your organization. 

• Auto Update version 1.0 provides three options to customers: notify patch availability the 

moment it is available, download patch, and notify that it has been downloaded, and scheduled 

for installation. For more information, see Windows Automatic Updates in Windows Help. 

2. Disable all unnecessary services. 

3. Change the default empty password of the System administrator of the SQL Server (SA). 

4. Check the SQL logins for people or groups that do not need direct access to the SQL Server via an 

SQL login. 

5. Remove other applications software and development tools from the servers if these have been 

installed. 

6. Use NTFS. The NTFS file system is more secure than the FAT or FAT32 file system. 
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APPENDIX G: CONFIGURATION OF 

THE IIS 

1. Keep all software patches up to date. Software patches provide solutions to known security issues. 

Check software provider web sites periodically to see if there are new patches available for 

software used in your organization. 

• The new process model beginning in IIS 6.0 includes process recycling, which means an 

administrator can easily install most IIS patches and most new worker process DLLs without any 

interruption of service. 

• Auto Update version 1.0 provides three options to customers: notify patch availability the 

moment it is available, download patch, and notify that it has been downloaded, and scheduled 

for installation. For more information, see Windows Automatic Updates in Windows Help. 

2. Disable all unnecessary services. 

3. Install Exact Synergy Enterprise on an NTFS partition. 

4. Properties of the virtual directory for internal users on the internal IIS servers: 

• Disable anonymous authentication. 

• Enable Basic Authentication if employees must be validated through a firewall via a proxy 

server. 

• Enable Integrated Windows Authentication to validate employees. 

• Define read rights (no write, script source access, directory browsing). 

• Execute permissions: Scripts Only. 

• Application Protection: Medium (Pooled) or High (Isolated). 

5. Properties of the virtual directory for external users on the external IIS servers: 

• Enable anonymous authentication for all public users. 

• Enable Basic Authentication if resellers and customers must be validated through a firewall via 

proxy server. 

• Enable Integrated Windows Authentication to validate resellers and customers. 

• Define read rights (no write, script source access, directory browsing). 

• Execute permissions: Scripts Only. 

• Application Protection: Medium (Pooled) or High (Isolated). 

6. Define read-only access to the Exact Synergy Enterprise directory for all users. Only system 

administrators have full control and can do an installation, update, and batch to batch conversion of 

Exact Synergy Enterprise. 
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7. Disable or remove all sample applications. Samples are just samples; they should never be 

installed on a production server. 

Note:  

Some samples are installed so that they can be accessed only from http://localhost, or 127.0.0.1. 

However, they should still be removed. For example: 

Sample   Column Link to table 

IIS Samples   \IISSamples c:\inetpu\iissamples 

IIS Documentation  \IISHELP c:\winnt\help\iishelp 

Data Access  \MSADC c:\program files\common files\system\msadc 

8. Install Exact Synergy Enterprise on a member server so no copy of the directory database of the 

domain is available on the server. Only local accounts are available. 

9. Remove other applications software and development tools from the servers if these have been 

installed. 
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Enable logging 

Logging is paramount when you want to determine whether your server is being attacked. You should 

use W3C Extended Logging format by following this procedure: 

1. Go to Start → Administrative Tools → Internet Information Services (IIS) Manager. 

2. In the left pane, expand the server node, expand Sites, and select the required web sites to enable 

logging. 

3. Under the Log File section, select W3C at Format, and then click Select Fields. 
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4. The W3C Logging Fields list will be displayed. Select the check boxes as follows: 

 

The Server IP Address and Server Port properties are useful only if you host multiple web servers on 

a single computer. The Win32 Status property is useful for debugging purposes. When you examine 

the log, look out for error “5”, which means “access denied”. You can find out what other Win32 errors 

mean by entering net helpmsg err on the command line, where err is the error number you are 

interested in. 

 

Set appropriate IIS log file access control lists (ACL) 

Make sure the ACLs on the IIS-generated log files (%SystemDrive%\inetpub\logs\LogFiles) are: 

• Administrators (Full Control) 

• System (Full Control) 

• Everyone (RWC) 

This is to help prevent malicious users from deleting the files to cover their tracks. 
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APPENDIX H: CONFIGURATION OF 

EXACT SYNERGY ENTERPRISE 

SERVERS 

1. Define all your IIS servers in the Server access application. The current Exact Synergy Enterprise 

database can only be accessed by the Exact Synergy Enterprise application from these IIS servers. 

Otherwise, you can connect to the Exact Synergy Enterprise SQL Server database using another 

Exact Synergy Enterprise environment. To define all your IIS servers in the Server access 

application, start Exact Synergy Enterprise as a user who has the Administrator role with level 

corporate. Select HRM, administrative tools, server access. Add all IIS servers. When no IIS 

servers are defined in the server access application, no check will be done on the IIS server that 

you use to connect to the Exact Synergy Enterprise database. 

2. Check if the SQL login “Baco” has no additional server roles or database access rights. This SQL 

login is created to connect to the SQL Server. All necessary rights in the database are supplied by 

the application role “Baco” which is part of the database. 

 

Services needed to run IIS and MS SQL Servers 

• Event Log 

• IIS Admin Service 

• License Logging Service 

• MSDTC 

• Protected Storage 

• Remote Procedure Call (RPC) Service 

• Server 

• Windows NT Server 

• Windows NTLM Security Support Provider 

• Workstation 

• World Wide Web Publishing Service 

• MS SQL Server 

• SQL Server Agent 
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Services that may be needed on the servers 

• Certificate Authority — Required to issue certificates. 

• Content Index — Required if using Index Server. 

• FTP Publishing Service — Required if using FTP service. It is highly recommended that FTP and 

Web services run on different servers. 

• NNTP Service — Required if using NNTP Service. 

• Plug and Play — Recommended but not required. 

• Remote Access Services — Required if you use dial-up access. 

• RPC Locator — Required if doing remote administration. 

• Server Service — Can be disabled but required to run User Manager. 

• SMTP Service — Required if using SMTP Service. 

• Telephony Service — Required if access is by dial-up connection. 

• Uninterruptible Power Supply (UPS) —Optional but it is recommended that you use a UPS. 

• Workstation — Optional but important if you have UNC virtual roots. 

 

Services mostly not needed on servers 

• Alerter 

• ClipBook Server 

• Computer Browser 

• DHCP Client 

• Messenger 

• NetBIOS Interface 

• Net Logon 

• Network DDE 

• Network DDE DSDM 

• Network Monitor Agent 

• NWLink NetBIOS 

• NWLink IPX/SPX Compatible Transport (not required if unless you do not have TCP/IP or another 

transport) 

• Simple TCP/IP Services 

• Spooler 

• TCP/IP NetBIOS Helper 

• WINS Client (TCP/IP) 

It is possible that you may need services, such as WINS and DHCP. This depends on your network 

environment. For a complete list of needed services, see http://msdn.microsoft.com. 
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APPENDIX I: CONVERSION AND 

MIGRATION OF DATABASES TO 

UNICODE AND STANDARD MODE 

DOCUMENT TYPE STRUCTURE 

With this release, there are changes in the database structure for Exact Synergy Enterprise. As such, it 

is possible that you may need to convert and migrate existing databases in order to fully utilize the 

available functions. 

The logical and pre-requisite steps for conversion and migration of an existing database are as follows: 

1. Update Exact Synergy Enterprise to the current release. 

2. Convert the database so that it is Unicode-compliant. 

3. Migrate the database so that it supports the Standard mode document type structure. 

Note:  

The above steps are for Exact Synergy Enterprise only. For more information on installing Exact 

Synergy Enterprise and its pre-requisites, see Exact Synergy Enterprise: Installation Manual (Doc 

ID: 14.139.246). 

 

Database migration to Unicode-compliant databases 

With this release, you can convert your existing databases to be Unicode-compliant. New databases 

created in this release are already Unicode-compliant. To ensure that your database can be supported 

across different countries that use different sets of languages, it has to comply with the Unicode 

standard. This will allow different languages, especially characters that do not have English as a basis, 

such as Arabic and Chinese, to be presented over the internet effectively. 

The basic conversion process in converting an existing database to ensure it is Unicode-compliant is 

targeted at databases that will not take an excessive processing time. This process will include 

converting the database structure and the language coding of documents. 

Note:  

You can perform this step only if you have updated Exact Synergy Enterprise to the current release. 
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To migrate to Unicode-compliant database using basic conversion process: 

1. In Windows, click Start followed by Run. Type 

<Exact_Synergy_installation_folder>\bin\ESEDbUpgrade.exe at Open and click OK. You will 

see the following page: 

 

2. Type the server name at Server. Next, select the database that you want to convert at Database. 

By default, <your full computer name minus the domain name\database instance> will be filled in at 

Server. 

3. Click Connect to connect to the selected database. 

4. Then, click Next. 

5. Click Next again to begin the prerequisite checks. 

6. If all the prerequisites have been met in step 4, click Next. You will then see the following page: 
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7. Select the option for basic conversion scenario, and then click Next. 

8. You will then be asked to make a backup of your database. Once completed, select the I have 

made a backup of database [<Database name>] check box, and then click Next. The following 

page will be displayed: 

 

9. Select the relevant check boxes to convert the selected tables or leave the check boxes blank, and 

then click Next to begin the conversion process. 

10. Once the conversion is completed, click Done. You will see the following page: 

 

11. You can opt to view the conversion log by clicking View report. To send the performance statistics 

gathered during the conversion process to Exact, click Send statistics. 

12. Finally, click Finish. 
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Database conversion and migration to document structure 

With this release, your existing database will fully support the document type structure. However, in 

order to provide for backward compatibility, the document category structure is still available as a 

reference basis unless the migration process is carried out. 

The document type and category structures are used by Exact Synergy Enterprise to manage your 

documents. The document category structure arranges your documents in a hierarchical structure while 

the document type structure arranges your documents in a logical structure. 

In the move towards providing a more business-like approach to storing documents, Exact Synergy 

Enterprise provides more emphasis on the document type structure in storing documents. With regard 

to a business process flow, a document type is more relevant than document categories. For example, 

if you are planning to write a proposal for a project, you need only click on the “Proposal” document 

type. 

Once your organization is comfortable with the document type structure, you can opt to migrate the 

database from the Classic to Standard mode permanently. This will totally remove the category 

structure from the system and users will only be presented with document types when managing 

documents. 

The steps taken in a typical conversion and migration process are as follows: 

1. The conversion process takes place when you update to this release. The system will convert 

existing databases to prepare for the document type structure support. You will start using this 

release in the Classic mode whereby you can still access document categories. 

2. Existing main categories, categories, and subcategories will be converted into document types. 

3. Converted document types are unavailable for use until the administrator enables them. 

4. The migration process can take place any time by using the migration tool. This will change the 

Classic mode database structure to the Standard mode where only document types are available 

for use. Once the document structure is in the Standard mode, you cannot migrate back to the 

Classic mode. 

Note:  

You can perform this step only if you have updated Exact Synergy Enterprise to the current release 

and the database is Unicode-compliant. 

 



APPENDIX I | CONVERSION AND MIGRATION OF DATABASES TO UNICODE AND STANDARD DOCUMENT TYPE 

STRUCTURE 

448 

 

To migrate databases from Classic to Standard mode permanently: 

1. In Windows, click Start followed by Run. Type 

<Exact_Synergy_installation_folder>\bin\ESEDbUpgrade.exe at Open and click OK. You will 

see the following page: 

 

2. Type the server name at Server. Next, select the database that you want to convert at Database. 

By default, <your full computer name minus the domain name\database instance> will be filled in at 

Server. 
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3. Click Connect to connect to the selected database. You will see the following page if the 

connection is successful: 

 

4. Click Document Structure Migration. A message will be displayed to ask if you want to continue. 

Click Yes to continue with the migration process. You will see the following page: 
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5. Click  , and then select the document type for the respective category/subcategory. A message 

“Set all categories/subcategories under <’document category selected> to document type 

‘*<document type selected’>?” will be displayed. Click OK to automatically fill in the selected 

document type for all the subcategories of the selected document category. To select other 

document types for the subcategories, click Cancel. 

Note:  

You can also map a document subcategory with a document type straightaway (without mapping its 

category) by clicking  to display the subcategories, and then clicking  to select the document 

type. It is not necessary to map the document subcategories to document types all at once before 

the migration starts. However, you must map all the document subcategories before you can begin 

step 2 of 3, Convert Document URL. 

6. Once you have mapped the document categories or subcategories to the required document types, 

click Start Migration to begin the mapping process. 

7. After all the document subcategories have been mapped to document types, click Next to display 

the following page: 

 

8. Click Start to begin the document URL conversion. 
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9. When the document URL conversion has completed, click Next to display the following page: 

 

10. Click Start to fully convert to the document type structure. 

11. Once completed, click Next, and then click Finish. 
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APPENDIX J: DOCUMENT 

CATEGORIES 

Creating document categories 

If you are using the Classic document structure mode (Classic is selected at the Document structure 

field at Modules → Documents → Setup → Maintenance → Settings), document categories must be 

defined before documents can be created. 

With the three levels of document categories, the speed of retrieving documents from the database is 

greatly improved. In addition, the categories provide a better structured document management system. 

To create and maintain the main categories, function right 237 - Maintain main categories, 

categories, and subcategories is required. Users with the Documents administrator role have this 

function right. 

 

To create main categories for documents: 

1. Go to Modules → Documents → Setup → Maintenance → Main 

categories/Categories/Subcategories, and then click New. You will see the following page: 

 

2. Under the General section at ID, type a unique ID for the main category. By default, the next 

available number is filled in. You can change the ID if required. 

3. Type a description for the main category at Description. 

4. Click Save to save the new main category. 

Note:  

All fields with the “!” icon are mandatory. 
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To create categories for documents: 

1. Follow steps 1 to 4 at To create main categories for documents. Alternatively, if you want to create 

a category under an existing main category, go to Modules → Documents → Setup → Maintenance 

→ Main categories/Categories/Subcategories, select a main category, and then click Add under the 

Categories section. 

 

2. At Category, type a description for the new category.  

3. Click Save to save the new category. 

Note:  

All fields with the “!” icon are mandatory. 

Tip:  

Once you have clicked Save to save a new category, you can create a subcategory on the 

Documents: Subcategory page. 
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To create subcategories for documents: 

1. Follow steps 1 to 3 at To create categories for documents. Alternatively, if you want to create a 

subcategory under an existing category, go to Modules → Documents → Setup → Maintenance → 

Main categories/Categories/Subcategories, select a category, and then click Add under the 

Subcategories section. 

 

2. At Subcategory under the General section, type a description for the new subcategory. 

3. At Document type, type or select a default document type to be used when creating documents for 

this subcategory. 

4. At Security level under the Forum section, type or select a security level to allow document 

creators with the same or higher security level to create a document in this subcategory. 

Note:  

The security level defined here affects both readers and writers of this subcategory. For instance, if 

a subcategory is set at security level “10”, only users of security level “10” and above can read and 

create documents in this subcategory. 
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5. At Type, select the required check box(es) to place the subcategory in the corresponding forum(s). 

For instance, if the Customer check box is selected, the subcategory will be placed in the 

Customer forum whereby only customers and any user with security level “1” or higher can access 

it. 

Note:  

The selected option will automatically change the security level accordingly. If more than one option 

is selected, the value at the Security level field will be changed to the lowest value. For instance, if 

both the Reseller and Employee check boxes are selected, the Security level field will be 

changed to “2”. However, if you have the correct subcategory maintenance rights, the security level 

can still be changed as required. 

6. At Description, type a description for the forum which describes about the forum. 

7. Click Save to save the new subcategory. 

Note:  

All fields with the “!” icon are mandatory. 
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250 All chapters  

251 4.3.1 

252 2.1.1, 2.1.2, 5.2.1, 7.4.1 
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255 All chapters 
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7.3, 7.8.1 
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